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This website provides contact information and details about the products, services, and support that HPE
Software offers.

HPE Software Support provides customer self-solve capabilities. It provides a fast and efficient way to
access interactive technical support tools needed to manage your business. As a valued support customer,
you can benefit by using the support website to:

Search for knowledge documents of interest

Submit and track support cases and enhancement requests
Download software patches

Manage support contracts

Look up HPE support contacts

Review information about available services

Enter into discussions with other software customers
Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a
support contract. To register for an HP Passport ID, go to hitps:/softwaresupport.hp.com and click Register.

To find more information about access levels, go to:
https://softwaresupport.hp.com/web/softwaresupport/access-levels

HPE Software Solutions & Integrations and Best Practices

Visit HPE Software Solutions Now at https://softwaresupport.hp.com/group/softwaresupport/search-result/-
[facetsearch/document’/KM01702710 to explore how the products in the HPE Software catalog work
together, exchange information, and solve business needs.

Visit the Cross Portfolio Best Practices Library at https:/hpln.hpe.com/group/best-practices-hpsw to access a
wide variety of best practice documents and materials.
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Chapter 1: Introduction

Overview

HPE Operations Manager i (OMi) with its modern user interface, advanced Topology-Based and Stream-
Based Event Correlation (TBEC and SBEC), and Monitoring Automation for infrastructure and composite
applications, offers features that are not available with HP Operations Manager for Windows, HP-UX, Solaris
or Linux.

Therefore, many customers are using it today as their Operations Bridge where topology and event data come
together from various data sources, including HP Operations Manager.

With the introduction of the Monitoring Automation feature in OMi 9.20, OMi was already able to take over the
OM agent configuration and management part that so far had to be done in HP Operations Manager, however,
several features present in OM were still missing, such as agent health checks, an external instruction text
interface, and others.

With the introduction of OMi 10, HPE has released the first OMi version meant to replace OM. It closes many
gaps and although there is no need to move to OMi immediately, it can be considered the successor of OM.

This raises the question of how to evolve an HP Operations Manager deployment so that OM agents and
operators, as well as all kinds of integrations, are shifted from OM to OMi.

This guide explains how to transition to OMi in phases while adding value to the overall solution in each
phase, and compares OM functionality with OMi functionality. It also explains how OMi and HPE Operations
Bridge Reporter (OBR) can be used to replace functions that are handled by HP Operations Manager (OM) for
UNIX or Windows and HPE Reporter today while providing additional features and a modern web-based user
interface.

Note: With version 10.x, HP Service Health Reporter (SHR) is renamed to HPE Operations Bridge
Reporter (OBR). In this guide, HPE Operations Bridge Reporter (OBR) refers to both Operations Bridge
Reporter 10.x as well as HP Service Health Reporter 9.4x.

It provides step-by-step evolution information that adds value after each step and presents an overview of
how existing OM configurations can be transferred and used with HPE OM.. It also contains a comprehensive
comparison of key OM features and their equivalent in HPE OMi.

It also describes the sequence of typical steps required when shifting responsibilities from an OM server to
OMi.

This guide is for HPE OMi implementers who want to replace an existing OM installation with HPE OMi
version 10.00 or later.

OM Evolution in Phases

HPE recommends that you transition functions from OM to OMi in phases. Each phase will add value to the
overall solution. The following chapters explain each step in detail.
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Note: This is not a strict sequence that has to be followed in all cases. For example, instead of adding
correlation rules in the first OMi implementation step, they could be added at a later date. However, it
makes sense to add correlation rules before operators start to work on events, as it increases overall
OpsBridge efficiency.

Day 1 Can be done in
weeks
) In?roduce OMi Establ_lsh Switch off
Plan the Evolution integrate event Effective Operator PM At your own
sources & topology Workflow pace
‘Headless” OpsBridge with key Manage Operations Agents from OMi .
Eﬂ\;i:ﬁ:::];u rrent OpsBridge with integrations for step by step gmmh off
topology operators Choose Mgmt Packs or import policies
. N Easy tuning
Plan how to Correlation Efficient Operator Configure SiteScope from
automatically event enrichment & workflow using modern OMi Automated
establish topology automation Ul and embedded Import SiS templates monitoring
performance grapher configuration
Increased user -
Plan integrations motivation through Move IrorgHR;poner SRWItChnOﬁ
Gamification 0 eporter
Plan Operator groups X |
etc Service Health Reporting

| Model Business Services, add more Event Type Indicators for TBEC & Service Health>

Evolution Phases

Plan the Evolution

In the first phase you plan the move and evaluate your current monitoring and operator workflow in OM.

Infroduce OMi

The next phase will introduce OMi and focus on the integration of the various event sources and topology.
Once this is established you can benefit from OMi correlation, event enrichment and automation features.
Some customers even stop here and use OMi in a “headless” fashion, which means all events are forwarded
to another system, like HPE Service Manager, and processed there. All other customers can see this step as
a necessary first implementation step - before they move to the next step.

Establish Effective Operator Workflow

In this step, operators are moved from OM to OMi. This includes setting up operators and operator groups,
defining work roles and responsibilities, and establishing key integrations for operators like the integrations of
trouble-ticket or notification systems, as well as tools and run book automation. Once this is established,
operators can benefit from the modern OMi Ul and efficient operator workflow as well as from advanced
features like OMi User Engagement.

Since its release in 2009, the classical use case of OMi has been to cover Operations Bridge functions,
receiving events from various event sources. In this use case, multiple domain or regional managers forward
events to a central OMi server on which the events are processed and handled by operators. It is here that
OMi can provide additional value:
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« Linkage to the RTSM
o Modern, web-based user interface

« Extended event automation capabilities including automatically assigning events to users and time-

based automatic triggering event updates and actions
« Multidimensional approach to calculating service health
« Integration capabilities via the BSM Connectors or
« Advanced topology-based event automation

When these functions are achieved, OMi can replace an OM system in an Operations Bridge or Manager-of-

Managers role.

Example of OMi Replacing OM Manager-of-
Managers Acting as Operations Bridge

Operators log in to OMi instead of OM and use the flexible Workspaces pages, for example the Event
Perspective, Health Perspective or custom user-created pages to process events. They can use features
similar to those found in OM to analyze, fix or escalate problems such as instruction text, tools, event-related
actions or performance graphs. Key integrations with other HPE products also exist in OMi, such as the
integrations with HPE SiteScope, HPE UCMDB, HPE Service Manager, HPE Operations Orchestration,

HPE Network Node Manager i, HPE Operations Bridge Reporter, and notification systems.

ﬂ/pl/ \

Operations
anager Wordwide

( Mico=gfEsCInE ) Marg:::'a éia(l)i';:mia)) (Marl;pge: It\:::‘vs\'nrk)
¥ |/ AR
r [N
P ) “Nemnation” )

The next steps add monitoring configuration for SiteScope and OM agents.
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Manage Operations Agents from OMi

This is the phase where OMi Monitoring Automation provides an automated, topology-based monitoring
configuration. You can use OMi management packs or build your own management packs for your custom
applications in order to benefit from OMi advanced monitoring configuration concepts, such as aspects and
parameterized policies.

For an up-to-date list of OMi management packs, go to https://hpin.hpe.com/group/operations-manager-i.

Example of OMi taking over Policy Management for Certain Nodes
'

Operations
Manager i

/‘\

s B
“EJ “§\ @E\ @
) ti Operati i
( lcro=citScOn ) Maon.:;: IC:'lliiomia) G‘Iaruge'ra NI::JSVnrk ( ?‘Ip::glgnis )
J

j ( Operations Agent )

This can be accomplished step by step by having OMi and OM in parallel, until all OM agents are configured
from OMi.

Operations Agent
Alcatraz

Note: When you exchange your OM license for an OMi license as part of the HPE license exchange
program, you will continue to get support for your exchanged OM licenses.

OMi used as Operations Bridge and for System Management
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Alcatraz

Manage SiteScope from OMi

In this step you use OMi Monitoring Automation to configure SiteScope systems.

Move from Reporter to OBR

In this step, business service-centric reporting using Operations Bridge Reporter is established and replaces
HPE Reporter.

Switch Off Performance Manager, Reporter, and OM

At the end of the evolution, when OBR and OMi have taken over all functions and when the older products are
no longer required, the older products can be switched off.

Add Value on Top

Modeling Business Services and defining additional indicators for OMi Topology-based Event Correlation
(TBEC) and Service Health features are optional tasks that can be completed at various phases, if needed.

The following chapters guide you through each of the evolution phases by describing necessary and optional
steps in detail.
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Further Resources

« OMi guides and OMi Help

The Operations Bridge Evolution Guide does not duplicate information that is already available in the OMi
Help, but refers to chapters that are important for the evolution. In the planning phase, when OMi is not yet
installed, the PDF format of the guides can be used. Once OMi is installed, HPE recommends to use the
OMi Help, as it combines the information contained in the PDF guides into a single, integrated, and easy to
access resource.

For the latest version of the following guides, see the
https://softwaresupport.hp.com/group/softwaresupport webpage:

o OMi Administration Guide
o OMi Extensibility Guide
o OMi Integration Guide

For an overview of OMi, search for the OMi Concepts Guide.

« Moving to Service Centric Management with HP OMi Technical White Paper available at
https://softwaresupport.hp.com/group/softwaresupport/search-result?keyword=. This white paper is
useful for consultants and architects planning the implementation of an HPE OMi-based solution. Although
it does not focus on evolution aspects, it provides a good overview of the implementation steps that are
necessary in any OMi implementation, regardless of whether OM is replaced or not.

« OMi Management Packs Evolution Guide available at
https://softwaresupport.hp.com/group/softwaresupport/search-result?keyword=. This guide explains the
differences between SPIs and Management Packs and how to retain customizations. It is intended for OM
Smart Plug-In (SPI) users who want to switch to the corresponding OMi management packs.

« Operations Bridge Solution community: https://hpln.hpe.com/group/operations-bridge.
« Operations Manager i Product community: https://hpln.hpe.com/group/operations-manager-i.

Both communities are meant for practitioners and users of OMi and of the Operations Bridge solution, and
contain many useful links to forums, blog articles, videos, trainings, guides, tools, and so on.

This guide refers to several how-to tutorials that are mentioned on the HPE Live Network Content
Marketplace at https://hpln.hpe.com/page/omi-tutorials.
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Chapter 2: Planning the Evolution

To avoid misplaced effort, any implementation of OMi should be planned and developed upfront, before the
actual software installation and configuration is done. OMi allows a lot of automation that can greatly simplify
ongoing monitoring, but this automation requires thoughtful planning and a clear understanding of how you
want to monitor your IT environment.

Moving from OM to OMi can be considered an opportunity to revisit your current monitoring configuration and
operator setup. You will benefit the most from OMi capabilities not if you are trying to reestablish everything
as on OM, but by taking advantage of the new concepts and possibilities that OMi offers.

Plan Operations Bridge Solution Deployment

With any OMi implementation there are certain deployment options (with or without external UCMDB, single-
or multi-server deployment, with or without a load balancer, and so forth) that depend on your sizing, security,
and integration requirements or preferences. See the Moving to Service Centric Management with HP OMi

Technical White Paper for an overview of what should be considered when planning the solution deployment.

Plan How to Establish Infrastructure Topology

Move from a Node-Centric to a Cl and Topology-Centric
Approach

System and Application Infrastructure Management in OM is based on a node-centric approach. Many tasks
such as tool launches or policy deployments refer to nodes, a list of nodes, or node groups. Node groups are
also referenced when defining responsibilities for operators.

The approach in OMi is different, as it is Configuration Item-centric, which can also be called a topology-
centric approach. Operators typically work with views that show Cls of various ClI types (such as business
applications, running software, databases, web servers, and so on) and the relationships between them.
These views typically return a subset of all the Cls that exist in the RTSM — the Run-time Service Model of
OMi.

Having such a model of Cls and relationships in the RTSM provides the following benefits:

« Operators can see relationships between IT components and business services, which helps them in
prioritizing, filtering, troubleshooting, and isolating problems

« Topology information can be used to provide Cl-type specific guidance to operators (Cl-specific context
menus, tools, run books, graphs, and so on).

For example: selecting an Oracle database event shows all available Oracle tools and run books.
Launching the neighborhood graphs for an Oracle database Cl shows important DB metrics and important
system metrics from the node that runs the DB.
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« The relationships between Cls can be used to propagate health status providing an at-a-glance 360 degree
view of service health

« Thetopology can be used by OMi topology-based event correlation feature to correlate events

« Thetopology can be used by OMi topology-based management template feature to automate what
monitoring configuration is applied or removed

The node that hosts applications like databases or middleware is not as important as in OM, as operators can
launch tools or deploy monitoring to Cls directly, without knowing which nodes are affected. Mass policy
deployment to nodes via node groups in OM is replaced by deployment of aspects to views or automatic
deployment of aspects based on RTSM changes in OMi.

Though node groups exist in OMi, they do not play a special role, requiring OM users to think differently.

OMi users will use views in various places inside the product: when filtering events, when setting up
assignment rules, when creating topology-based event correlation rules, and even when defining
responsibilities for operators. These views would typically show all sorts of Cl types and relationships,
provided that these Cls and relationships have been added to the RTSM. The following sections show you
how you can populate the RTSM with Cls and Relationships.

Technologies for Establishing Infrastructure Topology

Topology (node, node group, and services data) that exists in OM can be forwarded to OMi and converted into
a corresponding RTSM topology. HPE recommends that this topology synchronization is used as a starting
point in every OM evolution project. This will ensure that all OM nodes and OM SPI service models are
reflected in the RTSM, and that OM events can be related to corresponding Cls.

However, as OM will be switched off at some point, the topology has to be created and maintained through
other mechanisms.

Here the automatic discovery features of OMi play a central role. Although OMi allows you to start with a
rather simple topology that represents just the nodes in your IT environment, it is recommended to populate
the RTSM with additional Cls.

For example, as in the OM SPI discovery, all the necessary Cls and relationships for an application area like
Oracle can be created using the discovery policies that are contained in the OMi Management Pack for
Oracle.

All Management Packs contain such discovery policies so that you don’t have to worry about populating the
RTSM yourself.

Even the nodes, which are represented as Configuration Items of type Node in the RTSM, are created
automatically when an agent is installed and connected to OMi. Every agent sends basic information about
itself to its primary manager, and this information is used by OMi to create node, IP address, interface, and
Operations Agent Cls with corresponding relationships.

Where no Management Pack exists, there are several option to populate the RTSM with Cls and Cl
Relationships:

o Use aseparate HPE UCMDB and HPE Universal Discovery (previous product name: Dependency
Mapping and Automation - DDMA) to discover Cls (additional licenses required) and use UCMDB-BSM
Synchronization to synchronize them into the RTSM (see the RTSM Best Practice document for more
details)

« Usethe UCMDB integration features available on the OMi/RTSM system itself. Note the licensing levels:
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o UCMDB Foundation License (included in the OMi license). This license grants the right to use UCMDB
as the backbone component of select BTO products and includes the right to use Custom data
exchange integrations (that is, the Generic DB Adapter, the Generic Push Adapter and customer-
developed Java adapters), as well as the HPE Universal CMDB Web Service APl and the HPE
Universal CMDB API (Java)

o UCMBDB Integration Only License (not included in the OMi license)
This license grants the right to integrate third-party (non-HPE) products with UCMDB using various
types of integrations

o DDM Advanced Edition License (not included in the OMi license). This license grants the rights to:
= |ntegrate BTO and third-party (non-HPE) products with UCMDB, using any type of integration
m Use all Discovery and Dependency Mapping (DDM) capabilities to populate UCMDB

If other domain managers like NNMi, Microsoft SCOM, or Nagios are integrated into OMi, then these
integrations typically also add topology from those domain managers. Check the corresponding integration
documentation for details on which connectors creates node or infrastructure Cls.

Some OM customers use node names that include the purpose of the node and the software running on it, like
W28HRPROD — Windows 2008, HR application, Production system, or RHFINTST — Red Hat, Finance
application, Test system. By parsing these node names they are able to automatically group nodes into
corresponding node groups (to which they assign corresponding policies).

A similar approach can be used on OMi using the RTSM Enrichment rules: Enrichment rules can look for
nodes with certain node names and can then create Running Software Cls. Monitoring Automation is then
able to automatically deploy monitoring aspects to those newly “discovered” Cls. For details, see How to
create Cls Using Enrichment Rules.

Plan Operator Groups

In larger environments with more than a few operators processing events, operators are often organized into
groups with dedicated responsibilities and permissions.

For example, in OM responsibilities can be defined in such a way that database operators are allowed to see
and close database events, but not storage events and vice versa.

In OMi responsibilities can be defined in a very similar way using user roles that grant permissions to certain
views, tool categories and event categories. Additionally, the customizable Workspace pages can provide
OMi operators with overview dashboards and contextual information from business impact information to
detailed performance graphs. You can customize these pages to provide the exact information that is needed
toresolve issues quickly, as different operator groups might require different information to do their jobs.
Operators focusing on business applications might have other needs compared to operators focusing on OS-
level problems. In case one or more operators are part of multiple groups, you could also create a special My
Workspace page for them.

Soin this planning phase you should determine the number of My Workspace pages and what information
they should show, as well as the number of operator roles with different responsibilities and permissions, and
which types of events should be automatically assigned to which operator groups.

In an early implementation phase you might use an event-state driven event dashboard in My Workspace
pages. In later phases, when you have implemented KPlIs and His, you can add to that with Service Health
components.
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You can also create user groups and user roles for OMi administrators and delegate administrative
permissions to different users.

For more details, see "Create Users, User Roles, and User Groups" on page 73.

Plan Integrations

OM integrates with various applications from HPE and other vendors using a variety of different technologies
and interfaces. Many of the HPE product integrations are provided for OMi as well. See Appendix - Available
Integrations & Integration Technologies for a list of all available integrations.

Different use cases require different integrations. Depending on your needs, determine which integrations
need to be reestablished and whether out-of-the-box integrations exist and can be used.

Event Integrations

Several BSM Connectors exist to integrate 3rd-party domain managers in OMi. Additionally all integrations
using standard operations agent policies (opcmsg, opcmon, SNMP, lodfile, and so on) can be reused as OMi
supports the same policy types. OMi provides the opportunity to leverage new policy types that are not
available in OM, such as XML (in Monitoring Automation and BSM Connector), structured log file, Database,
REST Web Service Listener (all in BSM Connector).

For an up-to-date list of available BSM Connectors, check the HPE Live Network Content Marketplace:
https://hpln.hpe.com/node/122/contentfiles.

Integrations for Operators

To implement an efficient operator workflow integrations into trouble-ticket or notification systems might be
important as well as integrations into help systems or knowledge-bases and systems used for the
remediation of problems.

OMIi contains a built-in notification system and a flexible forwarding interface for trouble-ticket or notification
system integrations. Out-of-the-box integrations for HPE Service Manager are available from HPE. Other
incident management systems can be integrated using the forwarding interface or partner solutions.

For more details about the forwarding interface, see the Extensibility Guide > Integrating External Event
Processes and Administration Guide > Event Processing > Event Forwarding.

For details regarding the out-of-the-box integration with Service Manager, see the OMi Integration Guide.

For more details about the Notification interface, see the Administration Guide > Event Processing >
Notifications.

OMIi integrates with Operations Orchestration, and operators can launch run books from their console. Run
books can even be executed automatically when events arrive. For more information, see the OMi Integration
Guide.

Like OM, OMIi offers an external instruction text interface, which allows you to retrieve instructions from
external databases, web pages or other sources. See the Administration Guide > Operations Console >
External Instructions for more details.

HPE Operations Manageri (10.10) Page 22 of 196


https://hpln.hpe.com/node/122/contentfiles

OMi Evolution Guide
Chapter 2: Planning the Evolution

Integrations for Event Enrichment, Correlation or
Automation

OM allows event enrichment and automation through its Message Stream interface (MSI) implemented in C,
Java, or COM or via WMI APls, the OM Incident Web service interfaces, ECS and Composer.

Instead of ECS and Composer, OMi offers server-side Stream-Based Event Correlation (SBEC), Topology-
Based Event Correlation (TBEC), and the Event Processing Interface (EPI) which uses Groovy scripting.
Groovy is an agile and dynamic scripting language that builds upon the strengths of Java but has additional
power features inspired by languages like Python, Ruby and Smalltalk. It makes modern programming
features available to Java developers with an almost-zero learning curve and interoperates with other Java
code and libraries.

You can use these technologies to replace ECS and Composer. The following table lists the main OM
Composer use cases and their replacement in OMi.

OM Composer OMi

& EPI(Groovy)
<3
Enhance (Perl)

iy SBEC Combination Rule

B,
Multi Source b
= EPI (Groovy) or SBEC Repetition Rule
Rate =
s SBEC Repetition Rule
Repeated
;j SBEC Combination Rule or
Suppress | | Event Suppression Rule
& SBEC Combination Rule
Transient i

Note: Composer imposes a fixed order of execution for each correlation. OMi SBEC rules are executed
in the order chosen by the user.

Composer has the capability to perform Lookups and extract substrings from message attributes. With OMi,
EPI Groovy scripting can perform this function prior to feeding the events to SBEC.

To allow a step by step transition from OM Composer perl scripts to groovy, it is possible to call perl scripts
from groovy. See Running External Programs (such as Perl Scripts) from Groovy for more details. For best
performance translate your perl script into Groovy code.
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Stream-Based Event Correlation (SBEC)

Stream-based event correlation uses rules and filters to identify commonly occurring events or combinations
of events and helps simplify the handling of such events by identifying events that can be withheld, removed
or need a new event to be generated and displayed to the operators. This can be used as OM ECS
replacement.

The following types of SBEC rules can be configured:

« Repetition Rules: Frequent repetitions of the same event may indicate a problem that requires attention.

« Combination Rules: A combination of different events occurring together or in a particular order indicates
an issue, and requires special treatment.

« Missing Recurrence Rules: A regularly recurring event is missing, for example, a regular heartbeat event
does not arrive when expected.

Event Processing Interface (EPI)

The EPI enables you to run user-defined Groovy scripts for events that match a user-defined event filter
during event processing. With these scripts, you can modify and enhance events. For information, see the
Extensibility Guide > Event Processing Interface.

You can find the corresponding Groovy and Java APl Documentation at the following location:
<OM1_HOME>/opr/api/doc/opr-external-api-javadoc.zip

The EPI interface is also the replacement of OM MSI interfaces. Any C/Java/COM-based MSI
implementations have to be replaced by Groovy-based EPI implementations if they cannot be achieved by
one of the following OMi features.

Topology-Based Event Correlation (TBEC)

The Topology-Based Event Correlation license is required for the topology-based event correlation
functionality. For details, see the Administration Guide > Event Processing > Topology-Based Event
Correlation.

Time-Based Event Automation (TBEA)

Time-Based Event Automation rules enable administrators to configure actions to be executed on events
matching a user-defined set of criteria after a specified time.

For information, see the Administration Guide > Event Processing > Time-Based Event Automation.

Suppression Rules

Events that match a user-defined filter can be suppressed. For information, see the Administration Guide >
Event Processing > Event Suppression.
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Event Web Service Interface

OMi offers the Event Web Service interface, which is similar to OM’s Incident Web Service interface. It
allows you to receive, modify, and create events. If an OM MSI application is taking a feed for external
purposes, then you could consider implementing it in OMi using the Event Web Service interface or forward it
to external event processing.

For details, see the Extensibility Guide > Automating Operator Functions and Event Change
Detection > Automating Operator Functions using the Event Web Service Interface.

Integrations for Onboarding and Automation of
Configuration

OM allows to automate various configuration tasks, such as:

« Node setup

« Node to node group assignments

« Policy deployment

« Policy creation and modification

o Operator setup

« Automatic granting of certificates

« Configuration exchange between OM servers

These tasks can be automated through the WMI interfaces (OM for Windows), COM interfaces (OM for
Windows), C and Java APIs (OM for UNIX), and server command line interfaces like ovpmutil (OM for
Windows) or opcnode (OM for UNIX).

In OMi, nodes are replaced by Configuration Items and are either discovered or can be created using RTSM
interfaces as outlined above, or using the opr-node CLI.

For automatic configuration deployment, OMi users can use Monitoring Automation automatic assignment
rules. If a Cl is modified or newly discovered, Monitoring Automation automatically evaluates any auto-
assignment rules defined for its Cl type. If an automatic assignment rule evaluates to true, Monitoring
Automation automatically assigns the items specified in the rule to the modified or newly discovered Cl, and
starts the corresponding deployment jobs.

The automatic granting of certificates is possible in OMi based on IP ranges or using a Groovy script.

For configuration exchanges between OMi servers, OMi offers the content pack concept. This allows a semi-
automated configuration exchange. After manually creating or updating a content pack on the source system,
it’s possible to export and import the Content Pack on another system using the Content Manager CLI. Using
content packs you can exchange many configuration data, including policy templates and instrumentation
files, indicator definitions, user roles, filters, ... Similarly, Cl Types, views, and other RTSM artifacts can be
exchanged using the RTSM package manager. Topology data can be synchronized using RTSM-RTSM
synchronization.

However, OMi currently does not allow synchronizing users, user groups, My Workspace pages, or
infrastructure settings.
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Plan Monitoring Configuration

Note: If you do not plan to use OMi Monitoring Automation, you can skip this step.

OMi Monitoring Automation provides the biggest value when you automate the configuration of Operations
Agents or SiteScope. Although OM offers some automation features as well, like automatic deployment of
policy groups based on node groups or discovered services, you might not have used these extensively, or
policy groups or even single policies might have been assigned and deployed manually.

To avoid unnecessary effort during a later step, we recommend that you evaluate your current monitoring
configuration and specifically think about the standards you want to establish.

Consider what type of systems and applications (represented in the RTSM as Configuration Items) should
always be monitored in the same way, and where are variations necessary for a larger or smaller group of
configuration items. Which systems should and can be monitored automatically? Which systems always
need to be configured manually?

Although Monitoring Automation allows to easily tune parameters, it is still a good idea to try to standardize
the monitoring using meaningful defaults, and to try to automate assignments.

For example, you might want to monitor some key Oracle metrics and log files for most of your Oracle
databases, and additional metrics for a smaller group of business-critical databases for which you also want
to be alerted sooner. You can achieve this by using the Oracle Essential Management template for the first
group and a customized Oracle Extensive Management template for the second. But you should also plan the
automatic or manual assignment of those templates.

If you have a standard mechanism to roll out Oracle databases and standard database users and passwords
for Oracle management, then you can start the monitoring of those systems automatically using an automatic
assignment rule. You can specify the database user and password either in the automatic assignment rule or
in your management template.

If instead all your business-critical databases will have varying passwords that are not known in advance,
you must provide the passwords when assigning the Extensive management template manually. Another
option is to assign and deploy the Extensive management template automatically with a wrong password —
knowing that this will produce some error events —and to change the password parameter on the database Cl
afterward.

A third option is to use the Monitoring Automation Web Service interface to automatically assign the
Extensive Management template after setting up a business-critical database, with the database user and
password that were just configured.

Evaluate Your Current Monitoring Configuration

In this planning phase it is a good idea to evaluate what your current monitoring looks like: how you are
monitoring Oracle databases today, What policies are used, What metrics are collected, Where should the
same and where should different thresholds, and therefore different policies, be used.

Some of these questions can be answered using simple OM database scripts. You can download a policy
statistic script that tells you what policies are in use from the HPE Live Network Content Marketplace at
https://hpln.hpe.com/node/14127/contentfiles/?dir=18240.
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As a next step you should determine if your monitoring needs can be addressed by the Infrastructure
Management Pack, which comes for free with OMi, or by other Management Packs.

If there is no Management Pack available and if you want to reuse existing OM policies in OMi, you need to
estimate how many policies need to be imported into OMi. You should only import policies that are in use or
that you plan to use and not the complete policy inventory.

Note: In case you created policy versions or copies of policies to change thresholds or parameters, such
as message groups or custom attributes, then you will not have to import all these variations. You will
instead import one base policy and then use the OMi parameterization feature to implement those
variations.

Plan License Migration

Optional Operations Bridge License Exchange Program

HPE offers an Operations Bridge License Exchange Program. It provides Operations Manager customers
with an easy, standard way to exchange their OM Management Server, OM Basic Suite, Operations
Agent/Operations OS Instance, Operations SPI and Reporter licenses to Operations Bridge Premium and
OMi Management Pack licenses.

Note: This license exchange will allow customers to continue to concurrently use their existing software
(like OM and SPIs), which allows customers to move to OMi, Operations Bridge Reporter, and
Operations Bridge Management Packs at their own pace.

Contact your HPE account team or HPE partner for details.

TBEC License

Note: The Operations Bridge License Exchange Program does not include the OMi add-on product
TBEC (Topology-based event correlation).

If you want to evaluate this feature during an evolution project, make sure the temporary Instant-on license
has not expired. It is activated when OMi is installed. If OMi was already in use, request a new temporary
evaluation license from the HPE Software License Center.
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Establish Infrastructure Topology

As described in the planning phase, OMi offers various advantages when the IT objects being monitored are
represented in the RTSM as Configuration Items of specific Cl types.

You should create these Cls as part of afirst step, before integrating events, so that you can benefit from
these advantages from the start.

Creating Node and Infrastructure Cls Using Topology-
Synchronization of OM Node and Service Data

As an OM user, the easiest way to populate the RTSM is using the data that is already available in OM. OMi
topology synchronization allows you to create Cls based on the OM nodes, node groups, layout groups and
SPI service models. You can specify which SPI service models should be synchronized.

Infrastructure Cls can be created from the discovered services of the following SPIs:

« Microsoft Active Directory

« Exchange

o Lync

« SQL Server

« lIS

« Oracle Database

« WeblLogic

o WebSphere

« Blackberry Enterprise Server

« Infrastructure (including System, Cluster and Virtualization Infrastructure)
« SAP

See the following information in the OMi Integration Guide:

« Establishing a trust relationship between OMi and OM
« Setting up the OM server as a connected server
« Synchronizing the topology
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Creating Node Cls

Node Cls (and corresponding IP address and Operations Agent Cls) are either created via topology
synchronization or created automatically for all nodes that run an Operations Agent when an agent is installed
and connected to OMi. Every agent sends basic information about itself to its primary manager and this
information is used by OMi to create node, IP address, interface and Operations Agent Cls with
corresponding relationships.

However, if you do a lot of proxy monitoring where one agent acts as proxy and creates events for various
other nodes (for example using SNMP policies), then these nodes have to be created either manually or by
using other mechanisms. If you are using topology synchronization, those proxied nodes are created based
on OM external nodes or message allowed nodes.

Creating (Proxied) Node Cls Manually

The easiest way to create node Cls manually is using Administration > Setup and Maintenance >
Monitored Nodes. For details, see the Administration Guide > Setup and Maintenance > Monitored

Nodes.

Creating Infrastructure Cls

Infrastructure Cls can be created using topology synchronization based on OM SPI discovery data for the
following areas: Microsoft Active Directory, Exchange, Lync, SQL Server, 11S, Oracle Database, WebLogic,
WebSphere, Blackberry Enterprise Server, Infrastructure (including System, Cluster and Virtualization
Infrastructure) and SAP.

After moving to OMi, when SPIs are no longer used, it is necessary to replace the SPI discovery with
corresponding OMi Management Pack discovery aspects (where available). See the OMi Management
Packs Evolution Guide for details.

Note: Removing a SPI discovery policy from a node triggers the deletion of services in OM and of Cls in
the OMi RTSM. To prevent this from happening, set the Skip Cl Deletion infrastructure setting
(Infrastructure Settings for Operations Management > HPOM Topology Synchronization Settings) to
true. This will disable the automatic deletion of Cls when performing topology synchronization.

Operations Management - HPOM Topology Synchronization Settings

Name~ Description Value

Commit Bulk Size T o commit ta the RTSM in a single <all 2000

ta from all processing steps to the hard disk. This is not nded for production systems, asithas .\

Dump Data
Groovy Scripts

Packages for Topology Sync defauitnodegroupsioperations-agent

&I RISIRIS]

|Sk\p €I Deletion true |

Discovery aspects are often assigned to Computer or node Cls. See the corresponding Management Pack
Online Help section for details about how to deploy the discovery aspects.

If no Management Pack exists, there are several ways to populate the RTSM with Cls and CI Relationships.
For more details, see Technologies for Establishing Infrastructure Topology in the Plan the Evolution chapter.

If a BSM Connector is used to integrate other domain managers, it can also integrate topology from those
domain managers. Details about BSM Connector installation and topology policies are described in the BSM
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Connector installation and Upgrade Guide (interactive document), the documentation of the specific BSM
connectors available on the HPE Live Network Content Marketplace (for example, see
https://hpln.hpe.com/contentoffering/bsm-connector-microsoft-scom), and in the BSM Connector Help under
Integrating Data With BSM Connector > Topology Policies.

How to Create Cls Using Enrichment Rules

If the purpose of the node and the software running on it can be determined from node attributes like the node
name, for example W28HRPROD for Windows 2008, HR application, Production system, or RHFINTST for
Red Hat, Finance application, Test system), then Enrichment rules can look for nodes with certain node
names and can create Running Software Cls.

This is possible as long as there is only one such running software Cl per node and if the Running Software
Cl creation does not require additional identification attributes or key attributes. Enrichment rules are not a

suitable solution for creating Oracle database Cls, as multiple such Oracle instances can run on one node,
and the oracle SID must be known to create the Cls.

For information on creating enrichment rules using the enrichment manager, go to Administration > RTSM
Administration > Modeling > Enrichment Manager. See the corresponding OMi Help topics for details.

The following example shows the most important settings. It assumes that a new “Custom Application” CI
type has been created as a sub-type of the Running Software CIT, inheriting all settings, such as attributes
and identification rule.

The example enrichment rule creates a running Software Cl of type “Custom Application” and the
composition relationship to the node.

Create a new enrichment rule. Add the computer CI type and use Query Node Properties to filter the
nodes:about node queries.

The example rule looks for all nodes containing “win” in the PrimaryDnsName, as you can see in the
Attributes tab of the Computer CIT:

AddCustomépp
Enrichment Mode| ¥ | G &p | B Ty | Mode: | k Select v & Layou

Camouter

Ennchment Rules | * Afributes
PrimarvDnsName Like ignore case %owin®s

Switch to enrichment mode and add the custom application Cl type. Create the composition relationship
between both. Use Update Query Node:
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Computer
+ Composition
s
#£ Delete Selected tem(s)

io| 1e Add Relationship

Update Cluery Node

Provide a Name and DiscoveredProductName, as these attributes are required for identifying a Running
Software ClI.

The enrichment rule summary can be seen on the Enrichment Rules tab:

P

#% Enrichment Rules

Action: Create

Set Attributes:
DiscoveredProductName = MyCustomApp
Name = MyCustomApp
Container = Computer.cmdb_id

You can use the Calculate Query Result Count button to check how many Computers currently match the
query. In the example there are seven matching Computers.

AddCustom&pp

Enrichment Mode : e

|El| 1y |mode: | k select

| Calculate Query Result Count |

—

Computer(7)

+ Composition
N
Custam Applicat

ion

Next, you have to activate the rule (in the rule properties) and create a schedule job to run it:

Go to Administration > RTSM Administration > Administration > Scheduler and create a new job that
executes an enrichment rule. Pick the enrichment rule you created and define a schedule, for example, once
per day.
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Administration = Scheduler

Modeling Data Flow M ment

View = Tools -

Job Scheduler
+ o X|T US| ?
Active | Name | Job Definition | Schedule Last Run Time Next Run Time
SoftwareElementDispl... Interval ([Repeat every 23 Hou... | Tue Mar 25 2014 05:... | Wed Mar 26 2014 04...
DeleteQldSAPTranspo... Daily ([00:00]) Wed Jan 152014 12...

SiteScope Application... | SiteScope Application Host upgrade Interval ([Repeat every 50 Min... | Wed Jan 152014 12...
AddCustomipps run enrichment rule to add custom ap... | Interval ([Repeat every 5 Hour... Wed Mar 256 2014 06...

Run an Enrichment Rule [ x|

Select a maximum of 15 items.

KOO

Run an Enrichment Rule

| Hame Parameters
ADAM_Depends_DomainCo..
ADAMDemainControllerDepe.
Add Monitored By to EMS Cls
Add Monitored By to SiteSc...
AddCustomApp
addServiceOwnership

L | e

addSlaOwnsership
AlSslasEventLinkEnrichment
Application Host Model Enric...
Application Host Model Upar...
BBER_Component_Database

3
e ——

ok Cancel |

I o o

If needed, you can use the Modeling Studio to create a view that shows all nodes with the “Custom
Application” SW running, for example, using a simple pattern view:

LI Nodes running my custom app X] 4 F B
B oo

Query D iti Higrarchy
DINEEEEIEE =

Hierarchy Method: ® Manual

Nodes running my custom &
él—% Node

L@ Custom Applica

Composition

G

el Tl e m
o

Custom Applicat
ion

B
"
=

“«©

| Legend: & Contact Mode /™ External U Has Conditions @ Has ldentities %

Consolidate Events from Various Sources

After establishing the infrastructure topology it’s time to integrate events. As the necessary Cl topology
already exists, OMi Cl resolver can relate events to the correct Cls, which allows
view-based filtering and other Cl-type specific functions.
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Connect OM to OMi

To forward events from OM to OMi, see the following information in the OMi Integration Guide:

« Configuring the OM forwarding policy
« Validating event synchronization

Note: Other steps were completed when integrating the topology of OM.

Connect SiteScope to OMi

To forward events from SiteScope, see the SiteScope manual Integration with HP Operations Manager
Products.

Connect Other Domain Managers to OMi Using BSM
Connectors

To forward events from other event managers, see the documentation of the specific BSM Connectors
available on the HPE Live Network Content Marketplace (for example, see
https://hpln.hpe.com/contentoffering/bsm-connector-microsoft-scom) and the BSM Connector Help.

Control Events

Once events are integrated, you can use OMi correlation, enrichment, and automation features to control
events.

A high-level overview of the available features has been provided in the Planning the Evolution chapter of this
guide.

Event Correlation

Duplicate Suppression

The duplicate suppression concepts are almost the same between OMi and OM. Unlike OM, however, OMi is
also able to detect duplicates based on ETI values.

If required, you can change the default duplicate suppression settings in Administration > Setup and
Maintenance > Infrastructure Settings.

Select Applications and use the list to set the administration context to Operations Management. Scroll to
Operations Management - Duplicate Events Suppression Settings.
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Closing Related Events

Like OM, OMi is able to close related events based on message keys and key-matching patterns. OMi is also
able to detect related events based on HI values. If required, you can change the default settings in
Administration > Setup and Maintenance > Infrastructure Settings.

Select Applications and use the list to set the administration context to Operations Management. Scroll to
Operations Management - Change State of Related Events Settings.

Stream-Based Event Correlation (SBEC)

Go to Administration > Event Processing > Correlation > Stream-Based Event Correlation, and see
the corresponding OMi Help topics for details.

Stream-Based Event Correlation (SBEC) uses rules and filters to identify commonly occurring events or
combinations of events, and helps simplify the handling of such events by automatically identifying events
that can be withheld, removed, or require a new event to be generated and displayed to the operators. This
can be useful when replacing OM ECS.

The following types of SBEC rules can be configured:

« Repetition Rules: Frequent repetitions of the same event may indicate a problem that requires attention.

« Combination Rules: A combination of different events occurring together or in a particular order indicates
an issue, and requires special treatment.

« Missing Recurrence Rules: A regularly recurring event is missing, for example, a regular heartbeat event
do not arrive when expected.

SBEC Rules are processed in the order defined in the rules list. Modifications are executed as soon as the
rule is matched, and subsequent rules see modifications done by earlier rules.

Topology-Based Event Correlation (TBEC)

The Topology-Based Event Correlation license is required for the topology-based event correlation (TBEC)
functionality. This builds on the Event Management Foundation license.

For details, see the OMi Help section Administration > Event Processing > Correlation > Topology-
Based Event Correlation.

At this stage you can begin to benefit from TBEC if you are using OM SPls, as those SPIs send events that
match the out-of-the-box TBEC rules. These rules are enabled per default, and no additional configuration is
necessary.

If you use custom policies without Event Type Indicators, then TBEC will not be able correlate them. We
recommend that you add Event Type Indicators to your custom policies at a later stage, see chapter Add
value on Top.

Event Storm Suppression

Like OM, OMi can detect an event storm on a system and discard events (if not matched by an exception
rule), until the rate of incoming events drops below the event storm end threshold.

HPE Operations Manageri (10.10) Page 34 of 196


http://mambo4.mambo.net/topaz/amdocs/eng/doc_lib/Content/OMi/AdminGuide/om_ui_SBEC_UI_Repetition.htm
http://mambo4.mambo.net/topaz/amdocs/eng/doc_lib/Content/OMi/AdminGuide/om_ui_SBEC_UI_Combination.htm
http://mambo4.mambo.net/topaz/amdocs/eng/doc_lib/Content/OMi/AdminGuide/om_ui_SBEC_UI_Recurrence.htm

OMi Evolution Guide
Chapter 3: Establishing Topology, Consolidating, and Controlling Events

To change the default settings, go to Administration > Event Processing > Correlation > Event Storm
Suppression and see the corresponding OMi Help topics.

Administ

jon | Event Processing / Correlation / Event Storm

Event Storm Suppression
S 2 [

v General

Active: v

Artitact Originc 0 Pretefined

~ Conditions

Beegin event storm suppression when mare than 1000 everts are received from the same node within § minute(s)

End evert storm suppression when less than 100 everts are received fram the same node under storm conditions within § minute(sy.

¥ Begin Event

Tile: Evert storm tietected for '<evert Sources", Current incofming event rate: <evert counts events f <time interval= seeonds.
ETI Hint: EvertStorm: On

Severty: €3 critical

Category Internal

Subcategory: Evert Storm Suppression

Close Previous End Evert:  —

~ End Event
Tile: Event storm for '<event source=' is over, Current incoming evert rate: <event court= events / <tme inferval> seconds.
ETIHirt EventStorm Off
Severity: @ viormal
Category:  Internal

Subcategory:  Event Storm Suppression

Lag Only: -

Event Suppression

OMi can suppress events on the server using event filters. This is useful if the event generation is not under
control of the Operations Bridge and cannot be disabled at the source. Go to Administration > Event
Processing > Correlation > Event Suppression and see the corresponding OMi Help topics.
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Administration / Event Processing / Correlation / Event Suppression

~ General

el
-

Display Mame:

Description: drop all events with "suppress me” in the title

Create Event Suppression Rule

5 Event Suppression Rule

Drops all events matching the assigned fiter. Dropped events cannot be recovered.

+ Display Nams: |Evant Suppression Rule ‘

Description: drop all events with "suppress me” in the title

+ Filter: | T title contains"suppress me” |v | ‘

(+) Required field

- e

Event Enrichment

Event Enrichment and Custom Processing Through EPlIs

Event processing customization enables you to implement custom script-based event processing directly on
events. This is possible at four different processing stages: before CI/ETI resolution, after CI/ETI resolution,
before storing the event in the database and after storing the event.

The range of events fed into the custom event processing can be controlled by specifying event filters.
Different scripts can be enabled or disabled during runtime.

The script-based event processing logic has to be supplied as a groovy script. A number of sample scripts are
available in the following directory:

<OM1_HOME>/opr/examples/epi_scripts

Go to Administration > Event Processing > Automation > Event Processing Customizations and see
the corresponding OMi Help topics for details.

You can find the Groovy/Java APl Documentation at the following location:

<OM1_HOME>/opr/api/doc/opr-external-api-javadoc.zip

EPI Script Development Kit

The OMi Script Development Kit available from the HPE Live Network Content Marketplace
(https://hpln.hpe.com/node/14127/contentfiles) helps script developers edit, validate, test, and debug their
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HPE OMi groovy scripts within Eclipse, outside of an HPE OMi installation. The benefits of using the OMi
Script Development Kit in Eclipse include:

« Automatic completion and online documentation for HPE OMi Event Processing Interface (EPI) APIs.

« Create and feed test events into an EPI scripts and get the resulting modifications Visual debugging
support to step through EPI script execution.

« Import sample events from a running HPE OMi system.

« Configurable access to a running HPE OMi Run-time Service Model (RTSM) instance for topology
queries.

« back for verification.
Example of an EPI Script to Modify Event Attributes
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import

import

import
import
import
import
import
import
import
import
import

import

/*

java.util.Date;

java.util.List;

com.
com.

com.

com

com.

com

com.

com.

com.

com.

hp.
hp.
hp.
.hp.
hp.
.hp.
hp.
hp.
hp.
hp.

opr.
opr.
opr.
opr.
opr.
opr.
opr.
opr.
opr.

opr.

api.
api.

api.

api

api.

api

api.
api.
api.

api.

scripting

scripting.
scripting.
.scripting.
scripting.
.scripting.
scripting.
scripting.
scripting.

scripting.

.Action;

Event;
EventActionFlag;
LifecycleState;
MatchInfo;
NodeInfo;
PolicyType;
Priority;
ResolutionHints;

Severity;

* This example set all possible event attribute to some example

*/

class SimpleExample

{

def init()

{

def destroy()

{

def process(List<Event> events)

{

events.each {

event -> modifyEvent(event);
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def modifyEvent(Event event)

{
String application = event.getApplication();

"

event.setApplication("Modified by EPI: + application);

long groupIld = event.getAssignedGroupId();

event.setAssignedGroupId(groupId);

int assignedUserId = event.getAssignedUserId();

event.setAssignedUserId(assignedUserId);

Action autoAction = createSampleAction();

event.setAutoAction(autoAction);

ResolutionHints hints = createSampleResolutionHints();

event.setNodeHints (hints);

String ciInfo = event.getRelatedCiHint();

event.setRelatedCiHint("Modified by EPI: " + cilInfo);

def ResolutionHints createSampleResolutionHints()

{

ResolutionHints hints = new ResolutionHints(false);

hints.setCoreId("CoreId");
hints.setDnsName("mydqdn.com");
hints.setHint("My Hint");

hints.setIpAddress("0.0.0.0");
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return hints;

def Action createSampleAction()
{
NodeInfo actionNodeInfo = new NodeInfo(false);

Action action = new Action(false);

actionNodeInfo.setCoreId("CoreId");
actionNodeInfo.setDnsName("myfgdn.com");

actionNodeInfo.setIpAddress("0.0.0.0");

action.setCall("Call");
action.setNode(actionNodeInfo);
action.setStatus(EventActionFlag.AVAILABLE);

return action;

The following figure shows the configuration dialog where EPI scripts are specified:

Administration > Event Processing > Automation

Event Processing Customizations

EPI Steps

Event Processing Scripts

Details

(=] )

ResolutionCompleted

ok [ & K =
EJ Enrich Events.

HPE Operations Manageri (10.10)

LURAIE SO 7 B/

~ General

D: 581b6110-baad-284b-82fc-adcel1dedbdT

Display Name: Enrich Events

Artifact Origin: @ Custom

Description: enrich events with owner information

Active:

Script: [ import java.util List;

class GroovyScriptSkelston
def init()
i
H
def destroy()
{
H

def processiList<Event- svents)
5

import com.hp.opr.api.scripting.Event;

~ Advanced

3

|

Class Path:
Event Fiter: all events.

Timeout: 0

Read-Only:
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Event Automation

Some of the automation features described in the following section refer to operators or operator groups that
are created in a later phase. Therefore, the implementation of these operator-focused automations might have
to be completed at later point. If the operator groups are already defined, you can already refer to them in
automation rules (even if the permissions for each group are not yet defined). Otherwise, set up the rules
when the operators and groups are set up.

Time-Based Event Automation (TBEA)

Time-Based Event Automation rules enable administrators to configure actions to be executed on events
matching a user-defined set of criteria after a specified time.

« If an automatic action for a message fails, you can configure a restart of the automatic action after a short
delay. If it repeatedly fails, after a predefined number of retries, further retries are stopped and the event is
escalated.

« Ifaneventis not being worked on after a predefined period in time, you can configure a change to give it
higher priority, for example by increasing its severity, or by assigning it to the next support level.

« You can configure the closing of an event that is older than a predefined period of time.

« You can configure transferring control of events based on event age. For example, escalate if an event
remains in the browser for more than 2 days, close if the message remains for longer than 7 days (despite
the escalation after 2 days).

The following figure shows available actions for Time-Based Event Automation rules:

Actions

g & ®
£ Re-run Automatic: Action —
fs Moty Event. .
15 Forward Event...
ﬁ-‘_‘. Azzign Evert...
= Run Script...

=] Launch Run Books ...

Go to Administration > Event Processing > Automation > Time-Based Event Automation, and see the
corresponding OMi Help topics for more details.
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The following example shows a time-based event automation scenario, which increases the severity of an
open event after 1 hour:

Administration | Event Processing / Automation / Time-Based Event Auromation

Increase Severty And Priority - Detalls

~ General

Display Name:  Increase Severity And Priority

Description:  Increase the severity and priority of open everts after 1 hour.

Active: false

Artifact Origin: @ Custom

~ Conditions

Event Fiter:  Open

lExecute, if fiter matched for 1 hourcs)

~ Actions

1. v §- Madify event
Moifies event stiributes for the matching evert
Atributes  Severty e

Priority Increase value

Automatic Run Book Execution

HPE Operations Orchestration (OO) run books that do not require any user input can be started automatically
when an event matching a certain filter is received. The start and the result of the run book execution will be
added as annotations to the event.

To achieve this, you first have to integrate OO into OMi and map OO run books to Cl Types. See the OMi
Integration Guide for more information. This integration will then also allow operators to launch run books
manually. You can then use those run books in automatic run book execution rules by going to
Administration > Event Processing > Automation > Automatic Run Book Execution.

Create a new rule and specify an event filter for which the run book should be executed, then select the run
book.

Note: You will only be able to select run books after completing the OO integration.

The following figure shows an example automatic run book execution rule:
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| Event Automation > Automatic Run Book Execution

Setup Event Automation | Ewvent Correlation Operations Console Monitoring 5|
Run Book Rules Run Windows Health Check if CA runbook=whc - Details
o AREN TV O v ? ?
1 General =]

Display Name: Run Windows Health Check if CA runbook=whc

Description: Run Windows Health Check if custom attribute "runbook™=whec

Active: false
Artifact Origin: @ Custom
Condition (&
Event Fitter: CA runbook=whc
:| Actions &
Cl Type Run Book Name

Windows <Run Book Mapping unknown or incomplete=

Automatic User Group Assignments

OMi can automatically assign events to user groups. The events to be assigned are defined by an event filter
or view filter. Automatic user assignment is initiated as soon as events arrive in HPE OMi.

To configure user group assignment rules, go to Administration > Event Processing > Automation >
User Group Assignments.

Note: This requires operator groups to have already been defined, which might not be the case at this
stage of the evolution.

Forwarding to Incident Management Systems

Incoming events can be automatically forwarded to Incident Management Systems like HPE Service
Manager and others.

OMi provides an enhanced out-of-the-box integration for HPE Service Manager that includes:

« Relating incidents, when the corresponding events are related

« Displaying current incident attributes (lifecycle, assigned group, severity, priority) in the event
« Light-weight single sign on cross launch in context from the event to the incident

« Visibility of recent changes and incidents for the related Cl

« Downtime handling

Events can be forwarded using two techniques: using a Groovy script that accesses specific APIs of the
external server, or through an event web service interface that has to be implemented by the external server.

See the Extensibility Guide > Integrating External Event Processes and Administration Guide >
Event Processing > Event Forwarding for more details about the forwarding interface. See the OMi
Integration Guide for details regarding the out-of-the-box integration with Service Manager.

To set up an external event processing server, go to Administration > Setup and Maintenance >
Connected Servers and create a new server of type external event processing server.
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Once the external server is ready, you can set up a forwarding rule. Go to Administration > Event
Processing > Automation > Event Forwarding.

OMi provides a default forwarding rule called “Automatically Forward to Trouble Ticket Systems”, which is
disabled per default. It forwards all events for which the trouble ticket flag is set. The flag is internally
translated into a corresponding custom attribute ForwardToTroubleTicket, which can be used in the
forwarding event filter. You only have to specify the server it should use.

Administration / Event Processing / Automation [ Event Forwarding

Event Forwarding Rules Detailz

Automatically Forvard to Troukle Ticket System - Edit Event Forvarding Ruls

¥ General

+ Display Mame: |Autnmat\cally Forward to Trouble Ticket System | 1

Description: Automatically forvward non-closed events to trouble ticket svstem, if indicated by the custom
attribute ‘ForwardTaTroubleTicket' with the value ‘true'.
Caondition
+ Event Filter: | T Forward To Troukle Ticket System | - ‘l

Target Servers

< EIEER N5

+ [ Trouble Ticket System

Forwarding Type: |Notify and Update | - |
Artitact Crigin: 0 Custom

Active: =

Mame: TroubleTicketSystem

Type: Alias

Fully Qualified DNS Mame:
Port: a
Forward Dynamic Topology:  —

Description:

[#) Recuired field

) ) i

By default, the forwarding type “Notify and Update” is used, but other forwarding types are possible,
depending on your requirements.

« Notify and Update: target server receives original events and all further updates (event will be closed in
OMi).

« Synchronize: target server receives original events and all further updates and sends back all updates
(event might be closed by OMi or target server using event sync web service).

« Synchronize and Transfer Control: target server receives original events and updates and sends back all
updates. Ownership of the event is transferred to the other server. (event will be closed by target server
using event sync web service).

Event Integrations via Web Services and CLI

OMi offers the Event Web Service for integrating events into other applications, and automating operator
functions. This is a REST-based web service that allows you to do everything that an operator can do in the
console while working on events. It also provides subscription support through Atom feed functionality. You
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can read an Atom feed in your browser, where you can see a list of events, and you can also create and
update events using the Atom service.

Create, read, update, and delete operations can also be performed from the command line using the REST
Web Service command-line utility.

For more details and examples, see the Extensibility Guide > Automating Operator Functions and
Event Change Detection.

OM provides its own Incident Web Services as well as CLIs and APIs to manage events externally. OM
Incident Web Services comply with the DMTF WS Management standard, enabling these operations on one
or multiple events:

« Get, create, and update events

o Close, reopen, own, disown events

o Get, add, update and delete Annotations

« Add, update and delete Custom Message Attributes

« Start or stop automatic or operator-initiated actions

« Getinstruction text for an event

« Get notification for changes on events (including filtering support)

All CLI functionality described below, except for deleting events and downloading and uploading events, can
be achieved with OM Incident Web Services and with the OMi REST-based Event Web Service.

OM and OMi CLI Functionality Comparison

The following table compares auditing functionality in OM and OM.i.

OM for
Functionality OM for UNIX Windows OMi
Close events | opcmack opcmack through Incident web service / RestWsUtil CLI
(agent) (agent) or
opcack ovowmsgultil*

opr-close-events[.bat|.sh] — close all events or close
opcackmsg events selectively based on by date received range,
severity, related Cl, node Cl. This is designed to be run

opcackmsgs | Createa VB ‘offline’ since it does not update running Uls

script using
WMI methods

Reopen opcunack ovowmsgutil* | Through Incident web service / RestWsUtil CLI
closed events

Createa VB

script using
WMI methods
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Set, unset,
and change
ownership

Add, modify,
remove, and
list custom
attributes

Add and list
annotations

Change
severity and
text

Read events

Delete events

Delete
queued
events

HPE Operations Manageri (10.10)

opcownmsg

opccmachg

opcannoadd

opcannoget

opcmsgchg

opcgetmsgdet

opcmsgsrpt

opcdelmsg

opcdelmsgs

ovowmsgutil* | Through Incident web service / RestWsUtil CLI

Createa VB
script using
WMI methods

Createa VB
script using
WMI methods

Through Incident web service / RestWsUtil CLI

Createa VB
script using
WMI methods

Through Incident web service / RestWsUtil CLI

ovowmsgultil*
can change
severity (not
message
text)

Through Incident web service / RestWsUtil CLI

Createa VB
script using
WMI methods

Createa VB
script using
WMI methods

Through Incident web service / RestWsUTtil CLI

No No

No No
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Download or | opcactdwn, ovowmsgutil* | opr-archive-events[.bat|.sh] — Download closed events,
upload events = opcactupl based on date range, severity, and node from the DB.
opchistdwn, Uploading archived events is not supported.
opchistupl

opr-export-events[.bat|.sh] and opr-import-events
[.bat|.sh] support exporting and importing all or selected
events in any lifecycle state

* ovowmsgutil runs bulk operations on messages. It makes changes directly to the database, stopping some
OM for Windows services while it executes.

Running External Programs (such as Perl scripts) from
Groovy

There is currently no tool to export and import OM Composer elements into OMi. However, it is possible to
reuse Perl scripts, which were used in OM Composer to enrich events, inside OMi EPI scripts. This is
possible because Groovy allows running external programs, and can run a Perl interpreter and Perl script.
With Groovy you can also use the execution function to start an external program.

For example, you could launch your OM-based Perl script using the following code:

def start_exec( List<String> cmd)

{

def sout = new StringBuffer(), serr = new StringBuffer()

def proc = cmd.execute()

sleep(50);
proc.consumeProcessOutput(sout, serr)

proc.waitForOrKill(2000000)

if (serr.length()>0){

println "error $serr";

return sout

}
You can use the above function with below code:

ret=start_exec( ["perl.exe", "your_perl code.pl", “parmeter2”]);
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The package jerlWrapper.perlVM is available from https://code.google.com/p/jerl/, which might perform
faster when loaded into the EPI script init area.

Downtime Handling

OMi downtime is scheduled to occur once or on a recurring basis. It is based on selected Cls and their
relationships in the RTSM, dynamically listening to topology changes. For example, if a node Cl is put into
downtime, all impacted Cls are put into downtime as well: if at the time there are two Oracle instances on the
node, they are put into downtime.

Each downtime is associated with a selected downtime category which defines how events are processed
for the Cls in downtime. For example, you could have a downtime category that sets the event to closed,
execute EPI scripts and automatic run books.

Other actions during downtime can be to suppress notifications, set KPls to downtime status and disable
SiteScope monitors. For further details, see the Administration Guide > Service Health > Downtime
Management.

Note: While a downtime is active, you cannot modify it. You can delete it from the JMX console. For
details, go to https://softwaresupport.hp.com/group/softwaresupport/search-result/-
[facetsearch/document/KM1155257).

OM and OMi Downtime Functionality Comparison

The following table compares downtime functionality in OM and OMi.

Functionality OM for UNIX OM for Windows OMi
Define Yes. Yes. Yes.
scheduled

outage

Define Yes. Yes. No.

unplanned or
ad hoc outage

Put node or Yes. Yes. Yes. For CiCollection (node
node group in group equivalent)
outage
Otheroutage | Services and other Services and service Additional default Cl Types
criteria message attributes hierarchies. include running software,
(severity, application, business application,
object, type, text, CMA). Infrastructure service, business

service. Can add or change ClI
Types toinclude. Impacted Cls
are also put into downtime.

Event state Log only or delete. Log only or delete. Closed (log only), resolved or no
set during change.
outage
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Event No. Yes, custom message Yes, ‘Received in downtime’ flag.
attribute to attribute.

indicate

received

during outage

Disable No. Yes. Not applicable.

heartbeat

polling

Automation Yes, through outage file Yes, through Yes, via Downtime REST API.

editing and opccfgout CLI. = ovownodeutil and
ovowserviceutil CLI.

User Create tool(s) that execute = Permission to set Permission to view or to have full
permission opccfgout to set unplanned outage on control of scheduled downtimes
unplanned outage. Create nodes/services inuser's | to set downtime for Cls in views
tool(s) that assign node to | responsibilities. to which the user has access.
node group in Permission to specific
“maintenance”. Grant user policies (for example, for
access to the tool(s). scheduled outage).
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Overview

OMi allows building one or more customized operator My Workspace pages for each operator group, or even
individual operator, with its My Workspace framework and Ul components such as the event browser, view
explorer, event dashboards, watch list, health views, action panel, or business impact view.

Within a My Workspace page operators can use different views to monitor the health of the Cls they are
responsible for, or the events that occurred in their IT environment.

Operators can review the instruction text for an event and run tools, run books, event-related actions, and
performance graphs in the context of a specific event or Configuration Item from the context menu or action
panel.

The following figure shows an example of a customized My Workspace page:

() Operations Manager i Workspaces~  Administration v~ Q Liadminv @~

Workspaces - Operations Console.

Discover OMi x  AOBDasiboard x  AOBIG Status&Action x  ROIDashboard x SelectPage ~ cBEEDH £H¢ @
‘Manitoring Dashboard - AOB IG Datacenter Status - & A X TopView v W& A x Adons - |& ~ x
AdBetworc V@ o [rar—_—_ allg 2
P T —_—— ?
Euent v repors longcurton o User Transsct
G Onlne Banking Web Avp
Node:  sn_002

[ cicconz 8] (@ rtvanct_gv01 8]

_ 2 searen .
lobile Access = Vertica'
4 wonien i Is Veteans . Fler @ Al Gl Souceol  Node

(105 134] v . A 10
(@ cisco01 2] e @ mobile_router @ 2o Show Performance Grap... (C1)
21 & ceco01 2] e o
I* Notwork s

oo (o Last Updat: 10/26/2014 031733 AN b oce!
© Event Browser - & « )
0L £ 8 B 4 - & I <NoFiter~ hd ¥ <NoFilter> ~ ea s o8 E: L ? |T Traceroute to node fro... (Node)
Sev Pio C N | A U D St. TimeReceived v Title Related CI User Group. Category AT Traceroute to node fro... (Node)
[a ~ B - 1502 onine Baning Web 00 onine Banng
Mems: 210121 (1) 03 V3 ¥ as o8 @0 &0 0 1 20 5

The following table shows the comparison between OM and OMi operator features:

OM operator functionality Equivalent in OMi
Review instructions. Yes.

Launch tools on messages, nodes, services. Yes, launch tools on events and Cls.
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(Re-)Launch event actions. Yes.
Launch graphs on messages, nodes, services. Yes, launch graphs on events and Cls.

Launch reports on messages, nodes, services (OM for = OBR reports, can be integrated in My Workspace

Windows). which allows launch in context of a ClI.

Event lifecycle (own, disown, acknowledge, assign Enhanced event workflow (assign to/work on/
(OM for Windows)). /resolve/close).

Modify Event attributes: text, severity, CMAs, Yes: title, severity, CAs, annotations, as well as
annotations. description and solution.

Hyperlinks (http/s, ftp) embedded in text (OM for UNIX ' Yes, title, CAs, annotations, original text,
and OM for Windows), application, object, CMAs, description, solution.
annotations (OM for UNIX).

Set unplanned outage (OM for Windows). Currently only possible by defining a scheduled
Cl Downtime which starts immediately.

Broadcast to all or selected operators (OM for UNIX).  Not supported.

$OPC_NODES replacement in tools (allows to launch ' Currently not possible in OMi.
a tool which gets selected nodes as input parameter).

Start tool on many nodes (multi select nodes).

Instruction text interface to retrieve instructions from OMi offers an external instruction text interface,

external system. which allows you to retrieve instructions from
external databases, web pages or other sources.
See the Administration Guide > Operations
Console > External Instructions for more details.

First time received event column (OM for Windows), OMi has Time First Received and Time Received
time received and time last received event column columns (duplicate overrides time received).
(OM for UNIX).

Browser Filters. Supported (also public and private filters).

History filters. Yes. OMi allows to use event and date filters for
the Closed Events Browser.

Message colors. Supported (browser options).

Reorder columns. Supported (browser options).
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Column choices.

Play sound.

Run local application or trigger popup based on event
severity (OM for UNIX).

System tray icon / popup (OM for Windows).
Custom Ul layout.

Service maps/views.

Service Label and Service ID in message browser.

Service Name

Severity [ Service Label ][

Disk 2 node2_disk

Major Mail Server 2 email_node2

‘Warning  Eurocpe europe
Sel_SPlServer@@company .com
Sel_SPLServer@@ocompany .com

s of NS 0 18

0 All Active Messages ‘
Select Map View
L@ sclectivep

—

Contextual link to OM policy from message

Restrict operator permissions: globally set limited for
messages owned by others, per user/profile can allow
perform actions, modify message, own, (un-)Jack (OM

for Windows) or view, (dis-)own, (un-)ack, perform
actions, modify message on a per message group
basis (OM for Windows).

OM for UNIX Java feature.

Font size (Edit -> Preferences -> General).

HPE Operations Manageri (10.10)

Supports most columns available in OM.

Does not have first time received attribute,
unmatched, time unbuffered.

Has these attributes, but cannot select as
columns: message key, origin, policy, policy type

CAs can be selected in columns, but it requires
the admin to predefine the list of CAs the operator
can choose.

Many new columns available, for example, event
age, correlation, priority, received in downtime, ...

Supported (browser options, default sound).

Not supported.

Not supported.
Conceptual (My Workspace).

Yes, several widgets. Forexample, Top View,
Health Top View, Watch List.

Related Cl, Related CI hint (equivalent to service
ID) and Node in event browser.

Sev | Related CI Related Cl Hint Node

W mambo3 mambo3.mambo.net mambod
BACDB BACDB@@oradb3.mambo cradb3

OM Knowledge| UCMDB:4215438b41aeb2e

| Q 3

Yes.

More granular control.

Not supported.
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Browser advanced filters — event filters and very
flexible message view filters.

Dynamic Label in event browser.

Custom or Sub Service Maps can be created with
moving icons or externally calculated icon posmons.

Property files customization.
secure https mode.
Broadcast tool.

Custom message icons.
List connected Uls.

Dashboard — event history, pie chart, bar chart, cockpit
view.

Detach window.

HPE Operations Manageri (10.10)

Supported (same on concept base).

OMi has an extensive list of attributes and
patterns that can be combined together with
AND, OR, and NOT operators.

Note: OMi does not have an equivalent node
event attribute (the closest is related Cl hint).

Not supported.

Use “Geographic Map*® using “Location” Ci in
RTSM.

[iodeing > odeing Sodo

Modelng Data Flow Management Administration

ClTypes~ Fdit - \View~ layout - Operations - Jools~

Cl Types Depender

Detais |[Attributes || Quatiers | lcon

Aftached |

Cirypes  ¥|| = X & 7 This page enables you to edit the aftributes of the C1 type.

S Managed Otject () =

Name. _Tyee Descripten | Defautt Value.

Visbe

global _scope.
root_jscandidsteford.
root_lastaccesstime

Defaut
s candidat.. | false
When was

Is Candidte For Del
Last Access Time

Iaftude.
layer layer

Locaity localty
LocationBarCode localion_bar_code | sting

Latiude Lattude of
faciities

Represent.

Locations £

LocationType
Longitude
MENU

locaton_type
longitude string
MENU Sl

Describes
-0 Pam (41 Longitude:

Contract (0) f SVENU: <

<< <<

MESCL Mo i
[P T Mondarea B ‘moniored by Strno it

Otherwise use “Custom Maps* to position Cls
using drag and drop.

Business Rule; Worst Status Rule
Last status changed: smmzm 31:57 P

eor
Worst Status Rule
| Lostsuuschangea. snazors 157
| Value:

Business Rule;

VWorst Status Rule
== Lostoutus cnangea: srisz0rs 157

Not supported.

Supported (see OMi hardening information).
Not supported (tool has to be created in OMi).
Not supported.

Not supported.

Event Dashboard, but the dashboard choices are
be pre-created by the administrator in the
Dashboard Designer, rather than the operator
creating their own.

Yes, URL for access to Event Browser only.
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Pending browser supporting service hours.

Operational Service View showing unowned service
status.

GUI failover to backup OM server.

Disable user logins.

opcuistartupmsg

Integration: Java GUI can be launched context
sensitive from other applications opening a specific

service view including related message browser filter.

Not supported.

In OMi you can use multiple KPIs to propagate
more than one state. Unassigned Events KPl is
equivalent to Unowned status.

Load balancer in front of Gateway servers of a
single OMi instance.

Limited: Infrastructure Setting
(Foundation=Security) can prevent login if BSM_
ODB or DASHBOARD service is down.

Not supported.

OMi standalone event browser can be launched
with context.

Recommended Operator Workflow and My Workspace

Page Setup

We recommend that you provide operators or operator groups a customized My Workspace pages that fits
their needs. It should contain a dashboard component that shows the event status in each area the operator
or group is responsible for. For example, if the group is responsible for three major areas, like Databases,
Linux Servers, and WebLogic in EMEA, then they should see the high-level status of each area represented
through dashboard widgets, which will also allow them to quickly filter the event browser. Using such
dashboard widgets, they will be able to quickly switch between areas and corresponding views. If required,
the dashboard could also contain a widget that shows all unassigned events, so that operators are informed

about new issues that are not yet assigned to anyone.

For a short overview of how to create an event dashboard and My Workspace page, see the HP OMi: How
to create an Event Dashboard tutorial at https://hpln.hpe.com/page/omi-tutorials.

The following figure shows a Dashboard example for operators:

Lean dashboard for DBs+Linux+Weblogic EMEA - Edit Dashboard Configuration

Dashboard Layout Advanced Options

* Display Name: |Laan dashboard for DBs+Linux+Weblogic EMEA

] BE B&

@ Assigned TaMe ]
@ Unassigned events ]
@ ssignedto Workgroups ]

@ Unresolved for= 3 hours

@ LinuxSystem in EMEA

0 @ Weblogicin EMEA 0

0 @ DBsinEMEA 0

By using the Show events assigned to Me button in the event browser, operators can see all events

assigned to the user or the user’s group independent of the view. Events not related to a view are also shown
if an operator is allowed to see them based on the event category.

The following figure shows the Show events assigned to Me option in the Event Browser:
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@ EVENT BROWSER - | H € X
0Lo& % B A | o & LINoFit. v T aofit. v . @ 8] F

Sev Prio C N | A U D Sta.. Show everts assigned to Me or by Workoroups

The My Workspace page should also contain other components that are typically needed by the operators to
solve problems, like components that show the business impact, KPI Over Time dashboard, health
indicators, performance metrics or available actions.

The following figure shows an example of a customized My Workspace page with various components:

(/) Operations Manager i Workspaces v Administration ~  Q 2adminy @~

Viorkspaces - My Workspace

Operator Page DBs, Linux, Weblogic EMEA Seiect Pace v e B BEBD € B ¢
@ #ssioneaome i @ Unresoneator> 3nours 20 @ weblogcinENEA 3
e s et 201
@ sssioneato workgrouss 0 ® unvsseminenes o @ ossieues 0
View Explrer v 0| @« x Crentarowser - & « X Adons - # o« x
rowsevews | s R SIS = © | % Unesovediormoemansho. (v - © B f G B J?7 © 2
Sev Pio C N I A U D St TmeReceves  Tie + Reteact Euent  Ifastuctre 263 The Wemor izaon velis much igher .
o oe y [, 11214051857 P Inasiucurs-272 Swap Space usage i Mmuch hgher than ol Curtent Avrage: 127350000 UB Hist mambos . o mamoos
[v o @ oo " o 2100His mambos B vooe  mamocs
a v a [, 1029140543:12AM is higner mambongs Search:
e B el TS0 Tinas exessed ososeAs0ss | Filer @ Al ()Gl ) SourceCl () Node
a v 2 Tr 1Pu byt ratefor Networ & © & G € &
a v a [, 102914014311PM  Infrastructure-104: CPU ullzation level forthe CPU 1 is higher than normal Current Average: 2 5400 Histc mamoongs. T Active Jobs for Microsoft.. (CI)  {T Al Jobs for Microso SQL... ()
R » o o gnerannormal mambonss 7 Data Captur Toolfor oM. (€ {7 Dsta Capure Tl o 4P ()
" o o vsmsoiaonn T Disable MicrosoR'SOL Se._(CY) T Disable Microsof SQL Se.. (G}
a v [ CL 101814 03:00:19 AM
a o [, THn40tosSsPM  Discovey command “opi = o LIT—scts oML |
5 - orE. ©
a v a 12 0 “CiProgr » B B8 8 .
a v ) [l 102314041013PH  Discovery command “CWindowslsystem32icmd exe /C ~apache, o €
a v oo sE.. O
a v 0, 11214125757 P e (0
a v 0 e s hser.
a v o tnsotanszem )
— fonit... (CI)
foms: 27501291 (1) ©3 vs o D 20 g
e TopVew X | KOverTime X Heakhand vt Typentrs X Bsiessopacs X Cranges Andnciens X

selected View: [Systems_Infrastiucture <]

Implement Integrations for Operators

To support Operations operators, several integrations might be necessary. This chapter provides details
about the integrations that support the operator workflow.

Operations Orchestration Integration

Operations Orchestration run books can be defined for certain Cl Types and can be launched in the context of
a Cl orevent. See [365] Event to remediation (OMi - OO) 1.1 and [673] CI to remediation (BSM-00) 1.0 for
details.

Documentation for this integration can be found in the OMi Integrations Guide.
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Knowledge Base Integrations

Knowledge Base systems that provide useful information for operators can be integrated using OMi external
instruction text interface. It is able to call a script or executable, query databases, web pages or other external
sources to retrieve instruction text for a certain event. For details, see the Administration Guide >
Operations Console > External Instructions.

It is also possible to integrate web pages directly into My Workspace pages using a dynamic URL. For
details, see the User Guide > My Workspace > How to Set Up My Workspace > How to Create an
External Component.

Cross-Launches into Other Applications
Context-specific cross-launches into other web-based applications are possible through context menus with
dynamic URLs or tools.

For more information on context menus with dynamic URLs, see the Administration Guide > Service
Health > Repositories Overview > How to Create a Dynamic URL — Use-Case Scenario.

Forwarding to Incident Management Systems

Documentation about the generic forwarding interface can be found in the Extensibility Guide > Integrating
External Event Processes. Forwarding rules can be setup by going to Administration > Event
Processing > Automation > Event Forwarding.

Documentation for the specific HPE Service Manager integration can be found in the OMi Integration Guide.

Forwarding to User Notification Systems
Events can be forwarded to external notification systems using the generic forwarding interface. For
information, see the Extensibility Guide > Integrating External Event Processes.

Users can also be notified using the OMi own notification interface, which can send e-mail, sms, or pager
notifications. Go to Administration > Event Processing > Automation > Notifications and see the
corresponding OMi Help topics for details.

Re-Create Custom Tools

Tools

In OM, administrators can define tools that open a specific URL, or run certain executables or scripts on
nodes with Operations Agents. The same is possible in OMi.

Operators in OM can start tools in the context of one or more nodes or node groups, and can then run those
tools on multiple systems. OMi can currently run tools on single Cls only, but allows launching tools on nodes
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as well as on various types of Cls. This also enables context-specific tools, where only the tools that apply to
a specific Cl are shown to operators.

In OM, some tools are provided out-of-the-box and some are supplied with OM SPls.
Tools are supplied with OMi content packs and management packs. If a content pack exists in OMi, it usually
provides comparable tools to the corresponding OM SPI.

If a content pack does not yet exist, or if a custom tool was developed on OM, then a corresponding tool can
be re-created manually in OMi in Administration > Operations Console > Tools.

Note: There is currently no method to automatically exchange tools between OM and OMi.

There are some differences in the variables that can be used when defining tools — the most important
difference is that OMi does not support SOPC_NODES, which allows launching tools on several nodes or
with several nodes as the input parameter. For a complete list of variable differences, see the following
sections.

Tools in OMi

Using a Configuration Item-centric approach, tools in OMi are linked to Configuration Items. Tools are
assigned a category and operators are given execute permissions by administrators to tool categories that
are appropriate to their roles.

A Tool contains a command, script or URL, and can contain the following parameters:

« Cl attributes

« Event attributes

« Infrastructure settings

« Runtime parameters

« Monitoring host name

« Management server name

« Hosted on host name (where the Cl is hosted)

Tools are created to help users perform common tasks on Cls and are associated with a Cl type, which can
be run from the centralized console. For example, you can run a tool to check the status of an Oracle
database instance. The tool is assigned to the Configuration Item type Oracle.

For more details, go to Administration > Operations Console > Tools and see the corresponding OMi
Help information.

OM and OMi Feature Comparison

OM Tool
Features OMi Equivalent

Command types
Executable Yes

VBscript (OM | Yes
for Windows)
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Jscript (OM
for Windows)

Windows
scripting host
(OM for
Windows)

Perl (OM for
Windows)

URL

Allow
operator to
change
parameters
flag.

Allow
operator to
change logon
flag.

Yes

Yes

Yes

Yes

Use ${option} to prompt operator for missing parameters. Cannot change parameters but

can add missing parameters.

Not available, but tool can prompt operator for logon credentials (operator is prompted

every time the tool is started).

Possible parameter variables

Message
properties

Node
properties

Service
properties

Environment
variables
Usedto
retrieve
environment
variables
from the
console that
launched the
action

Server
configuration
variables

HPE Operations Manageri (10.10)

Event properties.

CI properties/Monitoring Host/Hosted on host.

ClI properties.

Not available (typical tools do not need access to environment variables on console

systems).

Infrastructure Settings.
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Node group
properties /
$0PC_
NODEGROUP_
ID

$OPC_
NODEGROUP

$0PC_MSG_
1DS

$0OPC_MSG_
NODES $OPC_
NODEID

$OPC_MGMTSV

$0OPC_USER
(OMU)

Not available (OMi is Cl/view centric).

Not available/launch from single event only, event ID of selected event is accessible.

Not available/launch from single node only, monitoring host of selected event/Cl is
available.

Available in the Ul. Execution is done on the Gateway Server.

Executing OMi user variable.

Execute on possibilities

Management
server

Selected
node

Node list

Node list
(predefined)

Console

URL inlocal
web browser

HPE Operations Manageri (10.10)

Yes. Requires that an operations agent is installed on all gateway servers.

(currently uses node of infrastructure setting Default Virtual Gateway Server for
Application Users URL as target for agents connected to an OMi server).

Note: A managed_by relationship to an OM server takes precedence. To make sure
that tools are executed on the OMi server, remove any relationships to OM servers or
remove the OM server Cl.

Selected Cl / related ClI of selected event.

Not possible, tool can be launched on single Cl/node only.

Not possible, tool can be launched on single Cl/node only.

OMi does not allow executables or scripts to start on a console system. This is because
the OMi console is web-based and runs inside a browser that does not allow the launching
of executables—for security reasons. However, running an executable on the client

system is not the primary use case of OM tools and a user on the client system can run the

executable manually. Such a useful tool including parameters could also be mentioned in
the instructions for the event.

Yes.
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Broadcast Not available.

Execute a
command
specified by
the operator
on all nodes
(OM for
UNIX)

Presentation | Tool execution always displays a Window.
output
options:

OM for UNIX:
Window
(output only),
No Window,
Window
(input/output)
OM for
Windows:
Windows, No
Window

Tool can Not available.
launch X-

applications

(OM for

UNIX)

How to Re-Create Custom OM Tools in OMi

To create a tool in OMi, go to Administration > Operations Console > Tools.

Navigate through the CI Types tree, for example to InfrastructureElement > Node > Computer >
Windows.

Click Windows and the New Item = icon in the Windows — Tools pane. The Create New Tool window
appears.

Copy the tool command and other settings from the OM tool definition to the OMi tool definition.

To test the tool, open the Event Perspective or another My Workspace page that shows Cls, and select a
suitable CI (of the Cl Type for which you defined the tool), and select Launch Tool from the CI context
menu.

Note: If the Tool contains event attributes it can be triggered from an event only.
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Import Performance Dashboards

Performance Dashboards

OMi includes an embedded Performance Dashboard component that does not require an additional license.
The OMi Performance Dashboard enables you to create customized performance dashboards for the Cl
types you are monitoring. You can also compare multiple instances of a resource or an application of a
Configuration Item (ClI).

For details on how to launch a performance dashboard, see the User Guide > Operations Console >
Performance Perspective > Managing Performance Dashboard > Launching a Performance
Dashboard.

Predefined Performance Dashboards

OMi content packs and OMi Management Packs add many predefined performance dashboards that are
comparable to the graph templates provided by Performance Manager.

How to Design a Performance Dashboard

Designing a performance dashboard includes the tasks of creating a performance dashboard, configuring a
performance dashboard, visualizing events in the performance dashboard, and managing different multiple
instances across systems using instance parameterization.

For details, see the User Guide > Operations Console > Performance Perspective > Designing
Performance Dashboard.

Import Custom Performance Manager Graphs

Performance Manager Graphs

OM for UNIX and OM for Windows do not offer an integrated dashboard component like the OMi Performance
Dashboard but integrate with Performance Manager and are able to cross-launch into Performance Manager.

OM, PM, and OMi Performance Dashboard Feature Comparison

OM policies can include operator-initiated actions that refer to a specific performance dashboard. The
performance dashboard-related operator-initiated actions are filtered out by OMi and are not shown to
operators.

The following tables compare OM and OMi functionalities, as well as Performance Manager and OMi
Performance Dashboard functionalities.
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OM functionality

Performance Manager integration
Separately manage user permissions

Separately manage nodes and node
groups (integration with Reporter or OM
for Windows)

Performance Manager functionality
Design custom graphs

User-defined and global graph templates
Export and import graph templates

Export graphs: TSV, CSV, Excel, XML,
PDF

URL based launch capability in PM for
embedding in their own portal

RESTful web services for retrieving data
Command line utility to generate graphs

Reporter reports integration

Data sources: Operations Agent,
SiteScope, Reporter

RTM data source support

Proxied Log Files

Flat file data source

Add node temporarily on-the-fly
Active Directory authentication

Add to Favorites (loaded when PM home
page is launched)

Create graph templates containing
multiple metrics on multiple nodes

Diagnostic View: Load and Save State

Diagnostic View: Drill down to Process,
tables of each metric class

HPE Operations Manageri (10.10)

OMi functionality

OMIi Performance Dashboard embedded

Single configuration and authorization model

OMi Performance Dashboard functionality
Design custom performance dashboards
Out-of-the-box performance dashboards

Yes (by using content packs and management packs)

CSV only

Yes

Yes
No

Recommendation: use OBR.

OBR reports can be viewed in My Workspace, but no
contextual cross-launch.

Data sources: Operations Agent, vPV, SiteScope, BSM
Connector, APM

Real time graphing support added for Operations Agent and

SiteScope

No

Use BSM Connector to process metrics from file into OMi

No
Any authentication supported by OMi

Yes

ClI centric approach means each performance dashboard

corresponds to metrics from a single Cl
Yes (Favorites in OMi)

No

Page 62 of 196



OMi Evolution Guide
Chapter 4: Establishing Effective Operator Workflow

System Information page No

How to Import Custom Performance Manager Graphs into
OMi

If you have created custom graphs in HPE Performance Manager, you can import those into OMi as
performance dashboards and map them to Cl types using the following procedure:

1. Copy all graph templates you want to import from the HPE Performance Manager system:
o PM on Windows: copy from %0vShareDir%/server/conf/perf directory

o PM on Linux: copy from /var/opt/0V/shared/server/conf/perf) to
<OMi_HOME>/opr/newconfig/0OVPMon an OMi GW server.

Create the OVPM directory if it does not exist.
2. Follow these steps:
a. Logonto OMi.
b. On aseparate browser tab, open <OMiGWServer>/0VPM/Options. jsp.
c. Click Import Dashboard.

This uploads all graph templates from the above file location to the OMi database. This is a one-time
import. If you modify graph templates in HPE Performance Manager afterward, use the same procedure
again to upload the modified graph templates.

3. Associate these graph templates (performance dashboards in OMi) to the respective Cl Types. Go to
Administration > Operations Console > Performance Dashboard Mappings, and select the CI
Type to which you want to link the graph.

Note:

« If the graph template contains specific node names, the graph can be imported into OMi, but the
specific node names are ignored when the graph is launched. The graph will be launched in the
context of the selected ClI.

« If a graph template with a SiteScope data source is imported from PM into OMi, the graph will retrieve
metrics directly from a corresponding SiteScope server. This assumes that the monitor in SiteScope
is configured to report metrics to the HPE Operations agent.

« PM graph templates that refer to a Reporter data source will not work in OMi.

Prepare Operator Console

User Management in OMi: Users and User Groups

User roles, user groups, and user profiles help simplify authorization in OM.

Similar functionality is available in OMi using user roles and user groups. You can define roles and
permissions and create users and groups to provide access to the features for specialist operators, for

HPE Operations Manageri (10.10) Page 63 of 196



OMi Evolution Guide

Chapter 4: Establishing Effective Operator Workflow

example, email application experts. In order to reduce the effort and complexity involved in configuring roles
forindividual users in OMi, permissions are granted only through roles. You can specify roles either by
assigning them to a group (so that all members of the group have access to the same roles) or by assigning

them to a user directly.

Note: OMi does not distinguish between administrators and operators — there are just users.

There is also no strict separation between administrative permissions and non-administrative permissions.
You can grant any permission to any user. To simplify the granting of all permissions, an OMi user can be

flagged as Super-Admin.

The following figure shows user groups in OMi:

() Operations Manager i Workspaces »

Lradminv @~

Agministration - Users - Users, Groups and Roles

2% Manage Groups

o | wneweom | 2| @
[ 20 Administrators
A p——
2% 080perators ()

Datatase operators

2% DBSHES (
atabase exper
20 Management
AT meragers

2% Network Operators (i)
Network operators

20 NetworksMEs (i)

Network experts

20 SAPSMEs (i)

SAP experts

28 server Operators (1)

Server operators
2% Server SMEs (1)

server experts

20 SMES

Subject-matter experts

2 Group Members

Name

Georges Bizet
Jacques Offenbach
Maurice Ravel

2% Group Hierarchy

an

SMES

n

DBSMES

& Role Assignments
Assigned roles:

Inneritea roles:

Permission Summary

Workspaces
User Components o
Userbages o

gbizet

Joftenba

mravel mravei@aieivierteltakt.com

DBExpertRole DB Dperator Role

The following figures show user profiles in OM for UNIX and user roles in OM for Windows:

Operations o,
O/ Manager

Administration Ul

Edit~ Browse~ ServerConfiguration -

x o\ §3

Admin  Help

RiE

Analyse ~ Deployment~ Tasks~ Integrations~  Servers -

All User Profiles = - o -

Filter +
Found 2 Elements
4 B C D E E

[ Label

g

D Linux Operators

D OMU Administration Ul

t Choose an action

Found 2 Elements

o~

HPE Operations Manager i (10.10)

Help

N O B O g I U0 ¥ W X ¥ Z Other
Description Responsibilities  Tools Profiles

v v -

£ ~ OMU Administration Ul user profile v v =
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# User Roles = =] ES

Mame | Description ‘ Mew, . |
Duplicate ...

Message Admini... Grants rights for all message-relsted tasks. You must.

Message Opera... Grants own and launch command permissions For me... |

Policy Administr... Grants rights For all policy-related tasks, You must as
Policy Operator ... Grants read-permission for policies, You must assign ... Delate |
Windows-admin  Administrator for Windows nodes

Windows-operator  Operator for Windows nodes Properties... |

Close Help |

User Roles

OMi enables you to fine-tune permissions management by applying permissions within roles. Permissions
enable you to restrict the scope of a role.

Administration | Users / Users, Groups, and Roles

. Properties
Edit Role: DB Operator Role
* Name: DB Operator Role
Descrition Operative permissions for databases

Properties

General setiings for this role

Permissions
Permissions assigned fo fhis role

i Permissions
Advanced RTSM Permissions

» Event Processing

Assignment o Groups
The groups to which this role is sssigned » Monitoring
- v Operations Consale
Assignment fo Users

The users o whem this role is assigned

Action Web Service.

Custom Actions (Adminisiration)

Custem Actiens (Execution)

Design Graphs

Event Browser

X X X X X X

Event Browser Qptions

vvvivv vy

&

I Events

Life Cycle Operations Launch Actions  Change Properties
® ® ®
Al View

All

Events assigned fo user

<]

Events not assigned o user
£ Database

& Infrastructure
& Network

EEEENE

External Instructions None

Non:

x
Monitoring Dashboards x
x

Monitoring Dashboards (Administr None

For more details, see the Administration Guide > Users > Users, Groups, and Roles.

Responsibilities for Nodes and Cls

OMi focuses on Cl and CI type-centric or view-based monitoring, instead of node and node group-centric
monitoring. Therefore, node groups are not used for authorization in OMi. Corresponding user responsibilities
can be defined in OMi using views, which is a more flexible concept.

A view typically contains a subset of the Cls that exist in the RTSM and can contain all types of Cls,
including node groups, which in OMi are represented by CI collections. Therefore, it is theoretically possible
to continue with node-group based management by creating views that contain only certain node groups or CI
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collections. However, with OMi it is recommended to use all possibilities that views provide, and to define the
areas that operators are responsible for by using views that contain all the Cls of interest.

The following figures show views and view permissions in OMi:

Administration - Users - Users, Groups and Roles

RTSM Permissions
Model Explorer BT s
J Erowese views | Search | DB Operator Role Resources|| Resourcs Groups|| General Actons|| Pemissions Overview] |
In the Resources tab, you can select pemissions for specific actions for specic resources.
S &
|On|ine Banking | P | Resource Types Avalable Views Selected Views With Permissions
7 ; [ Queres B S By v By v
=+ ] Cnline Banking Il views _
T - L Resource Name [%[2|G X |@|F <] &
-8 Online Banking Service Sﬁ ‘Cupijm":"m B B Root
H d i - e = omiDemo
={8] Oriline Barking e iu;[omm sankng O/o0jo/o|o|o
H@ Infrastructure  UCMDE Browser Widgets Elér ‘;’::::s::"a
[0 Application DataCenter EMSSQU‘- g g g g g g
MSSQL_D.
@ “Whitweare Infrastructure = L MssGL_D. Oooooono
: MSSQL_N oooooo
[ Non_revenuegeneratlng_TXs Eom_oem ojooogino
[ _p OBA (BEMI-0BA)
EI Tranzsfer_funds
7 5 Infrastructure
[#-[B] Checking_To_Savings % J2EE Appication Servers
i SAP
(B Checking_To_visa £ Webserver 15
i 4 i , =
[#-{%&] Savings_To_Checkin ——— e = =
- @) sewings _To L 2 w1005 | 8| [ 16 ©
#-{&] Savings_To_visa
T’EI@ Wiza_To_Checking
i Appl Cancel
E@ Wiza_To_Savings ) “

In OMi, user responsibilities can be restricted by granting view rights to certain views only.

Responsibilities for Events
In addition to the node group-based restrictions, OM uses message groups to restrict access to events. In
OMi, message groups are called event categories and can also be used to restrict access.

OMi additionally allows different permissions to be defined, based on whether an event is assigned to a user
or not. Typically, operators are granted permissions to work on and close all assigned events, but with limited
permissions on events not assigned to them.

In OMi events can be automatically assigned to user groups by auto-assignment rules and can also be
assigned automatically to individual operators by time-based event automation rules or EPI Groovy scripts.

However, the OM message group (OMi event category)-based authorization is still available and should be
used for unassigned events.

The following figure shows event categories in OMi:

I Events VAL )
Life Cycle Operations Launch Actions Change Properties
® ® ®
All View
Al

Events assigned to user
Events not assigned to user
& Database
& Infrastructure
& Network
& SAP
& Server

‘ {¥ Manage event categories
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OM for UNIX and OM for Windows can restrict which messages an operator will be able to see by restricting
which nodes groups and message groups an operator has access to.

The following figures show event responsibilities in OM:

Edit Responsibilities for User "Linux Operators"

Hessase Gr::?;[zsnr]"”ps P21 CiMCS.LModes CHMCS.SNodes CRRHA.SNodes CLVCS.LNodes CLVCS..S Nodes
Backup

R
Hardware

Job

0s
Performance D D D
Security

Genalall Sewicssl Nudesl Tools  Messages |Pu\ic\es| Users |

Specify the message groups and permissions available ta this role
Select message group and press Add button: &I
j
Al All

Message Groups assigned this Role:

Message Group ‘ Wiew | Own | Dis ‘ Ack. | B Remove |

Biztalk Server ® H * ®

Diefault % w° ® % Permissions... |

EXSPIAw/MI bl = ® bl

M55 _adrmin »® = ® »®

MS5_Fault b = b b

WINDOSSPICIT... % = x »®

WINOSSPICO.. % = = ®

WINDSSPI-DE.. ® # # " —

WINOSSPIHP.. X = ® *®

WINOSSPIHP.. % = 4 ®

WINDSSPHNS... % ® ® x

WINDSSPHNT.. % = = ®

WINOSSPIMC.. % = ® ®

WINOSSPIMS.. % = 4 ® -

LOMOCCDlMC v v W
| Fe

(u] 4 | Cancel | Apply | Help

Event Permissions

In OM for Windows, granular permissions can be set regarding message modifications per message group.
For OM for UNIX, some global permissions per operator can be set.

In OMi, you can set the same detailed permissions as in OM for Windows and additional permissions, for
example regarding the assignment or transfer control features of OMi.

The following figure shows fine-grained event permissions in OMi:

Life Cycle Qperarions Launch ﬁﬂinns Change Prroperries

Work On /Resolve Close Reopen Assign To Transfer Control Close Transferred Operator Action  Automatic Action Event Relations Severity Priority Title Description Solution Custom Attributes Annotations
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The following figure shows message permissions in OM for Windows:

Permitted Operations for Msg Group M55_Fault

Select the permissions ko be granted For messages in this message
group,

v Wiew

—5Stake Change Permissions
¥ | cvar

¥ Disown

v Acknowledge

¥ Unacknowledge

¥ Change Severity

V¥ Change Text

[ Assign

—Command Permissions

¥ Launch Operator Initiated Command

¥ Relaunch Automatic Command

QK I Cancel | Help |

The following figure shows operator message permissions in OM for UNIX:

Operate

Capabilities
] Perform ! Step Actions

] Modify Message Affributes
H| Own

] (Un-)acknowledge Messages

Restrict Access to Tools

OM can restrict access to tools based on tool groups, and OM for UNIX can restrict access on an individual

tool level.

In OMi, tools are defined for a certain Cl type, and access to tools can be restricted using tool categories.

The following figure shows the configuration of Execute Permissions for tool categories in OMi:

Tools (Administration) X Mone )
Tools (Execution) X None ) Execute
View Mappings M Mone ) Al

Default

The following figures show the tool permissions in OM for Windows and OM for UNIX:
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User Role Properties E3

.Generclll Senricesl Modes Tools | Messagesl Paolicies I Users I

Instructions: Select the Tool Groups that can be accessed from this Role.

Tool Groups:

=) [m][E Tools

+-[v]ER DB-SPI

[EF HotFix Deployment - HPOvEaAgt
[C1EF HP MMM Web Toals

DE? HP Operations Agent

DE? HP Operations Manager Tools
[1E}7 Reporting

- EE? SPI for JBoss Application Server
+-[][Ef JBoss Server Admin

e

[#] 57 SPI for Web Servers

[#]E}7 SPI for Weblogic Server

[#]E}7 Systems Infrastructure

[#]E} Uparade Policies

[“]EF virtualization Infrastructure

QK I Cancel Apply Help

Selector [E5]
Filter | Tool Bank | All Tools

= Tool Bank
L] Certificate Tools s
[__| Correlation Composer
|| HPOM License Tools
[_J Launch SiteScope Dashboard
] midas_apps
|| Met Diag
) NN
] WMMilntAdmin
L] SISPI
[_] SiteScope Adapter
| SiteScope SAM ADMIN
L] S5P Tools
[ UN*X Toals
=[] Virtualization Infrastructure
Whiware Host Info
Whiwware List Suspended WYMs
Whiware List VMs
Wiiware Resource Pool Info
] Windows Tools
] Workspaces
Broadcast v
Configure SiS20M Adapter

Choose one or more items. When finished, click 'OK.

Administrative Permissions

Access to administrative tasks such as creating new tools, setting up new nodes, or deploying policies can
be given in OMi by granting Full Control permission to the corresponding Administration Ul.

Permissions for viewing, editing and assigning policy templates, aspects or management templates can be
granted per policy template group respectively per configuration folder.
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The following figure shows an example of administrative permissions in OMi:
iPermissw’ons

 Event Processing

I Automation & Bartial ) Automatic Run Book Execution X hone )
Correlation X Hone ) Downtime Behavior 3 None )
Event Automation Configuration ¥ Mone )

Event Forwarding X None %

Event Processing Customization X None )

Event Submission VAL Y

Indicator Mappings X None )

Natification Templates ¥ None )

Motifications VAL Y

Time-Based Event Automation ¥ None )

User Group Assignments X None )

* Monitoring

Assignments VALY Manzgement Templates & Aspects AL Y
Automatic Assignment Rules 3 Mone ) Policy Templates VAL Y
Deployment Jobs VAL )

MTs. Aspects & Policy Templates € Mone )

Special Operations 3 Mone )

“ Operations Console

Action Web Service 3 MNone

Custom Actions (Administration) Al ) Full Contral

Cusfom Actions (Execution) 3 None )

Design Graphs X Mone

Event Browser X MNone

Event Browser Options ¢ Mone )

Events VAL Y

Fine-grained Administrative Permissions per Policy Category or Pattern

The policy management area of OM for Windows allows separation of administrative tasks. In this area, the
read, edit, deploy, and delete permissions can be defined for each policy category.

Policy Permissions for Category Microsoft Windows E

Select the permissions ko be granted For policies with this
categaory 1D,

Palicy Permissions
¥ Read

v Deploy

IV Edit

v Delete

OF I Cancel | Help |

In OM for UNIX, different administrative permissions can be selectively granted for certain object groups
using pattemns. It is also possible to grant read-only access.
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Operations AO E

1 Manager

Administration Ul

Home OMU Server

Edit~ Browse~ Analyse~ Servers~-

Edit User Role "readonly" Help

| [Objecicla Read |
Global Access

MNedes, Modegroups, Layout Groups, Node Hierarchies, Certificates, Categones

@ MHame [contsins w| [ |
Palicies, Policy Groups, 5PIs, Policy Types, Categories

5] Mame ‘ matchas W | | | O

Tools, Tool Groups

@ Mame [contsins w| [ | O
Users, Profiles, Groups, Roles

@ Mame [contsins w| [ |
Files, Directories ]

Agent Installation
Deployment

Server Configuration: Server Config, DB Config, Instruction Text, Reports, Regroup
Conditions, Metifications, Trouble Ticket
Flexible Management files

Tasks
Locks

oog DDDDDDDDDDDDDi

In OMi 10.01 and earlier versions, you can grant access to an Administration Ul, and this grants access to all
objects that can be edited in that Ul (for example, to all policy templates or all tools).

In OMi 10.10 and later, permissions for viewing, editing and assigning policy templates, aspects or
management templates can be granted per policy template group respectively per configuration folder.

v Monitoring X Partial
I Assignments % Bartial ) I Management Templates & Aspects % Partial ) View Tune Full Control
Automatic Assignment Rules 3 None ) Policy Templates ¥ MNone ) All
Deployment Jobs 3 None ) Application Server Management
MTs, Aspects & Policy Templates % Partial Database Management
Infrastructure Management
Special Operations 3 None )

OMi Server Self-Monitering

User Authentication

Users and user groups can be managed inside or outside OMi using an LDAP server. Authentication can be
performed internally, or by using an LDAP server. The default single sign-on authentication strategy for OMi is
LW-SSO. LW-SSO is embedded in OMi and does not require an external machine for authentication. OMi
also supports Smart Card Authentication and Identity Management Single Sign-On (IDM-SSO).

As Windows Active Directory implements an LDAP server, users and user groups that have been set up for
OM for Windows can be set up in OMi as well.

The Pluggable Authentication Module (PAM) that is offered with OM for UNIX is not available with OMi.

LDAP Authentication

LDAP can be configured with OMi as an authentication mechanism for users logging into OMi and to map
groups and synchronize OMi users with users configured on the external LDAP server. For OMi
administrators, this simplifies the process of managing users. You can use internal users, LDAP
authentication or both.
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You enable and disable LDAP using the LDAP Authentication Management Wizard:

@ Operations Manager i

Workspaces

Administration ~ Q

Administration - Users - Authentication Management
Single Sign-0n Configuration

Name

Single Sign-On Mode

Taken Creation Key (initstring)
HP Operations Manager i Domain

Value
Lightweight
57510Xbggs3y
Parse automatically

Trusted Hosts/Demains 1}
Enable SAML2 authentication schema true
SAMLZ Creation Look for keystore in classpatn false
SAMLZ Creation Keystore filename C:A\HPBSM/confl/settings//SingleSignOn//SAMLKeyStore
SAMLZ Creation Private key alias hpsamlkey
false

SAML2 Validation Look for keystore in classpath
SAMLZ Validation Keystore filaname

Configure

Smart Card Authentication Configuration

Name
Smart Card Authentication Configuration Mode

C:\\HPBSM//conf//settings//SingleSignOn//SAMLKeyStore

Value
Disabled

Confiqure

Lightweight Directory Access Protocol Configuration

Value
Disabled

Name
Remaote users repository mode

Add new configuration

Authentication Management Wizard o]
Introduction LDAP General Configuration
» LDAP General
Choose and configure LDAP Mode:
LDAP Group
Mapping LDAP General Configuration
Summary Unique domain [emea |

LDAP vendor type [ Microsoft Active Directory B 3

LDAP server URL [ Idap /116 58 78 114 388/CN=Users, DC=omi,DC=hp,DCo

Distinguished Name (DN) Resciution

Distnguished Name of Search-Entited User | CN=/dministrator, CN=Users,DC=omi,DC=hp,DC=com |

Passuord of Search-Entitled Liser [

Test DN Resolution
uuiD [Tim |

Password [ ]
[Tt
Bound in successfully as
o
(&2 ("< maci [l “wext> s Carcel” IR Hep |

APl and Command-Line Interfaces for User Management

OMi currently does not offer any APls or command-line interfaces to add, modify, export, orimport users,
user groups, LDAP or SSO settings, however, user roles, including permissions can be exported and
imported using content packs.

OM and OMi User Management Feature Comparison

OM functionality Equivalent in OMi

User groups and user profiles (OM for UNIX). User groups and user roles.

User roles (OM for Windows).
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Restrict responsibilities using message groups Same concept, using views and event categories

and node groups. (message groups).

Fine-grained event permissions (OM for Yes.

Windows).

Restrict access to tools based on tool groups. Same concept: restrict access to tools based on tool
categories.

Grant permissions on both operator features and | Yes.
administrative features.

Restrict access to policies using policy Yes.
categories.

Fine-grained administrative permissions (OM for | Yes.

Windows)

Fine-grained administrative permissions per Yes, per policy template category / configuration
object category or pattern (OM for UNIX). folder.

Read-only administrative permissions (OM for Yes (view permission).

UNIX).

User Authentication via Windows Active Yes, through LDAP authentication.

Directory (OM for Windows).

User Authentication internally (OM for UNIX) Yes.

Pluggable Authentication Module (PAM) No, LDAP authentication or integrated authentication
authentication (OM for UNIX). only.

API to configure users and permissions. Yes, User Management Web Services and opr-user
opccfguser (OM for UNIX) CLI.

CLI to export and import user roles and Content Manager CLI and Content Packs Ul to export
permissions. and import user roles and permissions.

opccfgdwn/upl (OM for UNIX)
ovpmutil (OM for Windows)

Create Users, User Roles, and User Groups

There is currently no tool to automatically import OM users and permissions to OMi.

Create users and define permissions manually in Administration > Users > Users, Groups, and Roles. If
you have more than a few operators and want to separate their responsibilities and permissions, then you
should create multiple user roles and groups.

Before you start, you should map out the required roles and their relevant permissions, as well as the users
and groups you intend to assign the roles to.

Start by creating the necessary user roles and permissions, then create the necessary groups and assign
roles to them.
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Note: Users can be members of multiple groups, and groups can be nested and inherit permissions from
parent groups.

As the last step create the necessary users. If you use LDAP, users can be created automatically at their first
login, and OMi user group memberships can be created based on LDAP group memberships. For more
details, see the Administration Guide > Users > Authentication Management > LDAP Authentication
and Mapping.

Create Views for Different Operator Responsibilities

In OMi you can define responsibility boundaries by granting access, or not granting access, to views. Views
are also used by operators to filter the RTSM content and events. Therefore, it is necessary to choose or
create RTSM views.

For example, for a database operators group that should only have access to event and health information for
all databases in EMEA, you should create a custom view that shows only the database systems in EMEA.

For other operator groups choose out-of-the-box views or create other suitable views. You can define more
than one view per operator group.

It is recommended to use pattern views as much as possible, as these will be updated automatically when
new Cls appear in the RTSM. Instance-based views that are maintained manually are often not ideal in
dynamic environments.

Note: Ensure the view contains ALL Cls for which you might expect to see events. For example, if an
event is mapped to an Interface Cl and the view contains the computer CI but not the underlying
interface ClI, then that event will not be visible with that view filter.

Create User Group Assignment Rules

Once you have defined the different operator groups and the views they will have access to, it is
recommended to define User Group Assignment rules that automatically assign incoming events to one of
the operator groups. A manual alternative is to define a special dispatcher role in your organization and to let
the dispatcher assign events to operator groups manually.

As aresult of an assignment, every operator of the group will get advanced permissions on the event, and will
be able to modify and close events.

To define auto-assignment rules, go to Administration > Event Processing > Automation > User Group
Assignments.

Note: You can reuse the views created in the previous step in the assignment rules. Events that are
related to a Cl in such a view are then automatically assigned to the specified user group.

The following figure shows Event Automation - User Group Assignments using different view and event
filters:
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| Event Automation = User Group Assignments
Setup Event Automation Event Correlation Operations Console Menitoring B]

@ User groups are assigned to incoming events according to the order of the event assignment rules below. The user group of the first rule
with a matching fiter iz assigned to an inceming event. Any following rules are ignored.

S *x2 X =% N U 5 2
Order a | Filter View User Group Description Artifact Origin

1 Category = OpenView Internal OpC Admins @ Custom

2 open + derived from J2EE Server J2EE_Deployment JEE operators o Custom

3 open + derived from Business Transa... JEE operators @ Custom

4 open + derived from Database ORA_Deployment DE operators assign all events with related Clty... | @ Custom

Create Event Dashboards and My Workspace Pages

As described in the planning chapter, you typically want to provide an operator group with a customized My
Workspace page. My Workspace pages can provide OMi operators with overview dashboards and contextual
information, from business impact information to detailed performance graphs. You can customize pages to
provide exactly the information that is needed to resolve issues quickly, as different operator groups might
require different information to perform their jobs. Operators focusing on business applications might have
other interests compared to operators focusing on OS-level problems, and might therefore also require
different event dashboard layouts.

As afirst step, create all the required event dashboard layouts.

Create Event Dashboards

Go to Administration > Operations Console > Monitoring Dashboards.

Create an event dashboard layout for each combination of operator groups you require. You can use the
Example: Lean Status as a starting point.

For example, if you have individual operators that are part of three operator groups “DBs EMEA operators”,
“Linux EMEA operators” and “WebLogic EMEA operators”, it is recommended to create an event dashboard
layout similar to the following, with one dashboard widget per view. This assumes that you have one view for
each group. If one operator group has access to multiple views with different Cls, add multiple corresponding
widgets.

The following figure shows a dashboard example for operators:

Lean for DBs+Li Neblogic EMEA - Details

WView Mode: H

v Layout
Unassigned events 1]
) Assigned To Me 0 d 3 Unresolved for > 3 hours 0 ) Weblogic systems in EMEA 0
Assigned to Workgroups 0 Linux systems in EMEA 0 ) DBsin EMEA 0

When integrated into a My Workspace page called, for example, “DB, Linux, WebLogic EMEA perspective”,
this dashboard will allow operators to quickly see the event status in each area and to quickly filter the event
browser by clicking a widget. The event dashboard will provide an overview of the event status for all events
a user is responsible for, so that they are not forced to switch between views or My Workspace pages.
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Create My Workspace Pages

Before creating My Workspace pages, it is recommended to sketch out the page and the components it
should consist of. A typical operator page could for example consist of the corresponding lean event
dashboard component, a watch list component to keep track of the status of the most important Cls, the
event browser in the middle, additional components that provide useful information to operators, like event
details, health indicator, business impact, and the action panel to provide fast access to remediation tools.
Explore the available My Workspace components and discuss with the operator groups what they need on
their My Workspace page for an effective operator workflow.

The following figures show two examples of customized My Workspace pages with various components:

D OperstionsMerageri  Wutane s 0 Sutrne @

P = S CIEMIRA Dames

1) Dperatioms Manager | Wokprme kil e G Laich= @+

s ek

Grant Permissions

As a last step, grant the corresponding permissions on the views, pages, and components you created, and
grant general event and administrative permissions. Permissions are assigned through user roles. Go to
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Administration > Users > Users, Groups, and Roles and edit the corresponding role.

What (Cls) Views an Operator Should Have Access to

Grant view permissions for the corresponding views in the RTSM permissions section of a user role.

Administration - Users - Users, Groups and Roles

RTSM Permissions
DB Operator Role Resources|| Resource Groups|| General Actons|| Pemissions Overview] |
In the Resources tab, you can select permissions for speciic actions for specific resources.
Asiable Views ‘Selected Views With Permissions
G| W - -
-3 Network E Resource Name BERREIRIEIER
-5 omipemo. 5 B Root
u s
= I ks £ omiDemo
¥ d
et . L L1 oniine Banking o|o|o|o|g|o
3 enu ltems e Access
 ucmoe B idget: E Operafions Wana.
rowser Widgets
o - [ Databases
L] MssaL_cl Ooojioomo;mo
] MssaL_D. Ogoooo
L1 MSsQL_D. Ooo|jo|oio|o
L] MSsaL_N. Ooooo;mo
L] ORA Depl A00000aig
3
Slllga [ 18 ©
Apply “ Cancel

What My Workspace Pages Should Operators Have Access to

Event operators must have access to at least one My Workspace page that includes the event browser
component.

The following figure shows how to grant permissions to My Workspace pages:

w Workspaces

Predefined Pages VAL Y

User Components VAL Y

User Pages VAL Y View
Locked
Change
Delete

Full Contraol

What Events Should be Visible to the Operator, and what Permissions
Should an Operator Have

Note: To ensure that operators can see only events for Cls and Views they have access to, make sure
that operators do not have the right to clear the view filter.

The following figure shows how to clear view filter permission:
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Event Browser 3 Mone ), Clear View Filter
Share Filters

Event Browser Options ¢ None )

Events % Partial )

Otherwise, operators would be allowed to clear the view filter in the event browser by selecting <No Filter>

from the view drop-down list. This would result in all events being shown independently of the view and would
typically show all events.

© Event Browser for OM Cl Collections

0o, & = B .4 @ &r | L[] OMClCollections |s | ..
Sev Prico C N | A U D St. T
LI ORA_Deployment i
I dh v Ll 17 LI Active Directorytopolog  [rentt
A W 0. 11 L Systems_Infrastructure Lot
o v Sl = RO
& v 0. 41 L] Active Directory topalog hent ¢
0 g [T AD_Logical_View t
1 nent
4 v > L1 AD_Metwork_Deployme

Specify which permissions an operator should have for assigned events and unassigned events per event
category.

Typically, operators are set up with permissions to work on and close all assigned events (grant all
operations), but with limited permissions on events not assigned to them.

For example, you could grant database operators full permissions for the DBSPI category, View permissions
for the Infrastructure category, and no permissions in other categories.

Events VAL )

Life Cycle Operafions Launch Actions Change Properties
® ® ®
Al View
a
Events assigned fo user
Events not assigned to user
&) Datebase
& Infrastructure
& Network
& SAP
a Server

| 'K:i Manage event categories

There are three permissions that are new to OM customers:

« Event Relations. Allows an operator to create cause-symptom relationships manually, or to break those
relationships. Typically granted to all operators.

« Transfer Control. Allows an operator to forward an event to an incident management system (via event
context menu).

HPE Operations Manageri (10.10) Page 78 of 196



OMi Evolution Guide
Chapter 4: Establishing Effective Operator Workflow

« Close Transferred. Allows an operator to close forwarded events. It should not be granted if the event
should be under control of the incident management system after forwarding.

Which Tool Categories Should be Made Available to Operators

Specify which tools an operator should have access to. For example, database operators should get access
to the database-related categories and default tools.

The following figure shows authorization for different tool categories:

Tools (Execution) % Fartial Execute

Tools (Administration) None » Al
None ) Apache Admin Tools
Database Operational Tools
None 3
Default
Hadoop Admin Tools
J2EE Admin Tools
J2EE Information Tools
J2EE Operational Tools
MSAD Operational Tools
MSEX Monitoring Tools
Microsoft SQL Server Administration Tools
Microsoft SQL Server Management Pack Operational Tools
Oracle Database Management Pack Operational Tools
SAP Admin Tools
SAP Information Tools

View Mappings

X X X

Design Graphs

< ]4)

(<] <]

SAP Sybase ASE Management Pack Administration Tools
SAP Sybase ASE Management Pack Operational Tools
Virtualization Infrastructure Tools

(<] <]

Note: OMi displays all categories used in existing tools. The tool category can be set in the tool
definition.

What Administrative Tasks the User Should be Able to Perform

Access to administrative tasks such as creating new tools, setting up new nodes, or deploying policies, can
be given in OMi by granting Full Control permission to the corresponding Administration Ul.
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The following figures show an example of administrative permissions in OMi:

i Permissions

» Event Processing

» Monitoring

) Operations Console

» RTSM

» Service Health

» Setup and Maintenance
» Users

» Workspaces

iPermissions

 Event Processing

I Automation & Partial ) Automatic Run Baok Execution 3 None )
Correlation 3 None ) Downtime Behavior 3 None )
Ewvent Automation Configuration ¢ None )
Event Forwarding 3 Mone )
Ewvent Processing Customization ¢ None >
Event Submission W All )
Indicator Mappings ¢ None >
Natification Templates ¢ None >
Notifications VAL Y
Time-Based Event Automation ¢ None >
User Group Assignments ¢ None )
“ Monitoring
Assignments. VAL Y Management Templates & Aspects VAL Y
Automatic Assignment Rules 3 None ) Policy Templates VAL Y
Deployment Jobs VAL )
MTs, Aspects & Policy Templates ¥ None )
Special Operations ¥ None )
“ Operations Console
Action Web Service ¥ None )
Custom Actions (Administration) ALY Full Control
Custom Actions (Execution) X None )
Design Graphs % Mone )
Event Browser X None )
Event Browser Options 3 None )
Events v All )
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Overview: How to Move Operations Agents to OMi
Step by Step

Note: OM allows installing agents remotely using technologies such as Rexec, SSH/SCP, Windows
DCOM, Windows shares.

OMi does not offer remote agent deployment (sometimes called bootstrapping or initial agent
deployment) today, but is able to deploy agent patches and hotfixes once the agent is installed.

Agents can be installed manually (also remotely using technologies such as SSH/SCP) or using other
software deployment tools such as HPE CDA. For more details, see https://hpln.hpe.com/blog/hp-
operations-agent-can-be-deployed-cda-and-csa, and HPE Server Automation or Microsoft Systems
Center 2012 Configuration Manager (see the HP Operations Agent and HP Operations Smart Plug-ins for
Infrastructure Installation Guide).

Another option is to keep an existing OM server for agent deployment.

This is the recommended sequence of steps for managing Operations Agents from OMi. These steps are
explained in detail in the following sections.

1. Allow management from both servers using a flexible management template.

2. Choose a group or type of nodes to move over, for example: all my Oracle Database systems.

a. Test policy and aspect deployment and tool execution from OMi on a representative node of that
type. This might include importing OM policies and creating OMi aspects and management
templates.

b. After a successful test, roll out the configuration to the remaining nodes of that type, either manually
or by using automatic assignment rules.

c. Switch the primary manager and target server to OMi. Doing so still allows configuration from both
OMi and OM servers.

3. Repeat steps 2-5 until all nodes are managed by OMi.

Before switching off the OM server, switch the agents to OMi completely, and clean up old OM policies if
necessary.

Configure the OMi Server as Secondary Manager

To allow step-by-step agent moves, we recommend that you configure the OMi server as secondary
manager.
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First, verify that the OM and OMi server certificates have been set up correctly, as described in the
Administration Guide > Setup and Maintenance > Connected Servers > How to Verify the Trusted
Relationship, and that the OMi server is part of the trusted server list of all nodes.

On the OMi server, list the server certificate using ovcert -list.
The (OVRG: server) part of the output lists the server certificate alias, shown in red.

Example ovcert —list output on OMi server:

| Certificates: |
| a?2bd9ad2-5134-755F-0178-843940bf71cE (*)

| Trusted Certificates: |
| CA 22bd88di-5134-755f-0176-8d3940bIT1cE (*)

| CA _a2bd598di-5134-755f-0178-8d3940bI71cE_ 2048

| |
| |

I

C4 elabcaci-aced-T7545%-05f7-bfecief15250
CR elabcaci-aced-T7545%-05f7-bfec2efl5250 2048

| Trusted Certificates: |
I CAh 82b49ad2-5134-755f-0176-6d43940bL71ct
I CAR a2bd%ad2-5134-755f-017E8-8d3940bE71ct 2048 I
| CA elabcaci-aced-7545%-05fT7-bfeciefl5250
| CA elabcaci-aced-7545%-05f7-bfecief15250 204 |

(= =)

If necessary, update the trusted server list of all nodes by running ovcert -updatetrusted on all nodes. On
OM for Windows you can use the HP Operations Manager Tools — Certificate Management — Update trusted
certificates tool to do this.

Set up OMi as secondary and action allow manager for the agents using an agent-based flexible
management policy. Create this policy on the OM server. You can use the ManagementResponsibilitySwitch
example as a starting point:

#
# Configuration file
# defines management responsibility switching
#
TIMETEMPLATES
#none
RESPMGRCONFIGS
RESPMGRCONFIG
DESCRIPTION "OM and OMi as responsible mgrs"
SECONDARYMANAGERS
SECONDARYMANAGER
NODE IP ©0.0.0.0 "omi.example.net"
DESCRIPTION "OMi"
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SECONDARYMANAGER
NODE IP 0.0.0.0 "om.example.net"
DESCRIPTION "OM"

ACTIONALLOWMANAGERS

ACTIONALLOWMANAGER
NODE IP 0.0.0.0 "om.example.net"
DESCRIPTION "OM"

ACTIONALLOWMANAGER
NODE IP ©0.0.0.0 "omi.example.net™
DESCRIPTION "OMi"

ACTIONALLOWMANAGER
NODE IP ©.0.0.0 "$OPC_PRIMARY_MGR"
DESCRIPTION "current primary manager"

MSGTARGETRULES
MSGTARGETRULE

DESCRIPTION "always send all messages to current primary manager"

MSGTARGETRULECONDS

MSGTARGETMANAGERS
MSGTARGETMANAGER

TIMETEMPLATE "$OPC_ALWAYS"
OPCMGR IP ©0.0.0.0 "$OPC_PRIMARY_MGR"

Note: OM will automatically add the ovcoreid for each manager to the policy. It retrieves the ID from the
corresponding node in the OM database. Make sure that the ovcoreid stored there is the OMi server
core id (the ID returned when calling ovcoreid -ovrg server onthe OMi server).

On OM for Windows, you can check and change the ovcoreid in the node properties:

Advanced Configuration

Caution: Messages cannot be received from nodes if the agent ID is incorrect.

¥ Modify Agent ID: | 42c1a3f2-4f5a-755f-0376-a3cdb6eas529

I Modify Certificate State: [instalied =

OK I Cancel |

On OM for UNIX and Linux, you can check the ovcoreid of a node using /opt/0V/bin/OpC/utils/opcnode
-list_id node_name=<omi GW/LB/server node>and change it using the -chg_id option.

Deploy the policy from the OM server to all nodes.
To verify if the configuration is correct, you can check a single node from the OMi gateway server using

ovpolicy -list -host <node.example.net> -ovrg server.

Note: When running command line utilities like ovpolicy or ovrc from an OMi server, you always have
to specify the -ovrg server option (unlike OM where this option is only needed in cluster
environments). Otherwise the command will fail with a “not authorized” error.
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Move Configuration to OMi

Overview
It is recommended to move the configuration of nodes to OMi step-by-step to reduce risk and to allow you to
become familiar with new features in OMi.

To familiarize yourself with the new OMi Monitoring Automation features, examine and test the Infrastructure
Management Pack. It is free and does not require a separate license.

During the evaluation period you can also install, test, and examine other available Management Packs.

Once you have explored the Monitoring Automation features, you can begin to move the configuration of
nodes from OM to OMi Monitoring Automation.

We recommend that you do not configure a node partially from OMi and partially from OM. Instead, identify
those nodes or node groups that can be configured completely from OMi.

For example, systems running the Oracle 11 database can be easily managed using the Oracle Management
pack and Infrastructure Management Pack. They are good candidates to be moved over first. For other
systems, you might want to wait until a corresponding Management Pack is available. If you do not plan to
use HPE or Partner Management Packs, then you can import your custom OM policies into OMi.

We recommend you select an OM node group to start with. Determine how it is monitored today and decide
how it should be monitored in the future, using an available Management Pack, custom policies, or both.
Depending on your decision, adjust the management template or import customs policies. For details, see
cases 1-3 below.

Once all monitoring artifacts have been brought to the OMi server, pick a representative node and test the
configuration from OMi by assigning management templates or aspects manually. You might have to assign
some aspects to the node Cl and others to application Cls running on the node. Compare the old
configuration with the new configuration and check if all policies have been redeployed.

After the test phase, you can roll out the configuration to all nodes of that node group. Depending on your
preferences or needs, you can either do this manually or automate it using automatic assignment rules.

Choose the next OM node group and repeat the steps.

Case 1: Manage Nodes Using an Available Management
Pack

If you want to replace the existing OM configuration with a Management Pack, see the corresponding
Management pack installation guide and the OMi Help for details.

Moving From an Existing SPI to a Management Pack

When you are currently using a SPI on OM, you have two options when moving to the new Management
Pack:
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1. Deploy the new Management Pack as it is, and check if it fits your needs. Adjust aspect parameters,
such as thresholds, if needed, on assignment or individual Cl level. This option might be appropriate for
customers who have modified the OM SPI slightly, or who want to establish new standards for
monitoring.

2. Analyze the SPI customizations that have been performed on the OM side to determine which of these
are still needed with the new parameterized aspects. See the OMi Management Packs Evolution Guide
for details.

Case 2: Import and Reuse Custom Policies from OM

To reuse custom OM policies, you export and then import policies, parameterize them if needed, and group
them into aspects and management templates.

It is recommended to do this step-by-step, policy group by policy group.

For example, if you want to move over the configuration for all your SAP nodes, which you have organized on
the OM side using a SAP node group. A single SAP node might not only receive SAP policies, but OS and
System infrastructure policies as well, based on the Linux node group the system is part of. To move over the
configuration for the node group, several policy groups need to be moved.

To avoid unnecessary effort, you should only export and import policies that will be used on the OMi side. Do
not just export all policies stored on the OM server.

Identify or Create Policy Groups with Policies to Export

Larger OM customers typically have all their active policies in certain policy groups that are often also used
for automatic deployment. If this is your case, you can use those policy groups for the export.

If policies were assigned manually and from various source policy groups, then it is recommended to first
create a dedicated new policy group that contains all active policies that represent how a node is managed
today. You don’t have to copy policies that are anyhow not supported by OMi, like ECS, but as OMi simply
skips those during the import, you don’t have to worry about supported and unsupported types when doing the
export. You then export all these policies using the policy group name.

For extensive information, see the Administration Guide > Monitoring > Migrating Configuration Data
> Importing Configuration Data from HP Operations Manager.

The following sections list the most important commands.

Export Policies from OM for Windows

ovpmutil cfg pol dnl <folder> /p <identifier> [/instrum]
The switch /instrum also exports all instrumentation related to the policies inside the group, for example:

ovpmutil cfg pol dnl c:\test /p \Samples /instrum

Note: ovpmad service needs to have access/write permissions to the export directory.

Export Policies from OM for UNIX and Linux

Use opcpolicy to download policy groups together with instrumentation:
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# /opt/0V/bin/0OpC/utils/opcpolicy -download pol_group=<groupNameWithPath>
dir=<downloadDir>

Copy Data

After the export, copy the downloaded files to an OMi gateway server system.
Import Policies on OMi

Syntax Check

It is recommended to run a syntax check for all policies which should be uploaded to OMi.

c:\HPBSM\opr\bin\ConfigExchange.bat -username <username> -password <password> -check
-policyfile c:\temp\OML_Test -logfile c:\temp\omlpolicies.txt

The specified user must be a BSM user with permission to create policy templates.

Review the lodfile for warnings and an overview.

OM for Linux Config Data Upload

Specify the copied folder as input directory:

c:\HPBSM\opr\bin\ConfigExchange.bat -username <username> -password <password> -uploadOM
-i c:\temp\OMLExport\

OM for Windows Config Data Upload

Specify the copied folder as input directory:

c:\HPBSM\opr\bin\ConfigExchange.bat -username <username> -password <password> -uploadOM
-i c:\tmp\OMWPolicies

Using this import mechanism, the policy group structure is imported as well and will show up as template
groups under Administration > Monitoring > Policy Templates.

The following figure shows an example of a group structure that was created as part of a policy import:

Paolicy Template Groups
S+ XAl &0 G
Bl g Policy Management
= E,j_ Template Groups
ﬁj_ OMi Server Self-Monitaring

5] EE Templates grouped by type

e

B3 configuration
ﬁj_ Events

Ej GEMNEric

Ej hietrics

Ttz Templates of unknown type

HEH

H

ﬁj_ Tapaloy
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Adjust Policies if Necessary

If the import returned warnings, edit the imported policies in Administration > Monitoring > Policy
Template. This might be necessary if the policies refer to OM server variables like $0PC_MGMTSV, or use
features that are not available in OMi, such as server-based MSI.

For information, see the Administration Guide > Monitoring > Policy Templates, which also contains
information on how to search policy templates.

Group Policy Templates into Aspects

After importing policies, grouped them into meaningful aspects. An aspect is defined for a specific Cl type
and should contain all policies that are required to monitor a certain aspect of the Cl, like its performance or
availability.

video 1: See the OMi tutorial “How to create an aspect containing a group of policy templates” at
https://hpln.hpe.com/page/omi-tutorials.

Go to Administration > Monitoring > Management Templates & Aspects. Create a suitable
configuration folder and add aspects there. When creating an aspect you have to give it a meaningful name,
specify the Cl Type it is for, and select the corresponding policies.

| Monitoring = Management Templates & Aspects

Setup Ewent Automation Ewent Correlation Operations Console | Monitoring |_

Policy Templates

-| Add Policy Template to Aspect

Hame
Policy Templates

Parameters

g Q
3
o
[

pache/Tomcat Log Collection from Linux

1
> P

S Apache/Tomcat Log Cellection from Linux_1.0
5 Audit Log Collection from Linux

[# CrClusterDataCollector

{e}) C-ClusterDiscovery

f clLcusterMonitor

E

E

£ai]

In this step you can create various aspects for various different Cl types.

Optional, but Recommended: Create Management Templates to
Group Aspects

Creating management templates is not necessary, but advisable. Management templates can simplify the
assignment of many aspects, and also allows starting the monitoring of composite applications with a single
assignment. You can group aspects using nested aspects as well, but this is limited to a single Cl Type. You
cannot include an aspect for Cl Type A into another aspect for Cl Type B. If you want to assign several
aspects for different Cl Types in one assignment, you need Management templates.

To use management templates, the Monitoring Automation for Composite Applications license is required.
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To simplify the assignment of multiple aspects, it is recommended to create one or several management
templates after all aspects have been created. For example, you can create several management templates
with different aspects, representing for example Essential and Extensive monitoring levels.

Go to Administration > Monitoring > Management Templates & Aspects. Create a configuration folder
to add management templates into. When creating a management template, you have to give it a meaningful
name, specify a view and root Cl Type it is for, and select the corresponding aspects. If you use the
management template just for the grouping of aspects that belong to one Cl Type, you can select any view
that contains this Cl Type as starting point. You don’t have to create a sophisticated view for that. The view is
just used as the starting point for the management template definition.

If you want to start the monitoring of multiple related Cls of various Cl types using a single assignment, then
you have to create a management template for that. In this use case you have to select (and might have to
first create) a view that shows all the Cl Types and their relations as a starting point for the management
template.

Note: Each Management Pack typically ships application views that can be used as a starting point.

For more information, see the Administration Guide > Monitoring > Management Templates & Aspects
> Configuring Management Templates.

Case 3: Reuse Configuration for Other Node Groups

You might have created multiple policy groups on the OM side to monitor different node groups slightly
differently, for example, because you wanted to use different thresholds or different message groups. This
was necessary because OM has limited built-in parameterization.

If you created copies or versions of policies in OM and only changed parameters without changing the policy
logic, then you should not import those copies into OMi. Reuse and parameterize an existing policy instead.

The parameter values are then changed either when assigning the aspect or management template or when
defining multiple aspects or management templates.
Additionally, the tuning of these values can be performed afterward without changing the policy data.

Parameterize Policy Templates

Go to Administration > Monitoring > Policy Templates and search for the existing policy that contains
the same logic.

Edit the policy and identify the parameters that differ between policies in OM.
For each such parameter, create a parameter in the OMi policy.

video 2: See the OMi tutorial “How to add a parameter to a policy template“ on
https://hpln.hpe.com/page/omi-tutorials.
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Here you can see an example of a simple measurement threshold policy with four rules. The thresholds used
in each rule have been parameterized. Other message attributes, for example, severity, can also be
parameterized:

ﬁhttp:,‘-",‘-"mambu4.mambu.net,.w"?task:Iuad&rawMude:D&versiunid:975cd43d—el3E--'l735—93114—926&96009335&@n - Windows Internet Explorer

Properties

= Threshold Rules Overview ? |-
Source
e S O | EWEYR
Processing Seq. Threshold Level Description
Rules 1 Major
Options 2 Minor

3 Warning

4 Marmal

~ Threshald Definition - "Major" ?

Definition Actions Start Action Policy Parameters

Threshold Level Description: |Maj0r | ® O

é“,-u'é Major Threshold, Major Threshold

é}-ﬁ Minor Threshold, Minor Threshold
Threshold limit (Maximurn] é:':; WarningThreshold, Warning Threshold
»  MormalThreshold, Normal Threshold

CPU_Test == (greater than or egual o) |%%MajorThreshold%%

Short-term peaks

[7] gnare single short-term peaks occurring vwithin OhOm0s

Reset
(®) Reset value is same value as threshold limit
() Specity & special reset value tor the threshold level

CPU_Test = (less than):

Instance Parameters

Sometimes it is necessary to monitor different instances of a monitored object on the same node differently.
OM allowed this using instance conditions in measurement threshold policies. Such instance conditions
should be replaced by an instance parameter in OMi, which makes it easier to add or remove instances using
parameter tuning without changing the policy.

An instance parameter enables you to create policy templates that monitor multiple instances of the same
type of object, for example, multiple database instances or multiple hard disks.

Each policy template can have only one instance parameter. When you add an instance parameter to a policy
template, all other parameters become dependent on it. The user can specify separate values for the
dependent parameters of each instance.

For example, if you have a policy template that monitors the percentage of disk space in use, you could
create an instance parameter called 'DiskDrive', and dependent parameters called 'Minor disk usage
threshold', 'Major disk usage threshold', and 'Critical disk usage threshold'. A user of this policy template can
specify multiple disk instances using the 'DiskDrive' parameter, for example, by adding the instance values
C:, D:;, and E:. For each disk instance, the user can then set different values for the dependent parameters,
for example, the value of 'Critical disk usage threshold' could be 85% for disk C:, 90% for disk D:, and 95%
for disk E:.
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Replace both the instance filters and thresholds with a parameter:

Properties
~ Instance Rules Cverview 2=
Source
Detauts v Dy X 0w (Search Rutes S4r) ¥
Eisceseiy Seq. | Rule deseription Rule Type Amourt Thresholds
Rules 1 AllDrives Evaluste thresholds it matched | 4
Options

~ Instance Rule Definition - "AllDrives" ?
W Thresholds

it PoicyParameters | |
o)

DiskDrive, DiskDrive <iestance Parame
@ CriticalThreshold, CrilicaThreshold

i MinorTheshaid, MinorTheshold

& WarningThreshold, WarningThreshold

& MormalThreshld, MormalThreshld

Fule description:

Rule Type: Evaluste thresholds i matched |« |

Stop evaluation

Specify condition (to match incoming event of type 'Measurement Thresheld')

Erter & pattern to compare sgainst the monitored object name. Tis is useful to monitor specific instances
For example, the manitored object is "disk and each avaliadle disk is one instance

Object name:  matches

%%DiskDrive %%

] ]

Threshold Definition

sk=load&rawMode= b4c407-58b2-44e7-afcT-44c2ffe00a70&con - Windows Internet Explorer

Froperties
~ Instance Rules Overview ? -
Source
Defauts #r By ¥ O (Search Ruies L4 k) T
Processing Seq. | Rule description Rule Type Amourt Thresholds
Fules 1 AlDrives Evaluste threshalds if matched | 4
Options
~ Instance Rule Definition - "AllDrives" ?
Defintion Thresholds
By 8 U (Search Threshalds Q4 r) T
Seq. | Threshold Level Description
1 CriticalThreshold
2 Minor
3 Warning
4 o el
 Threshold Definition - "CriticalThreshold" ?
Defintion Actions Start Action Policy Parameters
Threshold Level Description: [ CriticalThreshold ko 8O
DiskDrive, DiskDrive <ustance Paraume
o i CriticalThreshold, CriticalThreshold
Thresheld limit (Minimum) 2 MinorTheshuid, Minor Theshold
[ " e ¢ WarningThreshold, WarningThreshold
ishfree_Test <= (less than or equal to) rhicalThreshd & MormalThreshold, MormalThreshold

Moving from Instance Conditions to Instance Parameters

The following example demonstrates how to change a measurement threshold policy from using static
instance filters and thresholds to using instance parameters. This example policy monitors the percentage of
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space used in the log of the databases configured in Microsoft SQL Server. Different thresholds are set based
on the database name. The database name is the instance that will be parameterized.

r@ MSSQL Databases Percent Log Used [1.0] {Measurement Threshold)

File View Help
B save and Close [ Save | 2 Help ‘

Source IFluIes I Dptinn&l

Shart hame* |DEF'c:tL|$ed
Description
Saurce bupe I—:.F Feal Time Performance Meazurement j

—'Windows MT performance monitor parameters

Object” ISDLS erver.Databazes j
LCounter” IPercent Log Uzed j
Instance || j

Browse on node. .. |

[~ Store in Embedded Performance Componerk

Data Source”™ I

Object” |

tetric I

Polling jnterval ID ﬁh |5 ﬁm ID ﬁ 3 Add zource. . |

@ MSSQL Databases Percent Log Used [1.0] {Measurement Threshold) =]
File Wiew Help -

F% Save and Close [ Save | 2 Help |

"Source  Rules |D|:-ti-:ns|

IE-I b asirnumm 'I

Seq. / | Description | Fule Type | Mew... I

1 Adventurety | matched, da actions and stop Wadif

2 tempdb If matched, do actions and stop —I‘I'I

3 ReportServer [F matched, da actions and stop Delete |

4 ReportServerTempDB  |f matched, do actions and stop

5 other If matched, do actions and stop Copy |
Rule surnmary fave up |
IF Condition [Object name: Adwventurety orkz 0w |
of thiz rule is true THEN: Loualaaill

Evaluate threshold levels: Wave to: I
{Major [Threshold limit >= 90; Sewerity: Major)k :
{Mincr [Threzhold lirmit >= 85; Sewerity: Minor)

' arning [Threshald limit >= 80; Severity: W aming)} Defaults... |

Stop evaluation

ELSE evaluate next rule Test... |

Once you have imported the policy into OMi, it can be assigned and used as is. However, to allow setting

parameters that can be defined during assignment rather than being hard-coded in the policy, edit the policy
template and make these changes:

1. Inthe Policy Parameters tab, click * to create a new policy parameter. Mark it as an Instance
Parameter. Set the default value to the pattemn <*> so that all instances are monitored by default if the
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user doesn't override the settings during assignment.

Edit Parameter

# MName:

# “Wariable Name:
Instance Parameter:
Ul Order:

Deszcription:

+ Wariable Type:
Default Value:

Flags:

| Catabase Name

| CatabaseName

[0

SOL Server database name

| String

[] Use conditional values

=t

Mandatory
[] Read Onby
[ Expert Setting

[] Hidden

2. Modify the first rule and give it a generic description. Remove all the other rules that enumerate the

instances.

3. Drag and drop the instance parameter into the Object Name field. Because the object is a pattern, you
might want to anchor it with ~$ to ensure an exact match. For example, ~%%DatabaseName%%$.
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Properties .
~ Instance Rules Overview ?
Source
Processing Seq. | Rule description Rule Type Amount Thresholds
Rules 1 Per instance Evaluate thresholds if ma) 3
Options
+ Instance Rule Definition - "Per instance" ?

Defintion Thresholds

Rule description: | Per instance

Rule Type: |Eva|uate threshelds if matched |v|

Stop evaluation

Specify condition (to match incoming event of type 'Measurement Thres...|

Enter a pattern to compare against the monitored object name. This is useful to monitor specific instances.
For example, the monitered object is "dizk”™ and each available disk iz one instance.

Policy Parameters

ko KO

El Datab

Object name: matches 99 NatabaseName% %S

-

Name, Datab

4. To enable different thresholds to be set for each database instance, you also need to parameterize the
threshold settings. This policy has threshold rules for Major, Minor, and Warning thresholds.

In the Policy Parameters tab, click to create a new policy parameter for MajorThreshold. Specify if itis
numeric, and provide a valid range and a default value.

Edit Parameter
# Name: |I'|'Iaj|:rr'l'hres.hnh:l
+ \ariable Name: | MajorThreshold
Instance Parameter:
Ul Order: [0
Description: Threshold for majer severity event
+ Wariable Type: | Numeric
Minimum Value: | 0
Maximum Value: | 100
Default Value: [ use conditional values
|50
Flags: Mandatory

[l Read Onty
[ Expert Setting

[T Hidden

5. Drag and drop the MajorThreshold policy parameter into the Threshold field of the Major rule.
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Properties
Source
Defaults
Processing

Rules

Options

+ Instance Rule Definition - "Per instance”

ond

Definition Thresholds

Rule description: | Per instance

‘ Policy Parameters

Rule Type: |Evaluate thresholds if matched |v|

Stop evaluation

Specify condition (to match incoming event of type 'M

irement Thres... ||

¥ 2 KO
EA Datab Name, Datab
S Major Threshold, MajorThreshold

For example, the monitored object is "disk™ and each available disk iz one instance.

Enter a pattern to compare against the monitered object name. This is useful to monitor specific instances.

Object name: matches ang o DatabaseName% %5

4 ] [

~ Threshold Definition - "Major"

ond

Threshold limit (Maximum)

Definition Actions Start Action Continue Action End Action Policy Parameters
Thresheld Level Description: |Maju|- * X O
EA Datab Name, Datab

S Major Threshold, MajorThreshold

DBPctlsed == (greater than or egual to): | %%MajorThreshold%%

6. Create additional policy parameters for each of the other thresholds (Minor and Warning), and drag and
drop them into the Threshold field of the Minor and Warning rules respectively.

Properties .
¥ Instance Rules Overview ?
Source
Do | ke B X 0 (Gearonres FREYN ¢
Processing Seq. | Rule description Rule Type Amount Thresholds
Rules 1 Per instance Evaluate thresholds if ma| 3
Options
¥ Instance Rule Definition - "Per instance" ?
Definition Thresholds
# By X N o j:;‘-es':" Thresholds [ );] T
Seql Threshold Level Description
1 [Major
2 [Minor
B ing
2

+ Threshold Definition - "Warning"

Policy Parameters

* 2 KO

Definition Actions Start Action Continue Action End Action
Thresheld Level Description: |Warning

Threshold limit (Maximum)

Database Name, Datab
Major Threshold, MajerThreshold
Minor Threshold, MinerThreshold

DBPctlsed == (greater than or egual to): | %%WarningThreshold%%
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7. Save the policy template.

While you can assign the policy template to a Cl, it is best to create or modify an aspect to include the policy
template. When it is assigned, you can specify the database instance(s) to be monitored and override the

thresholds for each instance.

Note: The order in which you list the instances is important, because it dictates the order of the rules
within the policy when it is deployed to the managed node. Therefore, place the more specific instance

names at the top of the list.

Edit Instance Parameter: Database Name

Add instance parameters, and then for each instance parameter, specify values for the dependent parameters.

Description:
Instance Values Dependent Values
X MY i @ ( Search visible field -.L.;;'u
P ReportServerTemplDB _| Name | Value
P ReportServer Major Threshold g 99
M AdventursWWorksDi Minor Threshold -
m - Warning Threshold = a0

ok

You could specify whether the aspect is associated with the Microsoft SQL Database Cl Type and then
modify the instance parameter to use the CI attribute containing the name of the database, instead of
manually entering the names. All database instances will get the same threshold settings, but you can
override the thresholds for each instance in the Assignments and Tuning screen.

HPE Operations Manager i (10.10)

J Browse Views | Search | Assignments
o & S+ 2 R 0 b | &E) BB ?
|r.1SSQL_Depluyment |v| (] | Assigned Iltem | Version | Assigned By Enabled
Ell;[ MSSaL_Deployment = % Generic opcmsg 1.2 AutoAssignment v =
EI ISONOE (venus} - fj.‘ MSS50QL Databases Percent Log Use... 1.6 adminizstrator W =
EllEl MERCURY [mercury} SESSS
- mercury - Parameters
» EY)
Instance | Name | Value
Database Mame M [AdventureWorksDWW] =
[AdventureWo... | Major Threshold %90
[AdventureWo... | Minor Threshold $#Eoas
[AdventureWo... Warning Threshold é‘;% 45
Database Name FA [ReportServer]
[ReportServer] Major Threshold ﬁg S0
[ReportServer] Minor Threshold gﬁ? 85
[ReportServer] | VWarning Threshold §n‘;§ 0
Database Name EA  [model]
[model] Major Threshold #® 99
[model] Minor Threshold $#Eoas
[model] Warning Threshold a0
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Test Configuration

Once you have chosen or created the aspects and Management Templates you want to use, you should use
manual assignments to test and verify the configuration.

You can assign Management Templates and aspects using the aspect or Management Template as a
starting point. Go to Administration > Monitoring > Management Templates & Aspects. Select the
aspect or Management Template you want to deploy and choose Assign and Deploy Item:

Administration |/ Moniforing / Managemens Templates & Aspects

Configuration Folders Templstes & Aspects

Sl x| Eald0R o BIEANZ SRR W RN -NE
B E§ Configuration Folders [& OMi Server Self-Monitoring
Eﬁ OMi Server Self-Monitoring . OMi Data Processing Server monitoring

OMi Gatewway Serwer monitoring Refresh

Creake Management Template. ..
Create Aspect...

Edit Ttem...

Delete Ttem

Update ko Latest...

List Items Requiring an Update

Zopy Them
ut Item
Paste Tkem

Assign and Deploy Ttem. .
List Assignments for Selected Item...
Generate Assignment Repart...

Settings...
Global Settings...
About Adobe Flssh Flayer 11.9.900.117...

Alternatively, you can use the Cl as a starting point: Go to Administration > Monitoring > Assignments &
Tuning. Select a view that contains the Cl and choose Assign ... from the drop-down list.

Administration / Monitoring / Assignments & Tuning

Browse Views Search matmbo3 - Assignments
5 S EEe B el | BB GBS
D [':g'. Aggign Management Template...
System Hardware Monitoring v Assign Aspect...
= l;[ System Hardware Monitoring Tl A=ssign Policy Template
mambo3

The assignment will by default initiate an immediate deployment of all included policy templates to the
corresponding nodes.

On the representative node, you can then verify whether all policies have been redeployed:
ovpolicy -list -host <hostname> -level 2 -ovrg server

This will list all policies and the management server that installed the policy. It might list old policies deployed
from OM that have not yet been replaced by OMi.

You can also use the Synchronize Policy Template Assignments feature of OMi to see the policies deployed
from OM: Go to Administration > Setup and Maintenance > Monitored Nodes. Select a node and
choose Synchronize Policy Template Assignments from the context menu. Then check the assignments on
Administration > Monitoring > Assignments & Tuning. Make sure to show policy assignments as well,
as OM can only assign policies and does not know aspects or management templates.

Note: Only one policy with the same name can exist on a node. If multiple assignments on the OMi side
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assign policy templates with different versions, then the policy template with the highest version number
(and its parameter values) will be deployed by OMi.

What happens if a policy was deployed by OM, got imported into OMi,
and redeployed as part of an aspect or a management template?

The policy will be deployed again from OMi and will replace the existing policy with the same version.
Afterward, the policy owner will be the OMi server.

What happens if a policy was deployed by OM, got imported into OMi,
adjusted (new version created), and redeployed?

The policy will be deployed again from OMi and will replace the existing policy with a lower version.
Afterward, the policy owner will be the OMi server.

What happens if a policy was deployed by OM, got imported into OMi,
renamed, and redeployed as part of an aspect or Management
Template?

The renamed policy will be deployed from OMi, in addition to the already existing policy. The OM policy
should be removed manually.

What happens when someone tries to delete a policy or policy
assignment on OM after policies were deployed from OMi?

OM checks the policy owner before deleting policies. If the policy owner is OMi, then OM will not delete the
policy (unless you specifically ignore the owner or choose force update).

How and when should | remove old OM policies?

If policies were not renamed and if all used policies were imported into OMi and redeployed from OMi through
corresponding aspect or management template assignments, then there is no need to delete old OM policies
as these no longer exist. They were deleted and replaced by corresponding OMi policies.

If you decided to no longer use certain policies, these need to be removed from the corresponding nodes. One
way to do this is to use the OM console:

In OM for UNIX delete the corresponding assignment to a policy group, node group or node and deploy
policies. Make sure that Force Update is not selected.
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Deploy Configuration= - o -

Distribution Parameters

Components

3 Policies

™ Actions

r Maonitors.

™ commands

r Instrumentation

[ Subagents

Nodes / Nodes in Node Groups / Hodes in Layout Groups to distribute to

omkdb.mambo.net ;I
mamboenS9.mambo.net

- Force Update

r Purge Instrumentation

In OM for Windows, choose the policy version and choose Uninstall from... from the context menu.

ﬁ Uninstall policies from...

Deployment Nodes

* Select all nodes on which the current version of the policy is deployed
" select all nodes on which any version of the policy is deployed
 Select nodes from the tree

Make sure that Ignore policy owner is not selected:

Deployment Options
[+ Force removal of policy
I~ Remove all versions
[~ Ignore policy owner

It is also possible to remove old OM policies using the -deploy -clean option of the opr-agt tool. For
example, by using:

opr-agt -deploy -clean -node_list "nodel.example.com,node2.example.com"

For more details, see the Administration Guide > Monitoring > Command-Line Interfaces > The opr-
agt Command-Line Interface and opr-agt —help.
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What happens when | delete a node from OM?

Caution: We do not recommend deleting nodes from OM during the evolution, because if the topology
synchronization between OM and OMi is still active, this will delete the node Cl from the RTSM as well.
To prevent this from happening, set the Skip Cl Deletion infrastructure setting (Infrastructure Settings
for Operations Management > OM Topology Synchronization Settings) to True. This will disable the
automatic deletion of Cls when performing topology synchronization.

Roll Out Configuration

Once the configuration is validated using a test node, you can roll out the configuration to the rest of the
nodes. You can do this either manually, if there is only limited change in the environment, or automatically
using web services or automatic assignment rules.

Manual Roll Out

To manually assign configuration to multiple Cls, use Administration > Monitoring > Management
Templates & Aspects with the aspect/Management Template as a starting point. Select all corresponding
Cls manually.

Automation Using Web Services

Automation can be achieved using the Monitoring Automation web services interface. For example, a
Management Template can be assigned programmatically to a Cl when a new server is provisioned. For
details, see the Extensibility Guide > Web Service Interfaces > Monitoring Automation Web Service
Interface > Examples of Monitoring Automation Web Service Applications.

Automatic Assignment Rules

Automation can also be achieved using automatic assignment rules.

Automatic assignment rules are defined for certain views. Aspects and policies get assigned and deployed to
all matching Cls in the view. Make sure that you do not assign configuration to Cls that you do not yet want to
configure from OMi. For example, if you create an automatic assignment rule for a System Infrastructure
aspect and choose the Systems_Infrastructure view, this would trigger an assignment and deployment to all
nodes in the RTSM (because the out-of-box Systems_Infrastructure view includes all nodes). If you have
used topology synchronization from OM as recommended, a deployment to all OM nodes will be triggered. To
avoid this, choose another view which only contains those Cls that you want to configure from OMi. See How
to avoid policy assignment to nodes that are not yet managed by OMi below.

Example 1: How to assign Gold, Silver, and Bronze monitoring levels to different “nodes”.

On the OM side you might have deployed different policy groups representing Gold, Silver, and Bronze
monitoring levels to different node groups. To automate this in OMi, you use three Management Templates (or
summary aspects with nested aspects), and three views that contain the corresponding Cls.

Note: Management templates and aspects are defined for certain Cl Types, like Oracle or computer.
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When you want to assign these, you need views that contain Cls of those Cl types.

To separate CI groups, you can use pattern views with queries that return only those Cls of a Cl type that
matches a certain query. For example, if you have certain Oracle databases that should be monitored using a
Gold Management template, and if you can determine those databases based on Cl attributes or relationships
to other Cls, then you can define a pattern view that only contains those Cls.

If the CI attributes do not yet contain enough information, then you should try to add the information in an
automated way, for example, by using enrichment rules or RTSM APls, as manually adding and maintaining
Cl collections is often not suitable when you want to automate monitoring.

Example 2: How to assign multiple Management Templates or aspects to the same “nhodes”.

On the OM side you might have deployed different policy groups, for example for Linux, Oracle or other
application management areas, to a single node. To automate this in OMi, you use multiple automatic
assignment rules with corresponding Management Templates, or summary aspects with nested aspects, and
views.

Note: You should avoid assigning the same policy templates multiple times through multiple
assignments. This could happen if you assign one Management Template to a view that contains many
Cls, for example all Linux nodes, and another Management Template to a subset of these Cls, for
example all Linux systems that run Oracle databases. If both Management templates contain the same
policy templates with varying parameter values, the system applies one of the two values and you
cannot tell which one. To avoid this, either make sure that the views used in auto-assignment rules do
not contain the same Cls (disjoint views) or that the Management Templates and aspects that are
assigned to a single node do not contain the same policy templates (non-overlapping Management
Templates and aspects).

Go to Administration > Monitoring > Automatic Assignments Rules and see the corresponding OMi
Help topics for more details.

How to avoid policy assignment to nodes that are not yet managed by OMi

When the OMi server is specified as the primary manager of an agent, the Operations Agent will send
information about its node name and IP address to the OMi server. When this data is received, OMi also
creates a relationship between the OA Cl and the OMi server Cl in the RTSM, which means that the agent is
now managed by OMi. This relationship can also be created manually by using the node editor “managed by
OMi” icon.

This relationship can be employed in views used in automatic assignment rules so that the only Cls showniin
the view are those that are hosted on nodes managed by OMi. Add the Operations agent and OMi server Cl
types to your view with corresponding relationships to nodes. Nodes and related Cls that are not managed by
OMi should not appear in the view result.

Use such a view in automatic assignment rules. Whenever another agent is switched to OMi and sends its
node name/IP address data to OMi, it will appear in the view and will automatically get the corresponding
assignments.

Alternatively, you could assign aspects to all nodes, but deploy the flexible management policy that grants
OM i the right to deploy policies only to those nodes you want to switch. In this case, deployment jobs for
nodes that don’t allow policy deployment from OMi will fail, but these jobs can be deleted manually and the
deployment can then be triggered again when the node is switched. However, this option does not
transparently show which nodes have already been switched.
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OM and OMi Policy Assignment and Deployment Functionality Comparison

The following table compares policy assignment and deployment functionality in OM and OMi.

Functionality

Assignment and
deployment
process.

Deployed policy
state.

Version
assignment to
configuration
object or Cl.

Update version
assignment to
configuration
object or Cl.

Delete assigned
policy.

OM for UNIX

Assignment and
deployment are separate
tasks.

Deployed policies are
enabled.

Can assign fixed, latest
or minor to latest version
to policy group, node
group or node.

Yes.

Policy is deleted,
including assignments.

OM for Windows

Assignment and
deployment are
combined.

Can choose whether
deployed policies are
enabled, disabled or
unchanged.

Can assign fixed or
latest policy version to

policy group.

Fixed policy version is
assigned/deployed to
node or node group.

Can update to the
latest version for
selected policies ina
policy group.

Can update to the
latest version for all
policies assigned to a
node.

Can manually assign a
different version.

Policy is deleted,
including
assignments.

OMi

Assignment and deployment are
combined.

Can prevent automatic
deployment globally via "Create
suspended deployment jobs" in
Infrastructure Settings.

Can choose whether deployed
policies are enabled or disabled.

Relationships between
management templates, aspects
and policy templates are based on
fixed versions.

Fixed versions are
assigned/deployed to Cls.

Can update to latest version of the
objects within a management
template or aspect.

Can manually assign a different
version.

Need to delete assignments
before being permitted to delete

policy.

Change Primary Manager and Target Server of Agents

During the move to OMi you can continue to use your existing OM server as (primary) manager, receiving the
events from the agents, until you switch off OM, and as long as OM forwards all events to OMi.

However, to verify that all server-based correlation features of OMi are working as expected, including
duplicate suppression and event storm suppression, it is recommended to change the target server for events
to OMi gradually. For example, when you have moved the configuration of the corresponding nodes to OMi
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then you could also switch the target server to OMi. In case you still would like to receive all events in OM as
well, you can use an OMi forwarding rule that forwards all events received on OMi to OM. Instruction retrieval
might also fail if the OM server does not have the policy that was deployed from OMi in its policy inventory.

With the earlier mentioned flexible management policy, you can switch the target server by switching the
primary manager of a node, because the flexible management policy contains

MSGTARGETMANAGER
TIMETEMPLATE "$OPC_ALWAYS"
OPCMGR IP 0.0.0.0 "$OPC_PRIMARY_MGR"

as message target rule. If you used another message target rule, change it accordingly and redeploy the
policy to those nodes you want to switch.

You can switch the primary manager from OMi using, for example:

opr-ragt -username admin -primmgr <node selection>

Note: OM allows setting certain agent configuration variables in the OM Ul, like agent buffering and
DHCP settings.

Limit Buffer Size ZI Enable 'I *

Maximum Size (KB) |1 0000 *
Dizcard Messages with Priority lower than I Normal vI *

OM i does not allow changing these via the Ul, but these settings can be changed using ovconfpar.
To configure these from OMi, use the opr-agt -set_config_var option: For example, use:
opr-agt -set_config_var eaagt:O0PC_BUFLIMIT_SEVERITY=major -node_list nodel,node2

opr-agt -set_config_var eaagt:0PC_BUFLIMIT_SIZE=10000 -node_list nodel,node2

Consequences of a Primary Manager Switch

A switch of the primary manager affects the license counting and heartbeat monitoring. The agent will now
report to the OMi server and increase the number of Operations Agents shown on the OMi Server license
report.

A switch to the OMi server as primary manager also causes the agent to report its IP address and node name
to the OMi server, which will create corresponding Cls and relationships in the RTSM and start agent health
checking from OMi. It might also trigger the deployment of policy templates if you have defined
corresponding automatic assignment rules.

Consequences on the OM side:
The OM server might report that the agent is no longer running as it is no longer receiving heartbeat
messages. Switch off the health check on the OM server side.

Note: After a primary manager switch it is still possible to manage and configure an agent from the OM
Server. It is therefore still possible to deploy or remove policies from OM.
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Complete Switch of an Agent

To be able to switch off the OM server, the agents need to be reconfigured so that they use the OMi server as
their server, even when the flexible management template is removed.

This can be done using the opr-agt -switch_manager option. It changes the following settings on the agent:

sec.cm.client CERTIFICATE_SERVER
sec.core.auth MANAGER
sec.core.auth MANAGER_ID
eaagt.lic.mgrs GENERAL_LICMGR

opr-agt allows a mass update using a TQL, node group, or node list. For example, from OMi use:

opr-agt -switch_manager -query_name All_agents_mgd_by OMi* -username admin

or

opr-agt -switch_manager -node_list nodelfqdn,node2fqdn,node3fqdn
Note: Make sure that this TQL only contains those nodes you want to switch. Especially make sure that
the OM server node is not part of that TQL. As an alternative use the —nodelist option.

To clean up old OM policies that might still be installed on the node, run:

opr-agt -deploy -clean <node selection> -username <user>

This deletes all existing policies on the node, including the flexible management template that grants rights to
both OMi and OM servers, and then deploys all policies that are assigned to the node in OMi.

The result of both calls is that the agent is completely managed by OMi.

Summary and Command Overview: How to Move
Operations Agents to OMi Step by Step

This section contains the most important steps and command line calls used in moving operations agents
and their configuration to OMi.

1. Allow management from both servers using a flexible management template.
2. Choose a group or type of nodes to move over, for example, all Oracle Database systems.

a. Test policy and aspect deployment and tool execution from OMi on a representative node of that
type. This might include importing OM policies
ConfigExchange.bat -username <user> -check -policyfile c:\tmp\OMPolicies -logfile
c:\tmp\ompolicies.txt
ConfigExchange.bat|.sh -username <user> -uploadOM -i c:\tmp\OMPolicies
and creating OMi aspects and management templates.

b. After a successful test, roll out configuration to the remaining nodes of that type manually or by
using automatic assignment rules.
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c. Switch the primary manager and target server to OMi. This still allows configuration from both OMi

and OM servers

opr-agt -primmgr <node selection> -username <user>

3. Repeat steps 2-5 until all nodes are managed by OMi.

4. Before switching off the OM server, switch the agents to OMi completely

opr-agt -switch_manager <node selection> -username <user>

and clean up old OM policies if necessary

opr-agt -deploy -clean <node selection> -username <user>

Additional Information

Deployment of Policy Groups to Node Groups

OM customers deploy policies or policy groups to node groups. In a node-centric model, this is an easy way
to structure and control the deployment of policies. In OMi, as explained above, this model is replaced by a
Cl-centric deployment in order to benefit from all Cl-type related features (such as using CI attributes for
setting monitoring parameters and so on).

If you do not use these features, you can continue deploying policy groups (in the form of management
templates) to node groups (which are represented as Cl collections in OMi) as explained below.

How to Create and Maintain Node Groups/Cl Collections

Node groups or layout groups that exist in OM are forwarded to OMi as part of the OM topology
synchronization. Those node groups are converted into Cl Collection Cls. See How to Move Node Topology
to OMi/Topology Synchronization for more information.

Note: When OM will be discontinued, node group hierarchy will need to be maintained through other

mechanisms.

The easiest way to maintain node groups manually is by using the Monitored Nodes Admin Ul. You can
create node collections (Cl Collection Cls). You can add and remove nodes to/from these node collections.

| Setup > Monitored Nodes

Setup Event Automation

Event Correlation Operations Console

Monitoring

Node Views

IT Servers with HP Software products - Node Collections

Clx &R
= [ Predefined Node Fiters
5} 2l Nodes

[E} Monitored Nodes
LE'( Nodes with Operations Agent
B} unmonitored Nodes
[} Custom Node Fiters
= [ Mode Collections
El [ HPOM Hode Bank
[ Holdingérea
EEI IT Servers with HP Software products
[ Linux EMEA

G+~ X EmE kb

[ —
Primary DNS Name | U, 12 Node Callection

[ Hode Type

Operating System

g mambo3.mambo.net o v, um, onESCOEE
B mambon97.mambo.net OM
' mambongs.mambo.net  OM

| omkdb.mambo.net ol

Windows Windows Server 2008 R2 (6.1)

Windows Windows
Windows | Windows

= unix

LINUX Red Hat EL 5.X (2.6}

ClI collection > node membership relationships can also be created using the RTSM Admin Ul or RTSM
APls, but these require deeper knowledge of the RTSM.
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You can also automatically create ClI collection -> node membership relationships using enrichment rules.
See the RTSM documentation for more details.

How to Create Management Templates for Policy Group/Node Group-
Centric Deployment

You can assign an aspect to a Cl collection Cl, but it gets assigned to that Cl only, and not to all related node
Cls. However, you can use the management template mechanism as described below to achieve the
required behavior.

Create a new management template. For the topology view, select the view that contains the Cl Collection
CI Type and the membership relationship to Node or Computer Cls. If all your aspects are defined for the
Node Cl type or are marked as ‘node compatible’, you can use the OM CI Collection view. If you plan to
deploy aspects of the infrastructure management pack, create a similar pattern view using the Computer Cl
type, as the infrastructure aspects are defined for that Cl type.

Make sure that ClCollection is the CI type to which the management template will be assigned. Then assign
the aspects to the Node Cl type or Computer Cl type as required.

The following figure shows how to create a management template representing a policy group:

My Linux asoects: Create Management Template

v General Topology View
» Topology View Select a topology view that contains all the Cltypes that you want to manage with this management template. Then click the CI
Aspects type to which this management template can be assigned.
Parameters + Topology View: |];[ OM Cl Collections | - | |
@ @ IQ_ﬁ Layout: | Hierarchical | - |

# Cl Type: CiCollection [=]

For example, by using this method, you can create a “Linux management template” that contains all aspects
(policy templates) you want to deploy to the Linux node group. Create other management templates (policy
groups) for other node groups.

How to Deploy to a Node Group/Cl Collection

Once node groups and management templates are created, assign management templates as required using
the Management Templates & Aspects Ul or the Automatic Assignment Rules Ul.
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Manual Deployment

Select the management template (policy group) you want to deploy and choose Assign and Deploy Item

from the context menu.

Then select one or more node groups (Cl collections) to which you want to deploy:

Wy Linux “policy group” (1.0) - Assign and Deploy

» Configuration Item

Required Parameters
All Parameters

Configure Options

Configuration ltem

Assign and Deploy

e
Select the configuration tem to which you want to assign the management template or aspect,
Ci =y
Name Type
RSt Ttz -
IT Servers with HP Software products CiCollection
IT servers with HP SW products CiCollection
Linux CiCollection
Linux CiCollection
Linux EMEA CiCollection
Linux GER CiColiection
Linux UK CiCollection =
Lendon Hosts CiCollection
MCSG CiCollection
MoneyTransfer BusinessTransactionFlow
WS Hyper-V Host CiCollection
MS Windows CiCollection
MSCS CiCollection
NNI Managed Nodes CiColiection
Modes CiCollection
Modes managed by OM and MA CiCollection
NT 4 CiCollection
om_kb_script_2012 BusinessTransactionFlow
OpenVMS CiCollection -

Assignment Summary lists the resulting assignment to each node ClI:

‘Summary

Assignment and deployment jobs created
My Linux “policy group” -+ Linux (CiCollection)

File Security Menitoring mambon36 (Unix)

File Security Monitoring dummy (Unix)

CPU Performance: oracle42 (Unix)

General System Services Availability: dummy (Unix)
File Security Menitoring omkdb (Unix)

CPU Performance: omi-db (Unix)

General System Services Availabilty. oracle42 (Unix)
General System Services Availabilty: oml-db (Unix)
CPU Performance: dummy (Unix)

File Security Menitoring linuxtest (Unix)

CPU Performance: mambon96 (Unix)

CPU Performance: shr(Unix)

File Security Menitoring mambon9&. mambe.net (Unix)
General System Services Availability:  shr (Unix)
General System Services Availability. linuxtest (Unix)
File Security Menitoring oracle42 (Unix)

File Security Monitoring shr (Unix)

CPU Performance: mambon%&.mambo.net (Unix)

General System Services Availabiity. mambon96 (Unix)
CPU Performance: linuxtest (Unix)

Assignment and deployment jobs created

My Linux "policy group” -= Linux EMEA (CiCollection)

Assignment and deployment jobs created
My Linux "policy group” -= Linux GER (CiCollection}

General System Services Availability: mambon98.mambo.net (Unix)

HPE Operations Manager i (10.10)

Page 106 of 196



OMi Evolution Guide

Chapter 5: Managing Operations Agents from OMi Step by Step

The Assignment and CI configuration reports show the management template/policy group assignment:

Management Template Assignment Report

P

The report shows to which Cls a selected Management Template is assigned.

« [2 MT Information

MT Label: My Linux "policy group”
MT ID: 66c0ab87-068a-1571-85a0-44fe715a24b5

~ @ Linux, Type: CiCollection

P Assignment Details

¥ Target Cl: Computer
@ mambongs

[ 1] D [ Parameter Name Parameter Value

Default Value

File Security Monitoring. Version: 1.4

CPU Performance. Version 1.0

General System Services Availability. Version: 1.0

@ dumm

| | ‘ D | Parameter Name Parameter Value

Default Value

File Security Monitoring. Version 1.4

General System Services Availability. Version: 1.0
CPU Performance. Version 1.0

@) oracle42

|1 D | Parameter Name | Parameter value

Default Value

CPU Performance. Version: 1.0

General System Services Availability Version' 1.0
File Security Monitoring. Version: 1.4

Cl Configuration Report

n

The report shows how a Cl is monitored.

+ @ Cl Information

ClName: linuxtest
Cl Type:  Unix
ClD: 218cce5cbibbsic0e50a8babb0bT7 772

&) CPU Performance, Version: 1.0

¥ Assignment Details

Aspect D2 ba111913-9134-f66c-c37e-1a69673d678C
Cl Types: Computer
Enabled: True

Directly Assigned: False

Parent(s): My Linux "policy group” (1.0
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Automatic Deployment

Using a corresponding “Linux node groups” view, you can also automatically assign such management
templates using automatic assignment rules. Create a pattern view with the CI Collection CI type and
membership relationship and query node properties that select one or more specific node groups:

[ QueryNode properies Ll

@ Query Node Properties
= Enab;

nables you to add attributes, cardinality, quaiifiers and C1 specific conditions

Element name: Element type:

[cicoecton | [cicosecton ¥| ¥ showeiement in query resute
‘Attribute]| Cardinaity | Element Type|| Flement Layout | dentit
+ X i<}
NOT | ( Criteria ) And/Or
] Name Like ignore case "S6Linux%"
(|
il
(|
Attrbute name Operator: Parameterzed:  Value:
[ Name - (string) [¥] [Licionorecase(Uses) |v| OvYes@®nNe [ binux ]
NodeBank LinuxEMEA (1)
NodeBank LinxEMEALinwxGermany (1)

ke LinuxEMEALinuxUK (1)
Openview_Linux (1)

Virtual_Linux (1) [ ox |l Cancel | | Hep |

The resulting view contains only Linux node groups and nodes. This view can then be used in automatic
assignment rules to deploy the Linux management template to Linux node groups.

Scheduled Deployment

By default, manual and automatic assignments trigger an immediate deployment of the corresponding
policies. If you plan the deployment at a later time (for example, during non-office hours), you can achieve this
by setting the Create suspended deployment jobs infrastructure setting and using the opr-jobs tool to start
the deployment jobs. See the Administration Guide > Monitoring > Command-Line Interfaces > The
oprjobs Command-Line Interface and the Administration Guide > Monitoring > Deployment Jobs for
more details.

OMi Policy Limitations and Corresponding Workarounds

Limitations compared to OM for Windows:

« WMI policy editor: no WMI browser available.
Workaround: Use WMI browsing tools available from Microsoft. For more information, see
http://technet.microsoft.com/en-us/library/cc181099.aspx.

« Measurement Threshold Policy editor: no data source browsing of WMI metrics, Windows Performance
Counters, or metrics of the embedded performance component (coda).
Workaround: Use WMI tools as mentioned above for WMI and the built-in Performance Monitor of
Windows (perfmon.exe) to connect to performance counters of another computer. To browse the metrics
of the embedded performance component, use the OMi Performance Perspective.

« Measurement Threshold policy does not support the “Show only newest message in message browser”
feature.
Workaround: If needed, set MsgKey and MsgKeyRelation manually using the following pattern:
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MsgKey: <$NAME>:<$MSG_NODE_NAME>:<$MSG_OBIECT>:START<$THRESHOLD>

MsgKeyRelation: <$NAME>:<$MSG_NODE_NAME>:<$MSG_OBIECT>:<*>

Limitations compared to OM for UNIX and Linux:

« Search/edit/replace/undo options are not available in the RAW Mode Policy Editor.
Workaround: Copy a complete policy to the external editor that supports these operations.

Limitations compared to OM for UNIX and Linux and OM for Windows:

« When using patterns for event correlation (inside the Close Events with Key field of a policy template),
there is a difference between the pattemns that can be used in OM and OMi. Currently, OMi does not
support using range patterns (using -1t, -gt, and so on) and always performs a case-sensitive
comparison. If OM policies use range patterns or a case-insensitive check, syntax check used before

uploading the policies reports a warning.

« Test Pattern functionality (and opcpat(1) CLI) is not available in Logfile Entry and Windows Event Log

Templates.

« Event Browser: Select Message -> Edit condition/policy is not supported in OMi.

Event-Related Actions

In OM, administrators can define automatic and operator-initiated actions inside a policy. Those actions,
when executed on nodes with an HPE Operations Agent, can be used by operators to collect more
information about the specific problem or even solve it. These event-related actions exist in OMi as well.

However, there are four types of event-related actions that cannot be launched from an OMi console:

« Actions using $GRAPH
« Actions launched on $0PC_MGMTSV

« Actions launched on $0PC_GUI_CLIENT
« Actions launched on $0PC_GUI_CLIENT WEB

1) Performance Graphs for CI mambon95 [Windows] - Mozilla Firefox [_ O[]

(@

ONTEXT: CTI

WVCILIST=false 8SHOWGRAPHLIST =false 8ALL OWDESIGN =TRUE AL LOWEXPORTPDF =TRUESDEFAULT_WIN |

]| | Graphs | Metrics
g & S

£ @ virtual Infrastructure:
[ Host

E1 [ Systems Infrastructure.
i Configuration Details
] Process Details
(71 CPU Gauges
25 CPU Utiization Baseline
i CPU Summary
Disk Summary
Global CPU Forecast
F Global Details
[2] Global Histary
2 Global Run Queue Bass

Memory Summary
& Network Summary

&3 System Configuration
fEcru
[ isk
[@ Network Interface.
[ Fie System
B & new
EH sis mem

eline

Muttiple Global Forecasts.

Seasona | CPU Forecast

« ERL&

¥ Toolips

¥ Date Range Panel
Navigation Panel
Close AllGraphs
Help

0i13)

Tue (10/1113)

B AR & dal”

Last [ Range [ Dz

Wed (10/2/13) Thur (10/213) Fri(10/8113) Sat (10/8/13)

Start Time: 10/3/13 16:29:17  End Time:  10/4/13 16:29:17

Global Histery for mambong5

BT =R

JVUL’LLL‘J".‘VI" [

) e 8
200

100

20
Virtualization Configuration Details for.

=k

[ LockCobmn g2 G 5 £ 9

TIME

100413 16:29:17

GBL_LS ROLE
GBL_LS TYPE
GBL_NUM_CPU
GBL_NUM_LS
GBL_OSNAME
GBL_DSRELEASE
GBL_OSVERSION
GBL_SYSTEW_ID

Guest
Viware

2

0

NT
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SvePk
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The actions that use these variables are filtered out by OMi and not displayed. It is also not possible to define
those actions in OMi policy template editors.

OMi Solutions for SOPC_MGMTSV Actions

Instead of executing an action on the management server using the HPE Operations Agent, you can execute
an action on the management server using an EPI script when a certain event arrives. EPI groovy scripts are
executed on the OMi gateway server that receives the event. EPI scripts have full access to all event
properties and can be used for different purposes. Consider this option for actions relevant for many events
(for example to log certain events, to enrich events, and so on).

If the action call is very event-specific (every policy condition defines another action) and uses varying
parameters extracted from the event source, you may consider to continue using event related actions. This
is less error-prone because everything is configured in one location, namely the policy, and not across
multiple Uls. In this case, we recommend that you introduce an “OMi server” policy parameter instead of
using the $OPC_MGMTSV variable. This parameter can then be set to the OMi data processing server name
(or the OMi load balancer name, depending on your requirements where the tool needs to be executed) inside
a management template.

OM i Solution for SGRAPH Actions

Actions using $GRAPH launch predefined performance graphs and can even pre-define the displayed time
range so that the time when the problem occurred is shown. In OMi, graphs can be launched using the event
context menu (show Performance Graphs (Cl)) which automatically shows all default graphs for the selected
CI. From there, you can easily select additional graphs and use the Date Range Panel to navigate to the time
when the problem occurred.

OMi Solution for SOPC_GUI_CLIENT_WEB Actions

Instead of specifying the URL in the action, you can specify it in the instructions of the event.

OMi Solution for SOPC_GUI_CLIENT Actions

The OMi web-based user interface runs within a web browser that does not allow calling external programs
due to security reasons. As an alternative, such actions (including the parameters) can be mentioned in the
instructions. The user can copy and paste the command line into a command prompt on the client OS.

Policy Types

OMi supports the following policy template types:

« ArcSight Logger

« ConfigFile

« Flexible Management (agent-based)
« Logfile Entry

« Measurement Threshold

Note: Script parameters are automatically converted into MA parameters.

« Node Info

HPE Operations Manageri (10.10) Page 110 of 196



OMi Evolution Guide
Chapter 5: Managing Operations Agents from OMi Step by Step

o Open Message Interface

« Scheduled Task

« Service Auto-Discovery

« Service/Process Monitoring

« SiteScope Templates

o SNMP Interceptor

« Windows Event Log

« Windows Management Interface
« XML File

Not supported are:

o OM for UNIX v.8x templates

« SiteScope policy type exported from OM -> import directly from SiteScope

« ECS (Event correlation, event composer) -> TBEC, SBEC, EPI

« RAS (Remote action security)

« Server-based MSI| -> EPI

« Server-based Flexible Management -> Connected servers and forwarding rules
« Custom policy types (OM for UNIX and Linux)

Conversion of Trouble-Ticket and Notification Flags

Policies that set the Forward to trouble ticket or Forward to notification server flag can be imported and
reused without modification.

The flags are kept in the policy data and can be edited in RAW mode. When an event with those flags arrives
in OMi, those flags are automatically converted into custom attributes ForwardToTroubleTicket = true and
NotifyUser = true.

These custom attributes can then be checked in the event filters of OMi forwarding or notification rules
(Administration > Event Processing > Automation > Forwarding and Administration > Event
processing > Automation > Notifications) to forward events automatically as on OM.

How to Deploy Custom Instrumentation (OM for UNIX and
Linux)

OM for UNIX and Linux v.9x introduces instrumentation categories and allows to group instrumentation files
into such categories. When a policy is imported into OMi, the referenced instrumentation category is
automatically imported as well and is automatically deployed when the policy template is deployed.

Additional instrumentation files stored under /var/opt/0V/share/databases/OpC/mgd_node/customer are
imported automatically as well, but stored under a new category OMU_customer_data. Add this
instrumentation category to policy templates or aspects that need the instrumentation. To save time, you can
add the instrumentation category on the aspect level.

Note: If you deploy individual policies for testing purposes, this will not trigger instrumentation
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deployment.

How to Edit Already Uploaded Instrumentation Files

During the policy export and import, all assigned instrumentation categories are exported and imported on the
OMi side. When a second policy import refers to the same instrumentation categories, the instrumentation is
not uploaded again.

To update the instrumentation files on the OMi side, either during the migration because the instrumentation
files have changed on the OM side in the meantime, or after the migration, proceed as follows:

Download the current instrumentation (including all patches and hotfixes) available in OMi.
For example, to download the category Database, use:

/opt/HP/BSM/opr/bin/ConfigExchange.sh -user <username> -password <password> -merge
-output /tmp/Database -instrumname Database

Make the necessary changes to the instrumentation files in the downloaded directory /tmp/Database.
2. Upload the instrumentation files using the -force option:

/opt/HP/BSM/opr/bin/ConfigExchange.sh -user <username> -password <password> -upload
-input /tmp/Database -instrumname Database -force
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Overview

SiteScope is an agentless monitoring solution that enables you to remotely monitor the availability and
performance of your IT infrastructure (for example, servers, operating systems, network devices, network
services, applications, and application components). OMi allows you to combine agent-based monitoring with
Operations Agents and agentless monitoring with SiteScope.

You can use templates in SiteScope to create sets of monitors that you want to deploy together. When you
add a monitor to a template, you can specify fixed values for the monitor settings. In addition, you can add
variables to a template so that you can set the values of some settings when you deploy the template.

For example, you have a template that contains the monitors called CPU and Memory. You can configure
fixed settings that you always want to use for those monitors, but add variables called Remote Host and
Monitoring Interval, for the settings that you want to modify each time you deploy the template.

Those SiteScope templates can now be imported into OMi, be grouped into aspects, included in management
templates and assigned manually or automatically by OMi. As with agent-based monitoring, this allows you to
standardize and automate the monitoring configuration and automatically respond to changes in your IT
environment.

The parameters in OMi offer the additional benefit that you can use ClI attributes to set SiteScope Template
parameters. You can also pre-define certain parameter sets in different management templates, which are
then assigned to different Cls.

The most important advantage, however, is that you hide the underlying monitoring technology in the aspects
and management templates: assigning an aspect does not require in-depth know-how of SiteScope. You can
also combine SiteScope policy templates with other agent-based policy templates.

SiteScope Deployment from OM and OMi: Functionality
Comparison

Functionality OMi OM for UNIX

Deploy monitors, = Yes. Yes.

groups, and

remote servers

Automated Yes. Can be scripted using OM for
deployment UNIX ClLls.

Automated Yes. If the Cl is no longer part of the view (for Can be scripted using OM for
lifecycle example, the monitored business application), UNIX ClLls.

monitoring then monitoring is automatically removed.
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Deployment
workflow

Undeployment
workflow

Deployment
flexibility across
multiple
SiteScope
servers

Agent-based and
agentless
monitoring
configuration

SiteScope
template
handling

Parameterization

Template
versioning

Assignment
management

Cl-centric
deployment

Cls must bein
the RTSM before
use

Assign and deploy configuration starting from a Cl
or a policy template, aspect, or management
template.

Can delete an assignment that removes the
monitor(s).

Default behavior is to deploy monitors to the
SiteScope server with most free points.
Alternatively, you can configure OMi to decide
according to other criteria, such as the IP address
or domain name of the monitored target via Groovy
script.

Yes.

Create/modify templates in SiteScope. Import
templates to OMi manually.

Pre-populate parameters with Cl attribute values
or manually enter values

OMi stores multiple template versions, allowing
one chosen version to be deployed at a time.

SiteScope templates are the lowest granularity of
monitoring elements. They can be grouped with
other policy templates into aspects or
management templates to manage assignments
at a macro level, which is important for large-scale
deployments.

You can combine parameters that are the same
across templates so that you are prompted for
each value only once.

Yes.

Yes.

HPE Operations Manageri (10.10)

Assign and deploy SiteScope
policy.

Unassign and undeploy the
SiteScope policy.

Deploy SiteScope policy to a
selected SiteScope server. Can
also assign policy to a virtual node
(target system) where SiteScope
is the physical node.

Yes.

Create/modify templates in
SiteScope. Import templates to
OM for UNIX manually.

Edit the policy to set or change
parameters. Supports special
variables: HOST, NODEGROUP, and
FILE

OM for UNIX stores multiple
template versions, allowing one
chosen version to be deployed at
atime.

Assign SiteScope policies or
policy groups to the SiteScope
node.

Node-centric.

SiteScope server must be a
managed node. Target nodes do
not have to be in the Node Bank
but an external node is required to
allow events through.
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Leverage RTSM
node credentials

Validate points
required and
available prior to
deployment

Control
SiteScope
monitor group
structure

Deployment
status

Assignment
report

No. Can create templates that use SiteScope
Credential Preferences.

No.

Parent monitor group is hard-coded to “Deployed
from Operations Manager” with subgroup named
as gwserver.fqdn.

The Deployment Jobs screen shows pending and
failed deployments, where you can view the error
and restart the deployment job.

Review <OvDataDir>/log/system.@.en_US on
the SiteScope server to see what happens on the
SiteScope side.

From Setup > Connected Servers, select a
SiteScope server and click Launch SiteScope
Report. This generates a report of the Cls
monitored by SiteScope via OMi, along with the
list of templates for each CI.

N/A. Can create templates that
use SiteScope Credential
Preferences.

No.

Parent monitor group is hard-
coded to “Deployed from
Operations Manager” with
subgroup named as
OVO:omserver.fqdn.

OM for UNIX generates a
message on success and on
failure to deploy policies.

Review
<OvDataDir>/log/system.0.en_
US on SiteScope server to view
what happens on the SiteScope
side.

The OM for UNIX server shows
the SiteScope policies assigned
to the SiteScope server.

Moving SiteScope Monitor Deployment from OM for UNIX

to OMi

If you currently use OM for UNIX to deploy SiteScope monitors, there are two possible approaches to moving
the configuration to OMi:

« Import SiteScope templates directly from SiteScope to OMi using the ConfigExchangeSIS[.bat|.sh]

command.

« Import OM for UNIX SiteScope policies to OMi using the ConfigExchange[ .bat|.sh] command.

The best option is to perform an import directly from SiteScope. The reason is that OM for UNIX supports
special variable values that are not used in OMi. Since you cannot edit the policy within OMi, you cannot
make use of those imported policies. OM for UNIX allows the use of %%H0ST%%, %%NODEGROUP : <nodegroup_
name>%%, %%FILE : <file>%%and %%FILE:<file>.$SISHOST%%.

Configuring Multiple SiteScope Servers

OMi can configure multiple SiteScope servers. Prepare all SiteScope servers as described below.
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By default, OMi instantiates monitors on the SiteScope server that has the most available license points. It is
also possible to choose a SiteScope server using other attributes, such as the hostname or IP addresses of
the monitor target. See the Administration Guide > Setup and Maintenance > Connected Servers >
How to Create a Connection to a SiteScope Server for more details.

Example proxy deployment scripts are available under <OMi_HOME>/opr/examples/deployment-server-
selection.

Steps for Configuring SiteScope

Preparing SiteScope

Before you can configure the monitoring with SiteScope, you must complete the following steps:

1. Install and configure the agent on the SiteScope system.
2. Set up the SiteScope system as a connected server.

See the Administration Guide > Monitoring > Policy Templates > Importing SiteScope Templates for
more details.

Adjusting Templates in SiteScope

SiteScope templates contain information about the remote servers or applications that they monitor. This
information is usually stored in a variable that is replaced by the list of remote servers or application instances
when the template is deployed.

When importing a SiteScope template, the import tool must be able to identify the variable that contains the
instance information in order to create a corresponding instance parameter in the resulting policy template.
The import tool chooses one the following SiteScope variables, in the order described below, to create the
instance parameter:

« The variable with the display order number 0 in the SiteScope template.
« The variable named "host" in the SiteScope template.

Note: If the variable "host" exists in a SiteScope template but does not have a value, the value will be
set to %%H0ST%% during the template import.

« The variable with the value %%H0ST%% in the SiteScope template.

If none of the above variables exist or if the wrong variable would be used as instance parameter, adjust the
SiteScope template in SiteScope. In most cases, the easiest way to do this is to change the display order
number in the SiteScope template.

Note: System variables starting with $$ (such as $$SERVER_DISPLAY_ NAME$$) are not converted and
need to be replaced with %%H0ST%% before importing the template.

E:. Linux Host
Linux montors for $SERVER_DISPLAY _NAMESE
_ﬁ CPU Lkilization on $$SERVER_DISPLAY _NAMESS
__'d Filesystem Status on $$SERVER_DISPLAY _MAMETE
__'d Linux Resource meonitor on $$SERVER_DISPLAY _MAMETS
__'d Memory Litilization on $$SERVER_DISPLAY _MAMESE
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2] Linux Host
Linux monitors for %a%host%%
EH [cPU Utilization on %%host%% |
@ Filesystem Status on %e%host%%
@ Linux Resource monitor on %%host%%
@ Memory Liilization on %e%host%%
£l host

To simplify the import, copy all templates that need to be imported into one template group.

Importing SiteScope Templates into OMi

On the OMi server, open a command prompt and run the ConfigExchangeSIS command-line interface to
import templates from a SiteScope server.

For example, the following command loads the templates that are in the template container called "Template
Examples" from sitescope1.example.com:

c:\HPBSM\opr\bin\ConfigExchangeSIS.bat -sis_group_container "Template Examples”
-sis_hostname sitescopel.example.com -sis_user integrationViewer -sis_passwd
password -bsm_hostname bsml.example.com -bsm_user admin -bsm_passwd password
-bsm_port 80

For more information on importing SiteScope templates, see the Administration Guide > Monitoring >
Command-Line Interfaces > ConfigExchangeSIS Command-Line Interface.

Grouping Policy Templates into Aspects

After templates are imported, they need to be grouped into meaningful aspects. An aspect is defined fora
specific Cl Type and contains all policies required to monitor a certain aspect of the Cl, for example its
performance or availability.

Go to Administration > Monitoring > Management Templates & Aspects. Create a suitable
configuration folder and add aspects there. When creating an aspect, enter its name, specify the Cl Type and
select the corresponding policy templates.

| Monitoring = Management Templates & Aspects

Setup Event Automation Ewvent Correlation Operations Console Monitoring |_

Policy Templates

A00 polcy tTemplates 1o the aspect ouU Can adtd exISlng polcy Temp

-| Add Policy Template to Aspect

Name
Policy Templates

=
Parameters i
Na

E

E

f Apache/Tomcat Log Cellection from Linux_1.0

f_I.—! Audit Log Collection from Linux
[# CrClusterDataCollector

{e}) C-ClusterDiscovery

fi crLcusterMonitor

< Apache/Tomcat Log Collection from Linux

0 D)

]
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Set Parameter Values Using Cl Attributes

In this step, make sure that the instance parameter value is either %%H0ST%% (which will be automatically
replaced by the corresponding host node name) or that the value is set using a Cl attribute that represents the
instance. For example, if the SiteScope template is targeted to monitor Oracle instances, the instance
parameter will be the Oracle Instance Name. The corresponding Oracle aspect will be defined for the Oracle
Cl Type and a single Oracle ClI will represent an Oracle instance. When defining the aspect, you can use the
available information in the RTSM, which already contains the instance name, to set the instance parameter
value as shown in the following figure:

General Cl Type Instrumentation Aspects Policy Templates Parameters

Combine or edit parameters. “ou can combine similar parameters, and set or override default parameter values.
Qidill B o
1 C | Ul.. | Name Default Value
v 0 Cracle Instance Name Ci Attribute: name
- =11 Oracle Database Host Name
=-| = |2 Oracle Instance User Name
- =13 Oracle Instance Password i
== |4 Oracle Instance Port Number Ci Attribute: application_port
-|=15 Oracle Database Availability Freguency 300

You can use other Cl attributes, such as application_port, to set other parameters, but you need to make
sure that these attributes are filled by your discovery process.

Optional (Recommended): Create Management Templates to Group
Aspects

Creating management templates is optional but recommended. Management templates simplify the
assignment of many aspects thus allowing to monitor composite applications with a single assignment. To
use management templates, the Monitoring Automation for Composite Applications license is required.

To simplify the assignment of multiple aspects, it is recommended to create one or several management
templates after all aspects are created. For example, you can create several management templates with
different aspects, representing, for example, Essential and Extensive monitoring levels.

Go to Administration > Monitoring > Management Templates & Aspects. Create a configuration folder
and add there management templates. Enter the management template name, specify a view and root Cl
Type, and select the corresponding aspects. If you use the management template for grouping aspects
belonging to one CI Type, you can select any view that contains this Cl Type. The view is used as a starting
point for the management template definition. As an alternative, you can also use nested aspects (group
several aspects into a new aspect).

To start monitoring multiple related Cls of various Cl types using one single assignment, you need to create a
management template. As this is not possible using nested aspects, you need to create/select the view that
shows all Cl Types and their relations as a starting point for the management template. See the
Administration Guide > Monitoring > Management Templates & Aspects > Configuring
Management Templates for more details.
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Testing Configuration

Once you created the aspects and management templates, use the manual assignments to test and verify
configuration.

You can assign management templates and aspects from Administration > Monitoring > Management
Templates & Aspects (with the aspect/management template as a starting point) or Administration >
Monitoring > Assignments & Tuning (with the Cl as a starting point).

The assignment will by default initiate an immediate deployment of all included policy templates to the
corresponding nodes.

You can verify on the SiteScope Server whether the corresponding monitors have been deployed.

Roll Out Configuration

Once the configuration is validated, you can rollout the configuration to more systems, either manually (if
there is only limited change in the environment) or automatically using web-services or automatic assignment
rules.

See Roll Out Configuration in the Manage Operations Agents from OMi Step by Step chapter for more details.
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Overview

Operations Bridge Reporter (OBR) is a cross-domain performance reporting product. It collects end-user
performance metrics from Application Management and infrastructure utilization details from System
Management products to provide integrated reports on service and application performance. In order to do
this, OBR leverages service topology definitions from the OMi RTSM.

OBR is designed to support pluggable content. Content packs are delivered as modules that can be deployed
to an existing OBR instance thus allowing users to tailor their OBR instances to meet their reporting needs.
Based on the content deployed, an OBR instance may be used for specific domain reporting needs, such as
providing System Management reports.

A Content Development Environment (CDE) enables customers and partners to develop the content for
OBR. The development process involves creating metadata artifacts that generate the content. OBR bundles
Business Objects for all its enterprise reporting needs.

HPE Reporter and OBR Reports Comparison

Check the Operations Bridge Reporter Content Catalog available on the HPE Live Network Content
Marketplace (https://hpln.hpe.com/node/8902/contentfiles) for up-to-date information about available OBR
content packs.

The following table shows the comparison of HPE Reporter and OBR Standard Edition reports:

Available in OBR SE

Domain Report Pack in HPE Reporter (as of August 2014)
System System Yes
Virtualization Yes
OM SPIs Oracle, MSSQL Yes
Sybase, Informix Content in BO Universe*
WLS, WBS Yes
SAP No
Exchange/AD Yes
Lync, SP, BizTalk No
Tibco No
Event oM Yes
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Partner SPIs = NICE: Blackberry, PeopleSoft, DB2

No

Comtrade: CITRIX, Siebel, EMC Documentum No

*no out-of-the-box reports available, but data is collected in BO Universe

In addition to the report packs mentioned above, OBR contains additional reports packs (called content packs
for OBR) for OMi events, His, and KPIs and collects metric data for OAS and JBOSS.

HPE Reporter and OBR Feature Comparison

Reporter Functionality

Report scheduling

Data summarization

Report customization via Crystal Designer
Custom Groups

Time Shift support

Scalability, 2000 nodes per instance
Support external DB (Oracle, MSSQL)

PA collector

Data Access Layer (DAL)—-SQL

Custom extension

OOTB Process and Logical Volume reports

Viewing Reports from the OM for Windows
console

Collection from multiple OM servers
High Availability (Microsoft Cluster support)

AutoGrouping based on PA configuration metrics

Ul for configuring collections (a collection can be
configured per group of nodes or single nodes,
that is more metrics from group of critical server
(s) and fewer metrics from less-critical servers).

Agent metrics collected at 1-hour granularity with
daily frequency.

HPE Operations Manageri (10.10)

Equivalent in OBR

Yes

Yes

Yes, using Business Objects
CMDB Views + Node Groups + user-defined
Yes

20.000 nodes per instance
No - OBR embeds Sybase |Q
Yes

DAL-SQL, BOSDK

CDE

No

OBR reports can be integrated into My Workspace,
which allows automatic display of report in context of a
Cl. Itis also possible to set up an OMi URL tool that
launches an OBR report in context of a Cl on demand.

Yes
Veritas HA Cluster

Auto-grouping based on OM node groups and/or RTSM
views.

All collections are at 5-minute granularity with hourly
frequency. Nodes collection can be enabled/disabled.

Agent metrics collected at 5-minute granularity with
hourly frequency.
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Report output formats: html, PDF, Excel, Word = Web intelligence (web page), PDF, Excel, CSV

Can also send to email, FTP site, and folder.

Operations Agent nodes populated by discovery | Topology source is either OM or the RTSM.
in user-defined Windows Domain, by manually

adding systems, or by OM discovery. (Special standalone cases exist for VMware-only and

for NPS-only scenarios.)

Login security: by default, none. Canimplement = Uses Business Objects login security and
your own web server security. authorization mechanism

How to Establish Reporting Using OBR

Install OBR

OBR can be installed in multiple deployment modes based on the target environment. See the OBR
Installation Guide to determine the deployment architecture suitable for your environment
(https://softwaresupport.hp.com/group/softwaresupport/search-result?keyword=).

Install Available Content Packs

OBR ships with arich set of content packs. In addition, partners and other HPE product teams may create
content. These content packs are available for download from the HPE Live Network Content Marketplace
site. HPE Live Network Content Marketplace is also the vehicle for releasing off-product cycle content and
content upgrades. Depending on your license, you may be entitled to download and deploy these content
packs to an existing OBR instance. Visit https://hpln.hpe.com/group/service-health-reporter for more
information.

Configure Collections

OBR supports the notion of Remote Collectors. These collectors enable collection of performance metrics
from OM agents and other sources from behind a firewall (providing a secure and distributed collection). For
more details, see the OBR Installation and Administration guides
(https://softwaresupport.hp.com/group/softwaresupport/search-result ?keyword=).

Re-Define Custom Shifts

OBR allows users to create time shifts. These shifts are used to summarize and create shift-specific reports.
Shifts are defined via the OBR Administration GUI. See the OMi Help topics of the Administration GUI for
more details.
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Re-Define Custom Groups

OBR interprets RTSM views as groups that may be used in reports. These views serve to group
Configuration Items in reports. Similarly, node groups are supported in OM deployments. OBR also enables
users to create their own custom groups. These groups are on part with RTSM views or node groups. See the
OMi Help topics of the Administration GUI for more details

Use ootb Reports

OBR ships more than 120 out-of-box reports. See the Handbook of Reports for details
(https://softwaresupport.hp.com/group/softwaresupport/search-result?keyword=).

Additional Tasks

How to Re-Create Custom Reports Using BO

OBR bundles Business Objects 3.1 (BO) for all its Bl requirements. BO provides a browser-based editor to
create and edit reports. The data collected, cleansed and aggregated by OBR is stored in Sybase 1Q Column
DB and is exposed via BO Universe. Each content pack ships with a Universe, which can be used to create
reports. To learn more on BO and its usage in OBR, see the following blogs/video at
http://community.hpe.com/t5/Business-Service-Management/Jumpstart-report-customizations-using-report-
templates-in-HP/ba-p/6308707.

How to Integrate Custom Metrics into OBR Reports

OBR ships with a Content toolkit (CDE) used to build content for OBR. This toolkit accepts metadata input
and generates various content pack artifacts, such as collection policies, DB schema, aggregate procedures,
and BO Universe. The CDE may also be used to enhance the existing content. See the CDE Guide for
details (https://softwaresupport.hp.com/group/softwaresupport/search-result?keyword=).

How to Use Reporter as Gatherer

To simplify the move to OBR, it is possible to continue to use HPE Reporter as data gatherer for some time.
OBR can retrieve data from HPE Reporter and combine it with the data from OMi. The OBR generic
Database Collector is used to connect to the HPE Reporter DB and gather collected metrics. This can be
used to start the Reporter migration projects. However, it is advisable to migrate to the more efficient and
extensible OBR collection framework. See the migration toolkit for more details.

Move Agent Collection to OBR

To switch off Reporter, move the agent data collection to the OBR collection framework. A prerequisite for
that is to have all agents managed by OMi and discovered and modeled in the OMi RTSM instance. Once all
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agents are available as Cls in the RTSM, OBR connects to the RTSM, builds a list of available agents, and
schedules periodic collection. The agents in the RTSM have a new CIID, which is now used to identify them.
To link the older agent-based IDs in OBR to the new RTSM ClIDs, you can use Data Warehouse Lifecycle
tools. See the migration toolkit for more details.

How to Switch the Topology Source from OM to OMi

If you are already using OBR with OM as a topology source, you need to switch to OMi as a topology source.
OBR uses agent-based IDs in the OM deployment. These IDs are distinct from OMi RTSM-based CIIDs. To
successfully migrate OBR from the OM deployment to the OMi deployment, you need to map older agent-
based IDs to their corresponding OMi-based CIIDs. See https://hpin.hpe.com/blog/shr-om-bsm-migration-
tool-taking-shr-deployment-om-bsm-topology-scenario-%E2%80%A6 for more details.

HPE Operations Manageri (10.10) Page 124 of 196


https://hpln.hpe.com/blog/shr-om-bsm-migration-tool-taking-shr-deployment-om-bsm-topology-scenario-�
https://hpln.hpe.com/blog/shr-om-bsm-migration-tool-taking-shr-deployment-om-bsm-topology-scenario-�

Chapter 8: Switching Off OM and Reporter

Preparing to Switch Off OM

Switching All Operations Agents to OMi

If not already done, switch all Operations Agents to OMi. See Complete Switch of an Agent for details.

Removing the Flexible Management Template from Nodes

On the OM server from which you deployed the flexible management template, undeploy the template from all
nodes.

If the OM server is no longer available, you can delete the flexible management template from OMi using the
opr-agt -deploy -clean option. This deletes all old OM policies.

Switching Off Topology and Event Forwarding / Shutting
Down OM

You can shut down OM completely. If you want to keep OM running but disconnected from your OMi
environment, execute the following steps:

1. Onthe OM server, undeploy the server-based forwarding policy (which was created when you connected
OM to OMi).

2. Remove the OMi server from the topology server configuration.
o OM for Windows:

i. Inthe console tree, right-click Operations Manager, and then click Configure > Server. The
Server Configuration dialog box opens.

ii. Click Namespaces, and then click Discovery Server. A list of values appears.

iii. Remove the hostname of the OMi server from the list of target servers.

o OM for UNIX and Linux: Run /opt/0V/contrib/OpC/enableToposync.sh -stop to stop all
topology forwarding.

Switching Agent Licenses to OMi

Toreuse the OS instance licenses previously used on OM, you can import the same license keys in OMi. You
can do this for the following licenses:
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BB165ZAE, BB165ZA, TB672AAE, TB672AA, TB673AAE, TB673AA, TB674AAE, TB674AA, BB196ZAE,
BB196ZA, TA124AAE, TA124AA, TBOSGAAE, TBOSGAA, TBOGOAAE, TBO6OAA, TBOSSBAAE, TBOSSAA,
TBO75AAE, TB975AA, TBOS7AAE, TBO57AA, TBO73AAE, TB973AA, TD768AAE, TD769AAE, TD770AAE,
TD771AAE, TD772AAE, TD779AAE, TD780AAE, TD781AAE, TD782AAE, TD783AAE, TD773AAE,
TD774AAE, TD775AAE, TD776AAE, TD778AAE, TD136AAE, TD136AAE, TD138AAE, TD138AAE,
TD137AAE, TD137AAE, TB917AAE, TB918AAE, TB919AAE, TB920AAE, TB921AAE, TB932AAE,
TB934AAE, TBO935AAE, TBI36AAE, TBO37AAE, TBO38AAE, TBO39AAE, TBO45AAE, TBOGOAAE,
TBIO71AAE, TJ721AAE, TJ722AAE, TJ723AAE, TJ724AAE, TJ738AAE, TJ739AAE, TJ740AAE,
TJ741AAE.

Other licenses need to be migrated into new licenses. Contact your HPE account team or partner to request
the license migration.

Disabling/Deleting Connected Server in OMi

In OMi, go to Administration > Setup and Maintenance > Connected Servers and disable or delete the
connected server for your OM system.

Event Synchronization / Tool Execution after the Switch Off

Shortly after the switch off, you might still have active events in the OMi Event Browser that have the original
OM server as the originating server. When changing events, OMi will still try to synchronize changes to the
originating server and the synchronization details will be shown on the Forwarding tab of Event Details.
Synchronization problems can be safely ignored. After a few hours, OMi will stop synchronization attempts
automatically.

As soon as the OM connected server is disabled or deleted, OMi will no longer route tool executions via the
OM server, but execute the tool by contacting the agent directly.

Destroying OM Certificate Authority Private Key

To make sure that agent certificates using the old OM certificate authority (which is still trusted by OMi) can
no longer be issued, delete the CA certificate from the OM server that is no longer in use and make sure that
all CA certificate copies including the private key (previously exported via ovcm -exportcacert) are
destroyed.

Switching Off Reporter

Before decommissioning HPE Reporter, verify that HPE Operations Bridge Reporter has taken over the
following tasks of HPE Reporter:

« Collecting the required metrics from the HPE Operations Agents and any OM server(s) that are not being
decommissioned

« Producing the required reports
« Email integration is configured, if required

If any HPE Reporter web pages are linked into another application, for example a custom portal, update the
application to remove references to HPE Reporter.
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If HPE Reporter is integrated to an OM for Windows server that is not being decommissioned, remove the
integration from the OM for Windows server. The integration is configured under Configure > Server > HP
Reporter Integration.

If HPE Reporter is integrated to an HPE Performance Manager server that is not being decommissioned,
remove the integration from the PM server. Before doing so, be aware that the HPE Reporter integration to
PM provides PM with:

« Node and node group list automatically populated from the HPE Reporter database.

« Data source for generating graphs from the HPE Operations Agent metrics in the HPE Reporter database.

After the HPE Reporter integration is removed from PM, any nodes and node groups provided by HPE
Reporter are automatically removed from PM. Node and node group management will be done using the PM
CLI or GUI. For details, see the HP Performance Manager Administrator Guide available at
https://softwaresupport.hp.com/group/softwaresupport/search-result?keyword=.

Verify that PM users are not using any graphs that source data from HPE Reporter.
To remove HPE Reporter integration from PM:

Edit <PM_data_dir>/shared/server/conf/perf/OVPMconfig.ini.

2. Inthe [REPORTER] section, remove or comment out the entries related to the HPE Reporter instance
being decommissioned.

3. Restart Performance Manager for the change to take effect (by using ovpm stop and ovpm start).
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At this point in the evolution process, you already gain a lot of benefits by using of OMi advanced event
consolidation, correlation, and automation features. Operators can benefit from the modern Ul, the flexible My
Workspace pages, and the context-specific actions and graphs. OMi comes with a number of content packs
that provide many features free of charge for certain application areas (like Microsoft Active Directory, Oracle
Databases, and other).

However, there are situations where you need to correlate more events or show more application-related
health indicators or KPIs (in addition to already provided event-related KPIs) or you want to model your logical
business services on top of your discovered IT services and applications and use that information to specify
the priority of events. In such cases, see the below sections that explain additional tasks.

Note: These tasks can be regarded as optional, depending on your specific business needs.

These additional tasks are explained in the following sections. They should be regarded as optional tasks that
you might or might not do, depending on your specific needs.

Modeling Business Services

Modeling your logical business services includes creating business services, business applications, and/or
business transaction Cls, as well as linking those logical Cls to the IT services and applications they use.

The following figure shows a logical business service structure and monitored service contributors:

{ Business Service — Retail Banking Business Service / LOB

e

|’ Business Application — Online Bank Business Application

( Business Transaction Flow — Transfer

g

Business Transaction Flow

Business Transaction — To Checking Business Transaction

[ J2EE Application — JavaProg ‘ J2EE Application

s/

| WebLogic Server Server

L Windows Server J Host

Coru | [newor ] [ Dsk |

This relates the event information to business services allowing the operational staff to identify and
understand the impact of the events on business services and enable them to focus on the most important
ones.

To support service-centric management, the RTSM must be extended by defining a model of business
services and applications. Such a model must contain a relationship to all relevant Cl instances contributing
to the business service.
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Unlike Cl-centric monitoring (where Cl instances and relationships are maintained through discovery,
integrations, and automatic processes), the modeling of business services and their relations is a manual
procedure. It requires a profound understanding of the service and its dependencies to the contributing
service elements. Additionally, the structure of the service presentation is service-specific and needs to
consider the views on the business service model as required by the user.

For more information on this topic, see the following:

« See the following sections in the RTSM Guides > Modeling > Modeling Guide > Modeling >
Modeling Studio: Building a Business View, Business Cl Model, Build a Business Cl Model -
Scenario.

« End-to-End Service Monitoring in IT Environment Best Practice. It provides information on how to deploy
and implement end-to-end service monitoring solutions to ensure adherence to the level agreed upon
between the service provider and the service consumer.

« Moving to Service Centric Management with HP OMi. This technical white paper contains an example
Business Service Model and shows how to create corresponding Cls and views in OMi.

Note: When business services are defined and linked to infrastructure services, you can change the
following Infrastructure Setting to enable business service/business app Cls to show up as part of
events:

Select Context:

@  Applications I Operations Management

[
[

™ Foundations I Alerting
~
Al
~ Resolve impacted Cls in EventPriority Resolution. If set to frue. impacted Business .
Resolve Impzcted Cls Applications & Services will be added as custom atfributes o the event. false

Event Priority

Once events and their related Cls impact business services, OMi instantly calculates an additional event
attribute allowing to classify events depending on their impact on a business service. The event attribute,
Event Priority, can be used to identify the events to work on.

The calculation of event priority is based on the event severity and the business service impact, as shownin
the following table:

Business Service Impact Event Severity

Unknown | Normal | Warning | Minor Major Critical

No Impact Lowest Lowest Low Low Medium = Medium
Low Lowest Lowest | Low Low Medium = Medium
MediumLow Low Low Low Medium | Medium | High
Medium Medium | Low Medium = Medium @ High High
MediumHigh High Medium | Medium  High High Highest
High Highest | Medium | High High Highest = Highest
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The following figure shows an example business impact of a Cl (low):

@ Operations Manager i Workspaces ~  Administration ~»  Q Lradmin~ @~
Workspaces - My Workspace
360° View x Select Page ~ Lo k|
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AOBIG IvestmentR |~ | B} T sekctafiterd [~ | g ([T) 0w
Name Status. Business [ Software = System
L Software i System

Performance  Events, Events

[ AOBIG Investment Research

B {2y Investment Researcn

(<
@

(Tl ADB Web Ay
==} eb App

Business Impact:Low | Indicators:1 | Alerts:0 | Actual Changes:0 | Planned Changes:0 | Incidents: 0

7y JBoss 01

]

g vertica_bigdata

Note: To display the Business Impact information in Service Health 360° View, the business impact bar
needs to be enabled in the Service Health infrastructure settings. See How to Configure the Business
Impact Component for further information.

The following figure shows an example of the resulting event priority in Event Browser:

© Event Browser | P «
¥ B 2 = & | L1 =<NoFilte...| ~ | ~ |- ) @ & B, ol 2

Sev Prio C N 1 A U D S5t. TimeReceived v Title Related CI

1 v E!, 11/24/14 08:59:30 AM  Duration for User Transaction 004 dropped from7.03  Online Banking W “
iy L4 E!, 11/24/14 08:58:20 AM  Probe reports long duration for User Transaction 001 Online Banking W
[V} 74 CL, 112114 10:17:22 PM  Normal fraffic on router cisco01.acme.net cisco01

[v] 74 Ol 11/21/1409:52:38 PM  Performance for DB operations onvertica_001.acme omw2-db

Q = Cl, 112114 09:53:37 PM  CPUload onvertica_001.acme.net backto normal.  omw2-db

Q 74 E!, 11/2114 09:53:36 PM  Response time of AOB Investment Research web ap) AOB Web App

Q 74 E!, 112114 09:53:35 PM - New node was added to Vertica Cluster, Monitoring | vertica_bigdata

Adding Custom TBEC Rules

TBEC is built on top of Event Type Indicators, as well as on the topology information between the ClI
instances. This allows TBEC to relate, for example, a “CPU Load high” event related to a node with a “SQL
response time slow” event from a database that is running on that same node.

If you want to relate two events with TBEC, you first need to make sure that each event is related to a Cl and
that both Cls are connected in the RTSM. The relationships between Cls are typically created by discovery.
See Establish Infrastructure Topology for more information. Linking events to Cls is achieved through CI
hints or using the node, application, and object fields. See the Administration Guide > Event Processing
> Automation > Event Processing Customizations > Cl Resolution for more details.

Additionally, TBEC needs to know the semantics of the event (since you do not want to correlate any event
from CI A with any event from CI B). The semantic “CPU Load high” must be represented by an Event Type
Indicator (ETI), such as System restart:Occurred or CPU Load:High. If the events you want to correlate do
not contain an ETI, add this information as described in the below section.

Once these preparation steps are done (the two events are related to (connected) Cls and contain ETls), you
can create a new TBEC rule. One possibility is to select the two events in the Event Browser and choose
Create Correlation Rule from the context menu.
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If you currently do not have two such events available, you can also define the same rule using the TBEC
Administration Ul: Administration > Event Processing > Correlation > Topology-Based Event
Correlation.

See the Administration Guide > Event Processing > Topology-Based Event Correlation > How to
Configure Topology-based Event Correlation Rules for more details.

Adding Event Type Indicators

Add Event Type Indicators that represent the semantics of an event for the following use cases:

o Asinput for TBEC
« As input for Service Health if the ETI represents a Health Indicator (HI)

Such ETls/HIs must first be defined in OMi and can then be set at the source of the event or by using an ETI
mapping rule on the OMi server. Hls can also be set by metric samples (see below sections for more
information).

To define a new ETI, go to Administration > Monitoring > Indicators and see the corresponding OMi Help
topics.

To set ETls, set the ETI Event Attribute in the corresponding OMi policy template:

Definition Actions Start Action End Action

Event Attributes
Title: Utilization rate for CPU <3SESSION(Cpuld)= has exceeded major threshold. <55ESSION[AIertS|
Event Correlation
Custom Attributes Description:
Instructions
Advanced
Actions
Severity: |l-|ﬂj0|' - |
Category [<s3ESSI0N(MessageGroup)= |
Subcategory: |
ETE [cPuUsageLevelSpike

Mode: |

Related CI:

Sub Component:

Source Cl

Source Event ID:

|

|

|

|
Send with closed status: [
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If still used, you can also set the custom message attribute EventTypelndicator (or ETIhint) inside an OM

policy:

Qutgoing Message E

Message attributes I Message comelation CMAs | Instructions I Message stream inteface 4 I ’I

Custom message attributes:
Name | Value | Add... |
SearchTag <SSESSION(MessageGroup)>:CPL;

SPIFamily InfraSPI Edit ... |
SPIName SISPI

Cilnfo host_node@@<$MSG_NODE_NAME= Remove |

CPUUsagelevel:Spike

Event -|—‘J."|:| elndicator

As an alternative, ETls can also be set on the OMi server when the event arrives using an ETI mapping rule.
Go to Administration > Monitoring > Indicators. Select the Cl type for which the ETIl was defined. In the

ETI details, select Go to Indicator Mapping Rules:

_ETI Mapping Rules
2l » | e

| Go to Indicator Mapping Rules |

| Display Nai

The following figure shows Indicator Mapping Rules Manager:

ClTypes indicator happin

PingAvallbity - Edt Wapping Rule

Filter Events

¥ Filter
Show enly Cl Types with assigned mapping rules General
w Digplay Name: [vescommunavaiivilty |
Cl Types (filtered) + Name: [vescommunavaibitty ]
Description: \ VS cluster process VCSComm UnAvailbity |
Active:

# Event Fiter [ vescommunavailabieFiter

Map Event to Indicator

# Ingicator: |51 cluster software Service

Map to Indicator State: (O Based on severity

® specific Indicator State:

@ Avaiable

(+) Required field

¥ Unavailable

cription

Artifact Origin

See the Administration Guide > Event Automation > Indicator Mappings for more details.
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Adjusting Service Health

Service Health Overview

Service Health provides similar features as OM Service Navigator, as it enables you to monitor the
availability and performance of the applications and services in your organization.

Applications and services are represented as Cls in the RTSM and Service Health can show the hierarchy of
Cls using predefined views. A view acts like a filter and retrieves only certain Cls from the RTSM for display.

Service Health shows the hierarchy of the Cls and the Cl status. Each Cl has a Cl status and can have one
or multiple Key Performance Indicators (KPIs) representing the high-level Cl status, such as its performance
or availability. Each KPI can be fed by one or multiple Health Indicators (HIs), representing the fine-grained
measurements on the CI.

Unlike OM Service Navigator that only knows one service status, Service Health calculates multiple Hls and
KPIs representing the status.

A KPI status is propagated from a child to a parent Cl according to the propagation definition, when the parent
and child Cls are linked by either Impacted By (Directly) or Impacted By (Potentially) calculated relationship.

KPI status propagation is defined in KPI propagation rules, also known as group rules. These group rules
determine the KPI status based on the data received from other KPIs or Hls. The received data can come
from the KPls of child Cls or from other KPls or Hls associated with the same CI. See the Administration
Guide > Service Health > Customizing KPI Propagation for more details.

The following figure shows KPIs and Hls displayed in the Health Indicator component:

Health Top View v & o« Health Indicators LS

VERTICA_DB_NODE_01 (vertica_001) (Vertica)
Selected View: Vertica Database Cluster

Health Indicators Contributing to KPIs
= W

(") = KPI Health Indicator State Last status change

¥ Software Performance ¥ Vertica Resource Pool Usage ~ High 1/13/2015 9:53 AM

i Last Updstet1/26/2015 03:03:01 PM G Last Update: 1/26/2015 02:03:01 B

The following figure shows the Cl status and KPIs displayed in the Watchlist component:

ADB 1G Investment Research

VERTICA_DB_NODE_O * VERTICA_DB_NODE_

Unassigned Events Fiy 02 (vertica_002)
Unresolved Events Fiy Vertica
Software Performance [} ( ' r-]
System Performance 1 ! .- /
( o s s

1211114 10:38 AM
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KPI calculation rules can be changed and extended. See the Administration Guide > Service Health >
Customizing KPI and HI Calculation Rules for more details.

Out-of-the-box content packs contain many HI and KPI definitions and many KPI calculation rules that can be
used as a starting point.

Health Indicators

Health indicators (HIs) provide fine-grained measurements on the Cls that represent your monitored
applications and business services. Some Hls provide business metrics, such as backlog and volume, while
other monitor various aspects of performance and availability, such as CPU load or disk space.

The following figure shows a Health indicator definition with possible HI states:

L4

xIx]

In OMi, His can be set via events. When an event is sent to Service Health inside OMi, it is sent with an ETI
(Event Type Indicator). The ETI includes a name, a state and an optional metric value, for example
CPULoad:exceeded or CPULoad:exceeded:98. Using HI definitions in the indicator repository, Service
Health translates the ETI state into one of the standard Service Health statuses (Critical, Major, Minor, and

soon).

Note:
« An HI maintains its state until another event arrives that sets the same H| with a different state.

« Toreset the HI manually to its default value, close the corresponding OMi event with Close and
Reset Health Indicator. In normal production environments, OMi expects a good event that resets

the HI.

Key Performance Indicators

Key Performance Indicators (KPIs) are high-level indicators of Cl performance and availability, which apply
calculation rules to the data provided by Hls to determine Cl status. KPIs can be calculated using statuses of
Hls, KPIs, or a combination of these. For example, you can specify a rule that sets the severity of the KPI to
the worst severity status of any assigned Hl, or to the average severity status of all child KPls.

The following figure shows a KPI assignment displaying HIs contributing to the KPI status:

HPE Operations Manageri (10.10) Page 134 of 196



OMi Evolution Guide
Chapter 9: Adding Value on Top

The value that results from the calculation is used to set a severity level for the KPI based on the KPI
definitions; KPI severity can be normal, warning, minor, major, or critical. The resulting measurement for the
KPl is translated into a color-coded status indicator displayed in Service Health, where the color represents a
more desirable or less desirable condition for the KPI.

You can define a KPI to use only specific Hls that are of interest to you. For example, the System Availability
KPI has two Hls: Node Status and Ping Availability. If you are only interested in the local status, you can set
the KPI to include the Node Status HI only in its calculation.

Note: An HI is created when the first event with a corresponding ETI arrives. Therefore, it can happen
that many of your Cls do not show any HlIs or KPIs as long as no problems are reported.

Unresolved and Unassigned Events KPlIs

An Unresolved Events KPI shows the most critical severity of related events and the event count (an
Unassigned Events KPI shows the same for the unassigned events).

Therefore, the Unresolved Events KPI can be seen as the equivalent of the service status in OM. It changes
its status when new events with higher severity arrive or when events are closed. No configuration is
required, as these KPls are automatically created for all Cls that receive events.

However, unlike in OM, these event-related KPIs are not propagated by default. This is the intended behavior,
as it is often not desired that a single event of unknown semantics for a low-level Cl impacts the Cl status of
a higher-level business service Cl. Therefore, OMi by default does not propagate the event-related KPIs, but
propagates all other health-related KPIs instead.

To propagate event-related KPls, see follow the instructions described in the User Guide > Introduction >
Health > HI-Based KPI Calculations > How to Propagate and Sum Up the Events Along the CI
Impact Hierarchy.

You can also count active events (unresolved and unassigned) for a specific event subcategory. For
example, an Unresolved Security Events KPI can be configured to display the number of unassigned or
unresolved security events. For details, see the Administration Guide > Additional Configuration >
Active Event Count in KPIs.
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Cl Status

The Cl status can be configured per view and is the worst status of all selected KPls. To configure which KPI
contributes to the Cl status, go to Administration > Service Health > KPIs in Views. Select the view and
then select the KPls.

The following figure shows KPIs included in the Cl status:
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See the corresponding OMi Help topics for more details.
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Deploying Agents

OM allows installing agents remotely using various technologies, such as telnet, SSH/SCP, Windows
DCOM, Windows shares.

OM i does not offer remote deployment. Agents can be installed manually (and also remotely using such
technologies as SSH/SCP) or using other software deployment tools, such as HPE CDA (see
https://hpln.hpe.com/blog/hp-operations-agent-can-be-deployed-cda-and-csa for more information) and HPE
Server Automation or Microsoft Systems Center 2012 Configuration Manager (see HP Operations Agent and
HP Operations Smart Plug-ins for Infrastructure Installation Guide for more information).

Once the agents are installed using one of the above methods, they can be updated with hotfixes and patches
from OM:i.

Patch and Hotfix Deployment

OM can deploy agent patches and hotfixes remotely. OMi can deploy patches and hotfixes remotely and can
deploy new agent versions if the agent is already installed.

Update Operations Agent
() Update to Latest Hotfixes
(®) Update to Latest Version
() Operations Manageri  Workspaces ~  Administration ~  Q o
Administration > Setup and Maintenance - Monitored Nodes
Node Vigws All Nodes - Predefined Node Filters
Gl RIS S - K| % %5 @4%- B3
=] E} Predefined Node Filters ‘ Primary DNS Name | Monitored bv [ — Nnerating System
Update Operations Agent
I AllNodes B mambo mambo.net oM prcidtiiibitindaddi o ® | 5o o)
I} Woniored Nodes B mambod mambonet  OM Windows Windows_84 Server 2008 R2 (8.1)
[ windows |Windows_64 Server 2008 R2 (5.1) 5 e He
I Nodes with Operations Agent B mamboS.mambonet | OM Vv Windows_64 Server ) o [~ cancel | [Hep |
I Unmentored Nodes B omw-dbmambonet | OM Windows | Windows_32 Server 2003 (5.2) ;J
[ AU A [ TR R

For details, see the OMi Administration Guide > Setup and Maintenance > Monitored Nodes >
Connecting HPE Operations Agents to OMi > Updating HPE Operations Agent Installations.

Certificates Handling

Certificate requests from agents can be granted in the OMi Ul (Administration > Setup and Maintenance >
Certificate Requests) or using the command-line interface ovem as on OM systems.

OM i supports granting certificates automatically based on IP ranges, node names, or using other attributes
via groovy scripts.

HPE Operations Manageri (10.10) Page 137 of 196


https://hpln.hpe.com/blog/hp-operations-agent-can-be-deployed-cda-and-csa

OMi Evolution Guide
Appendix A: Agent Management

Maintaining Agents

Many CLIs that exist in OM, such as ovpolicy or ovconfpar, are provided in OMi as well. You can use them
to perform operations on a single node. To perform mass operations on multiple nodes, use the opr-agt
command-line interface. See the Administration Guide > Monitoring > Command-Line Interfaces > The
opr-agt Command-Line Interface for details.

Starting and Stopping Agents

Use the following OMi CLI to check the agent status or to start/stop the agent:
ovrc with options -start|-stop|-status|-restart|-notify

opr-agt with options -status|-start]|-restart]|-stop

Examples:

ovrc -ovrg server -host mynode.example.com -status

opr-agt -status -view_name "Hosts with HPE Operations Agents" -username admin
opr-agt -status -node_list nodel.example.com,node2.example.com

Agent Configuration Changes

Use OMi CLIs ovconfget, ovconfpar and opr-agt to list and change the agent configuration.
Examples:

ovconfpar -change -host mynode.example.com -src-ovrg server -ns eaagt -set
OPC_BUFLIMIT_SIZE 10000

opr-agt -set_config_var eaagt:0PC_BUFLIMIT_SIZE=10000 -node_list nodel,node2

Policy Management

Use the ovpolicy CLI tolist and change installed policies. Use opr-agt to list installed policies.
Examples:
ovpolicy -list -host mynode.example.com -ovrg server

opr-agt -list_policies -view_name “Hosts with HPE Operations Agents” -username admin

Installed Agent Packages

Use the ovdeploy CLI to list installed agent packages.
Example:

ovdeploy -inv -host mynode.example.com -ovrg server
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Monitoring Agent Health

OM servers are able to ping agents regularly and report when the agents no longer respond. OMi provides the
capability to check and report agent health as well. Default health check settings check the health every 30
minutes, the interval can be changed per node.

Additionally, self-monitoring policies on OM ensure that problems with the agent own core components do not
compromise its ability to monitor managed nodes. Using the self-monitoring feature, you can easily identify if
the OVO agent is working correctly by configuring the agent to poll its own core components and generate an

alert if problems are detected.

These self-monitoring policies are not shipped out of the box with OMi, but can be imported and deployed if
required. See the sections below for details.

Besides that, the ovc process on any agent automatically restarts aborted or killed agent processes and
sends corresponding events to its management server.

Using Operations Agent Self-Monitoring Policies

Using the OM self-monitoring feature, you can establish if the OVO agent is working properly by configuring
the agent to poll its own core components and generate an alert if it detects any problems. Although OMi does
not ship these self-monitoring policies, you can import and use them in OMi.

Some policies use $0PC_MGMTSV as an operator-action target and run ovrc on the OM server to restart certain
agent processes. These actions must be changed to run ovc -restart locally on the node itself (which
works as long as the action agent is working properly).

In OMi, create a wrapper around imported policies by creating a self-monitoring aspect for the
HPE Operations Agent Cl Type and assign it to the HPE Operations Agent Cls. This will deploy all included
self-monitoring policies with a single assignment.

Supported Agents

OMi can receive events from all Operations Agents v.11.0x and later (Operations Agents v.8.6x were
previously supported by OMi but reached the end of support phase).

To use OMi Monitoring Automation features, Operations Agents version 11.12 or later is required.

OM and OMi Feature Comparison

OM Functionality Equivalent in OMi

Start, stop, status, version, switch a primary Yes, using ovrc, ovconfpar, opr-agt.
manager, set variables on agents using
opcragt.
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OM Functionality

Mass operations (start, stop, status, version,
switch a primary manager, set variables) on
agents using opcragt -all -nodegroup.

Deployment of agents.

Deployment of patches.

Deployment of hotfixes (only possible using a
hotfix deployment tool).

Supports download of policies and
instrumentation files (opctmpldwn and
opcinstrumdwn), which can be included in the
base agent package.

Query detailed installed agent packages.

Supports OA 11.0x and later.

Equivalent in OMi

Yes, mass operations (start, stop, status, version, switch
a primary manager, set variables) on agents using -
query, -view, or -nodegroup options of opr-agt.

No, use HPE CDA or other Software distribution tool.

Yes, integrated into OMi. Latest patches can be deployed
using the Update Operations Agent function.

Yes, integrated into OMi. Latest hotfixes can be deployed
using the Update Operations Agent function.

No, but aspects and management templates (including
policies and instrumentation files) can be automatically
deployed as soon as the agent is connected to the OMi
server.

Yes, using ovdeploy. The HPE Operations Agent version
is also displayed in the Monitored Nodes Ul.

Yes.

How to Manage Agents from OM and OMi

Using agent-based flexible management policy templates, OMi and OM systems can be configured as
action-allowed and secondary managers, which allows configuration and management of agents from both
OM and OMi servers. However, HPE recommends that you avoid deploying policies from two servers to the
same node as this may complicate the move of agents. Instead, use the flexible management template to

prepare the switch to OMi.

See the Administration Guide > Setup and Maintenance > Monitored Nodes > Connecting
HPE Operations Agents to OMi for more details.

How to Switch Agents from OM to OMi

Recommended: Switch Agents Using a Flexible Management Template

(Using Existing Certificates)

Switch the agents to OMi using a flexible management template as described in Manage Operations Agents
from OMi Step by Step. Using this approach, you can continue monitoring business-critical applications on
the node and replace its configuration while the agent is running.

Below is the summary of recommended steps:

1. Allow management from both servers using a flexible management template.

2. Choose a group or type of nodes to move over (for example, all my Oracle Database systems).
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a. Test policy and aspect deployment and tool execution on a representative node.
b. After a successful test, rollout configuration to the remaining nodes of the same type.

c. Switch the primary manager and target server to OMi. This still allows configuration from both OMi
and OM servers.

opr-agt -primmgr <node selection> -username <user>

3. Repeat steps 2-5 until all nodes are managed by OMi.
4. Before switching off the OM server, switch the agents to OMi completely:

opr-agt -switch_manager <node selection> -username <user>
and clean up old OM policies if necessary:

opr-agt -deploy -clean <node selection> -username <user>
Caution: At this point, the node still has a certificate issued by the old OM server and is configured to
trust both OMi and OM server certificates. However, as the primary manager was changed and the
flexible management template removed, the old OM server no longer has rights to make changes on the

agent. Therefore, there is no need to re-issue or replace agent certificates. The OM certificate authority
can be completely shut down and the private key can be destroyed.

However, you can also request new agent certificates. See the below section for more information.

Alternative: Switch Agents Completely or Issue New Certificates

To request new certificates and switch the agent completely, execute the following commands on each node:

Log in to the node as root or administrator.
2. Stop the agent completely:

opcagt -kill
3. Delete the current certificate:
ovcert -list
ovcert -remove -alias <id of node certificate returned in previous step>

4. Go to the following location:
o On Windows 64-bit nodes: <ovinstalldir>\bin\win64\0pC\install

o On other Windows nodes: <ovinstalldir>\bin\OpC\install
o OnHP-UX, Linux, and Solaris: /opt/0V/bin/0pC/install
o OnAIX: /usr/1lpp/0V/bin/0OpC/install

5. Run the following command:

o OnWindows: cscript oainstall.vbs -a -configure -srv <fqdn of omi server>
-cert_srv <fqgdn of omi server>

o OnUNIX/Linux: ./oainstall.sh -a -configure -srv <fqgdn of omi server> -cert_srv
<fqdn of omi server>
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6. Grant certificate requests on the OMi server using the Admin Ul or ovem.
7. Deploy aspects and management templates to start monitoring again.

Note: After executing the above-described procedure, all existing policies are deleted and the agent is
shut down. To continue monitoring your business-critical applications, the agent needs to be
reconfigured by OMi.
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Node-Centric and Cl/View-Centric Approach

In OM, System and Application Management is based on a node-centric approach. Many tasks, such as tool
launch or policy deployment, refer to the nodes, a list of nodes, or node groups. Node groups are also
referenced when defining responsibilities for operators.

In OMi, the approach is Cl-centric, or view-centric. Responsibilities are defined using views (see the
Administration Guide > Users for more details) and operators typically work with Cls of various Cl types
(such as business applications, running software, databases, web servers, and so on). The node that hosts
the Cls is not as important as in OM, as operators can launch tools or deploy aspects to Cls directly, without
knowing what nodes are affected. Mass deployment to nodes through node groups in OM is replaced in OMi
by deployment of aspects to views and automatic deployment of aspects based on the RTSM changes (such
as new Cls, deleted Cls, and new relationships between Cls). Therefore, node groups, although they do exist
in OMi (as Cl collections), do not play a special role.

To simplify the move to OMi, OM operators can use the OM CI collection view to filter the events based on
node groups. Node groups/Cl collections can be created and updated automatically in OMi, if nodes are no
longer managed by OM.

However, in order to benefit from all Cl-centric features of OMi (Cl-specific tools/run-books, Cl-specific
graphs, and so on), it is recommended that OMi operators switch from a node group-based approach to a
view-based approach (rather sooner than later).

Nodes in OM have attributes, such as machine type, control type, and other, for example:
‘machine type’ = ‘linux/x64/linux26’ and ‘control type’ = ‘controlled’.

Some node-related functionality is linked to the node attributes, for example:

« The attribute ‘machine type’ determines the agent packages to be installed.

« The attribute ‘control type’ (OM for UNIX) determines the level of management capabilities available for the
node.

« The attribute ‘virtual’ allows deployment and tool execution to/on virtual nodes in an HA environment.

« A node can be set up as an external node with a pattern, resulting in all messages that match that pattern
being assigned to that node.

Nodes in OMi are represented as Cls of type Node (or a sub-type such as Computer, Windows, and so on).
Node Cls have attributes (for example, primaryDNSName or monitored_by) and relationships to other Cls in
the RTSM (for example, an IP address Cl or HPE Operations Agent Cls). A node with a Composition
relationship to an HPE Operations Agent Cl represents a node with an installed agent. For such nodes, the
monitored_by attribute contains the value OM, but a node can also be monitored by other applications, such
as SiteScope or BSM Connector.
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The following figure shows a typical node ClI with related Cls in the RTSM:
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The following figure shows some attributes of nodes in the RTSM:

| Dizsplay Label | DiscoveredOsName | Monitored By | PrimaryDnsName Cl Type

@ &3 Windows Server 2008 6.0 [Om] 1&3.mambo.net nt

% LoadBalancer LoadBalancer I

% RpClusRG cluster_resource_group
@ mambo3 Windows Server 2008 (5.0} [OM, SiteScope] mambod.mambo.net nt

@ mambonSs Windows Server 2008 R2 (6.1) | [OM, SiteScope] mambon95. mambo.net nt

@ mambon36 Linux Red Hat 6.1 2.6.32 [Om] mambon96. mambo.net unix

@ omw2-db (Management Server) | Windows Server 2008 R2 (6.1)  [OM] omw2-db.mambo.net nt

@ 0o Windows Server 2008 R2 6.1 [OM, SiteScope] oo nt

@ oradb3 Windows Server 2008 R2 6.1 [Om] oradb3. mamba.net nt

Node Setup

In OMi, node Cls and related Cls are typically created automatically. Such Cls are created when the
HPE Operations Agent is first installed and connected to the OMi server. Node Cls are also created using
topology synchronization from OM or using various discovery technologies.

Caution: There is no need to set up nodes in advance as in OM.
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Node Type
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dor er201262 1114014 | |,

Operat... | ..

Add to Node Group “Windows Systems”

g Add Node to Node Group

node group selected below.

Nodes that are selected in the nodes list vl be added to the.

« Parent Group. B [ GermanHa

fi Windows Systems.
[ My Linux systems in EMEA

() Required field

mambo8 - Detais
~ General

Primary DNS Name:

~ Additional Information

Installed Packages

Opermtions-agent

If nodes are not created automatically, you can create Cls using the Monitored Nodes Ul. This Ul was
introduced to simplify viewing and maintaining node Cls and can also be used to add nodes to node
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collections (ClI collections) manually. Starting with OMi 10, it also allows configuring health checks and
updating agents.

How to Change the Hostname or IP Address of a
Managed Node

Once the node Cl and its related Cls are created, if you later want to change the hostname or the IP address
of the node, it is highly recommended that you manually update the details in OMi before making changes on
the node. Otherwise, the node will send the updated IP address and hostname to OMi, which can result in a
duplicate node Cl, due to the ClI reconciliation rules in the RTSM that require a 66% match of the IP
addresses (if a node has only one IP address, there is a 0% match of IP addresses when this address
changes).

To change the hostname or IP address:

1. In OMi, go to Administration > Setup and Maintenance > Monitored Nodes.
2. Edit the node and change the hostname and/or the IP address. Click OK.
3. Change the hostname and/or IP address on the managed node.

Virtual Nodes

OM uses virtual nodes in cluster-based, high-availability environments to simplify policy deployment. Policies
can be deployed on a virtual node and are automatically deployed on all physical nodes related to that virtual
node/IP address. Policies are enabled only on nodes that run a corresponding resource group.

Note: This functionality is currently not supported for cluster-based monitoring.

External Nodes

OM uses external nodes to map incoming messages from various systems to one single node. This is
required in the following scenarios:
1. When the node name is unknown.

2. When nodes must not be individually configured, for example, due to the number of nodes that must be
set up.

Operators in OM can select an external node and see all events from corresponding nodes.

In OMi, events are received and can be shown to operators even if they are not related to a node in the RTSM.
Such operators must be granted the right to view the events independent of a view filter. Therefore, it is not
necessary to set up an external node to view the events.

To map certain events to specific, external nodes/Cls in order to allow operators to filter these Cls, create the
Cls manually and use CI resolution hints to ensure that events are mapped to the right Cls.
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Cl resolution hints can be added on the OMi server using an EPI script that extracts the node information in
the event, compares it against a string or pattern, and sets the ClI hint accordingly (see How to Implement
External Nodes in OMi below for details).

Node Group, Node Layout Group, Node Hierarchy,
and Cl Collection

In OM, you can group nodes into node groups, which can be used for mass policy deployment and mass tool
execution, as well as to define user responsibilities and filter the events. You can mark node groups as
hidden.

In OMi, tool execution is done on Cls, mass policy deployment is replaced by manual or automatic RTSM-
based aspect deployment, and user responsibilities are defined using views. Therefore, the only use case
where node groups can be beneficial is filtering the events.

Node Groups Versus Views as Means to Structure
the IT Environment

In OM for Windows, node groups can be nested to build a hierarchy. In OM for UNIX, this is not possible, but
it offers the concept of node layout groups and node hierarchy to organize the nodes into a logically structured
view.

Conceptually, node groups and node layout groups in OM are a means to group and structure monitored
objects/nodes to cope with the large amount of objects in the IT environment.
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In OMi, the structure of monitored objects (configuration items) is represented in the RTSM using
relationships. RTSM views retrieve and display Cls and relationships. The displayed hierarchy is defined by
the view definition. Using different views, operators can have a more flexible view on their IT environment
than with node groups where the structure is rather static and restricted.

OMi operators can switch between various views and use views and contained Cls as afilter. Therefore, it is
not necessary to use node groups or layout groups as filters.

However, to simplify the transition, OMi automatically creates CI collections that represent the OM node
group hierarchy. This hierarchy is created and updated using topology synchronization from OM. This
hierarchy can be displayed and used for filtering using the out-of-the-box view OM CI Collections. This is
very useful when OM and OMi are used side by side.

[om ¢l callections [=]

E-I] OW CI Collections
=@ Nodes
+-[0] Advine IT servers
[E] Advinc Nodes
[E) HA Clusters
=[] HP Defined Groups
[&] External
[&] N Managed Nodes
[@] shup
- [] Unix
[&] unknown
-[@] Virtual Nodes
£ Windews
[B] Windows 2000
[B] Windows 7
=1 [@] Windows Server 2003
sm
£1-[@] Windows Server 2008
mambo3
&[] Windows Server 2008 R2
[B] Windows Server 2012
[@] Windows Vista
[@] Windows XP
=-[@] InfrasPl Managed Nodes
#-[@] Clustered Nodes
-[@] Hypervisor Hosts and Proxies
=-[E] MS Windows
mambongs
omw2-db (Management Server)
sm

The underlying relationships in the RTSM (which Cl/Node belongs to which Cl Collection/node group) are
updated using toposync whenever changes occur on the OM side.

However, those group relationships are not created or updated automatically, because node groups do not
play a special role in OMi.

How to Move Node Topology to OMi/Topology
Synchronization

Nodes and the node group hierarchy of OM are forwarded to OMi respectively RTSM together with the
services hierarchy using topology synchronization. For details, see the Extensibility Guide > Populating
the Runtime Service Model > Topology Synchronization Overview.

For OM for Windows, use default configured toposync packages that include the nodegroups synchronization
package. For OM for UNIX, use toposync packages layoutgroups and nodegroups.
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You can configure the synchronization package in Administration > Setup and Maintenance >
Infrastructure Settings.

Select Applications and use the list to set the administration context to Operations Management. Scroll to
Operations Management - HPOM Topology Synchronization Settings.

The following types of topology data related to node management can be transferred from OM to the RTSM:

oM
topology
data Related OM Type Resulting ClI type(s) and Relationships in the RTSM
Node OM for UNIX and Linux, = Node, Computer, Unix|Windows, other <operating system>.
OMfor Windows Pathin Cl type tree:
Managed Object -> Configurationltem -> InfrastructureElement ->
Node -> Computer -> Unix | Windows | ...
Mapping:
External node -> Node
Node with the operating system specification -> Computer
or operating system-related Cl type, for example Unix, Windows,
and soon.
Virtual node -> ,virtualized system“added to “node_role* attribute
Node OM for UNIX and Linux, = CI Collection and relationships between CI collections and node
group OM for Windows Cls
Path in Cl type tree:
Managed Object -> Configurationltem -> CICollection
Node OM forUNIX and Linux = ClCollection
hierarchy
Node OM for UNIX and Linux = ClCollection
layout
group
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The following figures show synchronized node hierarchy examples from OM for Windows (Node Groups) and
OM for UNIX (Node Layout Groups):

[om ciconections [=]
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Note:
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Sub Cl types of ‘Node’ are ‘ClusterResourceGroup’, ‘Computer’, and ‘Net Device’.

o External nodes are set up as ‘Node’. This is also true for the following machine types: IP Network -
> other -> other, non IP -> other -> other, as well as ‘Node on external Events’.

o OM (non-external) nodes are set up as Cl Type Computer. When the operating system information
of OM nodes is available, the corresponding Cls are assigned to Cl Type subgroups of the CI Type
Computer labeled with the operating system version. The other two sub CI Types have (at this
point in time) no relevance for OM entities.

o Although the ,Net Device' Cl Type exists in the RTSM, toposync does not synchronize devices
like routers, network printers, and so on.

Not all attributes of nodes and node groups are transferred using toposync into the RTSM. The OM
node attribute ‘Control Type' is ignored by OMi.

All node groups are transferred to ClCollections, also if they are marked in the OM responsibility
matrix as hidden.
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How to Implement External Nodes in OMi

This step is required if you want to map events from various nodes to one specific external node/Cl, so that
operators can get a list of those external events by selecting the corresponding Cl.

Create a Cl (of any type) that acts as an external node. The following example uses a node Cl, because it can
be easily created using Administration > Setup and Maintenance > Monitored Nodes. Other Cls can be
created using Administration > RTSM Administration > IT Universe Manager.

Note: If you created an external node in OM and used topology synchronization, you already have an
external node Cl that you can use as arelated Cl, so you can skip Step 1.

MyExternalNode1. example.com - Create New Monitored Nodes

General

@ Monitored Node
[

Create and edit a nede instance with attributes that are relevant for menitering by O perations
Management.

All nodes are saved as configuration item instances in the RTSM CMDB.

Node Type: & node

# Primary DNS Name: |r.|yExterna\Nude1 example.com

Enter the fully qualified DNS name of your host. The name ofthe C1 will be derived
from the short host name.

# |P Addresses: * o 52
IP Address | DHCP ‘ Routing Domain
10.10.10.1 = S{DefautDomain}
Operating System: | |v|
Processor Architecture: | [=]
Description:
(+) Reguired field
L = L —pe——r
Example:

« Step 1: Create a generic node (Node Type: Node) and provide a node name (for example,
MyExternalNode1.example.com). Specify the IP address, since all nodes in the RTSM require an IP
address. Use the IP address not used by any real node.

Review the node properties and copy the node ID as it will be used in the next step.
« Step 2: Create an Event Processing Customization/ EPI script for the step Before CI/ETI resolution.

Copy the below code into the Script tab and replace <id of CI that acts as external node> with the
ID of the Cl you have created. Change NODE_SUFFIX according to your needs. This example script maps
all events from nodes with that suffix to the external node CIl. You can implement more sophisticated
checks using Java regular expressions.

import java.util.lList;
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import com.hp.opr.api.scripting.Event;

import com.hp.opr.api.scripting.ResolutionHints;

class SetCIHintBasedOnNodeSuffix

{

// This script can be used to replicate the external node functionality that exists

in HP Operations Manager for Windows/Unix.

// It maps events from nodes of a certain domain to one specific CI that acts as

“external node”.

// More sophisticated checks can be implemented using Java regular expressions.

// This is the generic CI to which all events will be related (related CI of event)

static def EXTERNAL_CI = "UCMDB:<id of CI that acts as external node>"

// this is the domain - all events from nodes with DNS name that matches

*.example.com will

static def NODE_SUFFIX = ".example.com"

def init()
{
}

def destroy()

{
}

def process(List events)

{

for (event in events)

{

def nodeHints = event.getNodeHints();

def nodeName = nodeHints.getDnsName();

def newhint = EXTERNAL_CI

if(nodeName != null && nodeName.endsWith(NODE_SUFFIX))

event.setRelatedCiHint(newhint);

HPE Operations Manager i (10.10)
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Tip: As an event filter, set up afilter that looks for events without ClI hints. This way, the events that

already have a CI hint are neither overwritten nor processed by the EPI script.

events with no Cl hint - Edit Event Filter

Fitter Display Mame: =

events with no Cl hint

Filter Description:

Fitter Definition

o X IR

Related Cl Hint equals ™

Final EPI Script in Administration > Event Processing > Automation > Event Processing

Customizations.
@ Operations Manager i Workspaces w Administration ~ Q £ admin ~ o~
Administration -~ Event Processing - Automation - Event Processing Customizations
EPI Steps Event Processing Scripts Details
o 2|8 x b K o g 7 7
& PipelineEntry L add CI hintto external node
< v General
[ 3dc2030c-4268-82¢7-4255- 112000830088

« Step 3: Add relationship to a Cl collection

Display Name: add CI hintto external node

Artifact Origin: @ Custom
Description:

Active:

Seript

defprocess(List events)
for (event in events)
{

defnodeHints = event getNodeHints();
defnodeName = nodeHints.getDnsName();
defnewhint = EXTERNAL_CI
= null 83 nodeHame.
event setRelatedCHintnevhint);

H
H

ODE_SUFFIX)

1

- Advanced

Class Path:
Event Fiter: events with no Cl hint

Timeout [

Read-Only:

The predefined view OM CI Collections does not automatically show all nodes, but only the nodes that
belong to OM node groups. To see the newly created external node in the view, create a relationship to the
External node group using the IT Universe Manager. Select the new Cl and choose Relate to Cl from the
context menu. Search the CI collection “External” in the OM CI Collections view and create a
membership relationship from the CI collection to the node.

HPE Operations Manageri (10.10)
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Wodeling > IT Universe Wanager

Select Relationship

B 1nsert Relatic

Target Cls

[E% External

Source I MyExternalode1 (Node)

Target C(s): External

Relationship: | Membership -
Direction: Source

Define Relationship Properties

=l Properties inherited from class Managed Relationship

Actual

Allow Cl Update
Create Time
Created By

Description
Display Label

Enable Aging

Global ki

Is Candidate For Deletion
Last Access Time
LastModifiedTime.

st

True

User: Voker

False

False

Properties inherited from class Managed Relationship

=

[save  J cancel |

Wodeing Data Flow Management |
Edit~ View v Layoul~ Operations - Edtorkem~ Tooks ~
R Browse Views |[Search Cls
BE - (g e | 1 [ 0 [ % |5 || o s
source Ct & WyExternalliode
Select target Cis
E— fomusevews )0
L | Y View: (oM CiCollections
ClType  [Node; = EFE_DH CICollections
Name B CI Type (0] tioges
- a3 +-[0] Advinc IT servers
[E Hypervisor Hosts ... | CiCollection {—[B] Advinc Nodes
B Windows. (0] Ha Clusters
[ 18M LPAR Cicalection =[] HP Defined Groups
[E2 infrasL Cicolection % g] External
[E2 InfraSPI Managed ... CiCollection % Zm;‘“““ Hodes,
[ intrastructure Cicolection WERSTETode B ore
[ instrastructure Cicollection &) unknown
[E Linux CiCollection En &) virtual Noges
[ Linux CiCollection 3 @] windows
E Loassaiancer Load Balancer =[] InfraSPl anaged Nodes
[ mambo3 Windows - [B] MgdByOMAndMA.
& mambonss Windows. —% omw2-db (Management Server)
B4 mambongs Unix ="
—[@] viruaization
[ mcse CiCollection
[ MgdByOMARdMA  CiCollection [Legena: ) Added i Candiate for Deletion A Changed '8 External + impacted I mpacted and 1
[&% MoneyTransfer fionFlow
[ MS Hyper-VHost  CiCollection [> Mo Active Impact Rules ‘ Change Timeframe is not set ‘ £ Candidates for Deletion not
[E2 MS Windows CiCollection Fnd | | ® 6
[E2 mscs Cicollection g
B myextemaltiodet Noge Name: el ID: 168598 caSe083eclcl28beTS M
[ NHM Managed Nod...  CiColection
R i E: = ~ Type here to fer pro
Catenton =By i ‘ & Edi | Y Export ‘ Quick fiter: | Q- Type ne er proy |
Cicolection

The operators can now select the external node Cl in the OM CI Collections view and get the
corresponding events as in OM:

360°View X | Event Perspective X | Performance Perspective X | My special OpsConsole X

Select Page n

(=]

(@] Advinc Nodes
O] HA Clusters
E1-[E] HP Defined Groups
[B] External

[&] HNM Managed

(@] shme

& myexternaliode1

Nodes

HPE Operations Manageri (10.10)

View Explorer 5] | ol % @ Event Browser for MyExternalNode1
| [Browse views | Search | O Lo o o - SL RS 5 |];;[ OM CI Collections. ||? <No Fiters ‘ L
ﬁ Gy S|/P.fC|HN|I|[A|U|D|S5|T|RelatedCl Title
|er| cl Collections ‘ v| @ = L_' MyExternalNode1 disk Z: full on someNode1 example.com
=8 ];[ OM CI Collections o= CL MyExternalNode1 High CPU load on someNode.example.com
B {G] Nodes Q= Cl, MyExternalNode1 High CPU Ioad on someOtherioded. example.com
- [H] Advine T servers [2]k:4 CL|  |MyExtsralNode High CPU load
Q= L_| MyExternallode1 Critical CPU load
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User Tasks

User tasks are outlined in the following table.

Event Handling and Tool Execution

Functionality OM for UNIX

External
event
manipulation

CLI

opcack, opcackmsg,
opcackmsgs, opcmack
(agent CLlI), opcunack

opcannoadd,
opcannoget

opccmachg,
opcownmsg,
opcmsgchg

opcdelmsg

opcgetmsgdet,
opcmsgsrpt

API

All operations on a
message can be done
with the OM Server
Message API. OM for
UNIX provides aC
API.

HPE Operations Manageri (10.10)

OM for Windows

CLI

ovowmsgutil

opcmack (agent CLI)

Create a VB script using
WMI methods.

API

All operations on a
message can be done with
the OM Server Message
API. OM for Windows
provides a C APl and
COM API.

OMi
CLI

RestWsUtil CLI allows accessing
all the Event Web Services
functions from the command line.

Web services

REST-based Event Web Service
allows all event modifications in the
console. It also allows creating
events (starting actions and
retrieving instructions are not
possible).
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Tool
execution

Web services

Get, create, and update events.

Close, reopen, own, dis-own events.
Get, add, update, and delete annotations.

Add, update, and delete Custom Message
Attributes.

Start, stop automatic or operator-initiated actions.
Get the instruction text for an event.

Get notification for changes on events.

API

Application API to
execute Tools.

Web services
Launch a Tool within the operator’s responsibility.

Run arbitrary strings, run commands on an OM
agent.

Commands types: executable, Perl script,
VBScript, JavaScript, or Windows Scripting Host
script.

Asynchronous requests/ result handling.
WSMAN calls, payload in SOAP format.

Trigger predefined tool calls.

Use a "subscribe" call to wait on multiple requests.

Call list for open requests.

Web services

Action Web Service:

Run arbitrary strings.

Run commands on OM agent.

Command types: executable
(default), Perl script, VBScript,
JavaScript, or Windows Scripting
Host script.

Asynchronous requests/ result
handling.

REST-based.

Trigger a command on multiple
hosts.

Poll for requests with execution
context ID.

Requests can be routed to another
server when needed.

Requests can be canceled.
CLi

opr-agt -cmd

Administration Tasks

Administration tasks are outlined in the following tables.
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Events

Functionality

Export/Import
events

Delete
queued event

Agents

Functionality

Agent
prerequisite
check

Install agent
software

Installed
agent
software
setting

OM for OM for
UNIX Windows

CLI CLi

opcactdwn, ovowmsgutil

opcactupl

opchistdwn

opchistupl

CLI

opcdelmsgs

OM for UNIX

CLI

inst.sh

CLI

opcsw

HPE Operations Manageri (10.10)

OM for
Windows

CLi

ovowreqcheck

API

COM API
methods to
check node
prerequisites.

OMi
CLi

Not applicable.

Not applicable.

Not applicable.

opr-archive-events[.bat|.sh] Downloads closed
events, based on date range, severity, and node from the
DB. Uploading archived events is not supported.

opr-export-events[.bat|.sh] and opr-import-events
[.bat]|.sh] support exporting and importing all or selected
events in any lifecycle state.
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Remote agent  CLI CLl CLl
commands
opcragt, ovrc opcragt, ovrc ovrg,
ovdeploy, opcdeploy ovdeploy, opr-agt[.bat|.sh]
ovpolicy opcdeploy Exceptions:
ovcodautil ovpolicy No -cleanstart. Use alternative
ovcodautil remote command, such as
oveonfpar deploy, to perform opcagt -
ovconfpar ovaeploy, top pcag
cleanstart.
API ovdeploy
o I API .
Distribution API - distribute ovpolicy

configuration (policies, actions,  COM API

commands, monitors) to specific = methods for

agents. administering ovconfpar
agents remotely:

java -jar jcodautil.jar

* get, set primary
manager

* start, stop
status of agent

* get agent
version

* get, set config

variable
Users
OM for
Functionality OM for UNIX Windows OMi
User/Profile CLl API User Management
Management opccfauser COM AP Web Services and
opr-user CLI
methods

API

User configuration API - create, change, delete, list
users, change user responsibilities, (de-)assign
tools/tool groups

User profile configuration API - create, change,
delete, list profiles, (de-)assign tools, tool groups,
responsibilities, profiles
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Manage user | CLI
sessions listguis
opcwall
disable_java_gui, enable_java_gui

opckilluiwww

Configuration Objects

Functionality OM for UNIX OM for Windows  OMi
Tools/Tool groups CLI CLI CLI
opcappl ovowtoolutil ContentManager
[.bat|.sh]
exports/imports content
API packs including tools.
N ) . Content pack definition
Application configuration API -
PP 9 is done using the GUI.

create, change, delete, list, start
tools and tool groups.

Application group configuration
API - create, change, delete, list
tool groups, (de-)assign tools to

tool groups.

Message groups CLl CLI
opcmsggrp ovowmsggrouputil
API

Message group configuration API
- create, change, delete, list
message groups
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Services

Nodes/Node groups

CLl CLl
opcservice ovowserviceutil
opcsvcattr

opcsvcdwn, opcsvcupl

API

Service Navigator Interfaces and
APls:

* XML Data Interface to write or
get service configuration directly
into or from the service engine via
afile system socket.

» C++ APIs of the service engine
to register for service status

changes

CLI CLI

opcnode ovownodeutil
opclaygrp

API

Node configuration API - create,
change, delete, list nodes and
node groups, (de-)assign policies
to nodes and node groups,
change node type, (de-)assign
nodes to node groups.

Node hierarchy configuration API
- create, change, delete, list node
hierarchies and layout groups,
get/move nodes and layout
groups

HPE Operations Manageri (10.10)

API

UCMDB APIs (Java and
Web Services)

Other Automation
opr-node

Views and
CiCollections—UCMDB
API or enrichment rules
to create relationships.

UCMDB API to
query/update Cls.

OMi auto-assignment
rules manage dynamic
policy
assignment/deployment.
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Policies/Policy CLl API CLl
groups opcpolicy PMAD APIs - COM | ConfigWsTool
opctempl methods' policies - (de-)assign and list
for handling:
management templates,
* Policy groups list deployment jobs for
API management templates

* Policy types
Policy configuration API - get, set
and change policies/policy
groups, and (de-)assign to policy ' * Nodes (including
groups. agent profile Monitoring Automation
generation) web services:

* Packages
Web Services

* Deployment jobs  + List management
templates.

* List deployment jobs
created as aresult of
management template
assignments.

* Get status and
parameter information for
an assigned
management template.

* List, create, update,
and delete management
template assignments.

Other automation

OMi auto-assignment
rules manage dynamic

policy
assignment/deployment.

Policy types CLl
opcpoltype

API

Policy type APIs - create,
change, delete, list policy types.

Change username CLI

and password for ovpmpuwutil
Measurement

Threshold/Scheduled

Task/WMI policies
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Message regrouping

Instrumentation
categories

API

Message regroup condition
configuration API - create,
change, move, delete, list
message regroup conditions

CLI
opcpolicy

opcinstrumcfg

API

Category Configuration API -
create, change, delete, list
instrumentation categories, list
and (de-)assign categories to
nodes, policies, policy groups

General Administration

Functionality

Downtime handling

Node name/IP changes

OM for UNIX OM for Windows

CLl CLl

opccfgout ovownodeutil
ovowserviceutil

cLi

opcchgaddr

opc_node_

change.pl

HPE Operations Manageri (10.10)

Not applicable.

Other Automation

Not applicable. Can
change message groups
programmatically using
EPI Groovy scripts,
TBEA, SBEC, Event
web service.

OMi

Web Services

REST-based web service
for downtime allows you to
retrieve, update, create, and
delete downtimes.

API

UCMDB APIs (Java and
Web Services)

Other Automation

Managed by agent sending
ASSD information, which
translates into updates in
the RTSM.
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Download/upload
configuration and
configuration exchange
between servers

Server cloning

Server processes status,
stop, start

Self-monitoring: server and
node

GUI start-up message

Server config settings

CLI CLI

opcpolicy,
opctempl

ovpmutil

opccfgdwn,
opccfgupld

opcinstrumdwn
opctmpldwn
opccfgsync

opc_sis_
template2pol

CLI

om_server_
switch.sh

CLI CLI

opcsv, ovce vpstat, ovc

CLl

opchealth
opchbp

opchc.sh

CLl
opcuistartupmsg
cLi

opcsrvconfig

HPE Operations Manageri (10.10)

ovowconfigutil
ovowconfigexchange

ImportPolicies

CLl
ConfigExchange
[.bat]|.sh]
ConfigExchangeSiS
[.bat].sh]
ContentManager
[.bat].sh]

exports/imports content
packs. Content pack
definition is done using the
GUI.

Other Automation

Use the OMi GUI to create a
scheduled sync of
Cls/relationships between
the RTSM(s) and the
UCMDB.

CLI

run_hpbsm (Linux),
SupervisorStop.bat and
SupervisorStart.bat
(Windows),
opr-support-utils
[.bat].sh], ovc

Other Automation

Use OMi Server Health
page to view status
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Troubleticket / Notification

Flexible management

Certificate handling

Licensing

Troubleshooting/Support

(Re-) initialize database
content

Database password tool

Utilities

cLi

opctt

opcnotischedule

opcnotiservice

CLI Not applicable, since data is

opcmomchk not grgated in files, so- no
explicit syntax check is

ovconfchg required.

cLi cLi CLl

opcsvcertbackup ovcm, ovcert ovcm, ovcert

ovem

opccsa

cLi CcLi

omlicreporter omlicreporter

ovolicense ovolicense

OVOLTTest

opcremsyschk

cLi cLi CLl

itochecker ovsuptinfo LogGrabber (savelLogs. sh
or go.bat)
opr-checker[.bat|.pl]
sendEvent[.bat]|.sh]

CLl

opcdbinst

opcdbinit

cLi

opcdbpwd

cLi CLi CLl

mib2policy mib2policy BBCTrustServer

opcpat opcpat [-bat].sh]

BBCTrustServer.sh | BBCTrustServer.bat
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Performance Manager

OM for OM for

Functionality UNIX Windows OMi
Start, Stop, CLI CLI Performance Dashboard is part of OMi so there is no need for
License separate user and node management.
ovpm ovpm
Generate CLI CLI
graphs

ovpmbatch ovpmbatch
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Overview

OM provides preconfigured reports in addition to those provided in HPE Reporter and HPE Operations Bridge
Reporter. These reports are mostly focused on OM configuration and are designed for use by an OM
administrator. Similar reports are available in OMi Monitoring Automation.

OMi reports are HTML-based, with hyperlinks to quickly navigate from one report to another. OM for Windows
reports are HTML-based. OM for UNIX reports are mostly ASClI-based. However, there are six HTML-based
reports accessible in the Admin Ul.

OM supports creating your own custom reports by directly querying the database tables (OM for UNIX and
OM for Windows) or through WMI queries (OM for Windows). Although it is possible to query the OMi
database, this is not supported in OMi, since the OMi database schema is not published and it may change in
a future product version.

OM and OMi Preconfigured Reports Comparison

The reports in this table include preconfigured reports. Additional configuration information is available from
command-line tools, such as opcpolicy, opcnode, opclaygrp, opchbp, listguis, oainstall.sh,
opcservice (OM for UNIX) or ovownodeutil, ovowmsggrouputil.vbs, ovdbstat (OM for Windows).

Note: License reports and audit reports are covered separately under their respective sections.

Report OM for
Area OM for UNIX Windows OMi
Nodes, Lists nodes, with node Lists policies, | Node Configuration report compares the
Node type and HBP settings. agent package = monitoring configuration of a selected node to
Groups, version, and the actual state. It lists the aspects and policy
Cls component templates assigned to the node and reports if the
Lists nodes not in the Node | versions for actual state on the node is different.
Bank. each node.
CI Configuration report for a selected Cl or all
Reports the status of Cls in aview reports the assigned aspects
security certificates (includes the aspect name/version,
assigned to all managed enabled/disabled, parent object, and other
nodes. information).
Detailed report fora Comparison report compares the monitoring
selected node, includes configuration of a selected Cl with the

type of node, HBP
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settings, node group monitoring configuration of all Cls of the same
membership, policy, and type in the current view. It lists the equal
policy group assignments. assignments, additional assignments, and

missing assignments.

List node groups and node

membership. User-defined view-based RTSM reports of
selected Cl attributes. Output to CSV, XLS,
PDF, XML, Browser.

Detailed report for a

selected node group that

lists the message

group/operator

assignments and

policy/policy group

assignments.

Lists nodes that are not a
member of any node group.

Lists nodes that have no
policies assigned to them.

Lists nodes that are not
part of any user's
responsibilities.

Lists node groups that
have no policies assigned
to them.

Lists node groups that are
not part of any user’s
responsibilities.
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Events Reports the number of
active messages per
message group.

Reports alist of active,
history, or pending
messages for an operator.

Exports selected
messages to a text fileora
drag and drop to another
application, such as Excel.

Users Lists operators including a
summary of permissions.

Per-operator detailed report
lists the permissions
assigned directly and
assigned using the
profiles.

User Lists profiles.
Profiles

Lists permissions
configured for a specific
profile.

Policies, ' Lists all policy groups and
Policy policies.
Groups

HPE Operations Manageri (10.10)

Save selected
events to afile
(TXT, CSV).

None

None

Lists policies
that are in use
and the nodes
they are
installed on.

Export selected events to a file (XLSX, XLS,
CSV).

None

None

Inventory report lists all management templates,
aspects, and policy templates.

Aspect Assignment report shows the Cls
assigned to a selected aspect.

Management Template Assignment report
shows the Cls assigned to a selected
management template. This report also includes
Cl assignment details.
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Agent None
Binaries

Services = None

Message Lists message groups that
Groups are not part of any user’s
responsibilities.

HPE Operations Manageri (10.10)

Lists agent N/A
package

versions and

the nodes they

are installed

on.

Lists agent
component
versions and
the nodes they
are installed
on.

Lists services ' None
including their
calculation

and

propagation

rules.

None None
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Overview

OMi and OM provide auditing and license reporting.

Auditing

Both OMi and OM are capable of auditing configuration and event changes. Audit entries contain information
indicating what kind of action took place, who performed it, when, and the audit area it concemns.

The primary source of OMi audit log data is displayed in Administration > Setup and Maintenance > Audit
Log. It includes the following OMi-related audit contexts:

Operations Management. Displays the actions related to Operations Management, such as creating and
modifying content packs, event rules, and notifications.

User/Group Management. Displays the actions related to adding, modifying, and deleting users and user
groups.

Permissions Management. Displays all actions related to assigning permissions, roles, and permission
operations on resources for users and user groups.

Recipient Administration. Displays the actions related to modifying information about the recipients of
audit logs.

Downtime/Event Scheduling. Displays the actions related to creating and modifying downtime and
scheduled events.

Database Management. Displays the actions related to creating, deleting, and modifying users and
passwords for profile databases, as well as modifying the status of the Purging Manager.

Notification Template Administration. Displays the actions related to modifying open-ticket
information, ticket settings, closed tickets, ticket templates, and subscription information: notification
types (locations or general messages), and recipients.

Service Health Administration. Displays the actions related to configurations made in Service Health
Administration.

For details on event changes and configuration changes that are written to the audit log, see the
Administration Guide > Setup and Maintenance > Audit Log.

Some event audit data is available in the History tab of the event in the Event Browser. In addition to being a
convenient event-centric view of changes, this can provide some additional information, such as the old and
the new value for an attribute when an attribute value has changed.

Cl change data is available in the RTSM. It provides a ClI history, such as Cl creation time, set or changed
attributes, added or deleted relationships, as well as other information.
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The following figure shows an example of Cl configuration changes in the RTSM IT Universe Manager:

@ Operations Manager i Workspaces ~  Administration v

Administration - RTSM Administration - Modeling -~ IT Universe Manager

@ History Changes

S # -|Fiterby Tme Range[ B[] Change Type: Al

¥ | Attriute; A1

=

Change Date | Attribute | |

New Value

| Modified By

Fri Nov 21 2014 06:00 PM CET Add Related CI

Fri Nov 21 2014 06:00 PM CET DiscoveredOsName

Fri Nov 21 2014 06:00 PM CET ProcessorFamily

Thu Nov 20 2014 01:49 PM CET Add Related CI

Thu Nov 20 2014 01:49 PM CET Add Related CI

Thu Nov 20 2014 01:48 PM CET Add Related CI

Thu Nov 20 2014 01:49 PM CET Add Related CI

Thu Nov 20 2014 01:49 PM CET Allow Cl Update

Thu Nov 20 2014 01:49 PM CET Create Time

Thu Nov 20 2014 01:49 PM CET Created By

Thu Nov 20 2014 01:49 PM CET DefauttGatewaylpAddressType
Thu Nov 20 2014 01:49 PM CET Display Label

Thu Nov 20 2014 01:43 PM CET Enable Aging

Thu Nov 20 2014 01:48 PM CET Global ld

Thu Nov 20 2014 01:49 PM CET Has UDF License

Thu Nov 20 2014 01:48 PM CET
Thu Nov 20 2014 01:49 PM CET
Thu Nov 20 2014 01:49 PM CET
Thu Nov 20 2014 01:48 PM CET
Thu Nov 20 2014 01:49 PM CET
Thu Nov 20 2014 01:43 PM CET

Has UDI License

Wonitored By

Name

PrimaryDnshame

Store KPI History For Over Time R...
Track Confiquration Changes

005056A54680(interface)
Windows Server 20126.2
XB6_64

OMi Gateway Server on mambos(.
192.168.254.18(ip_address)

OMi Processing Server on mambo.
HP Operations Agent on beedc1...
True

Thu Nov 20 2014 01:49 PM CET
BSM: omi_config,LoggedinUserb. .
Pvd

mambod

False

502

OMiLoggedinUser-admin
OMiLoggedinUser:admin
OMiLoggedinUseradmin
omi_config,LoggednUserbsm_od.

omi_config,LoggedinUser:bsm_od...

omi_config,LoggednUserbsm_od.

omi_config,LoggedinUser:bsm_od...
oomi_config,LoggedinUser:bsm_od...

omi_config,_oggedinUser:bsm_od.

omi_config LoggedinUserbsm_od...

omi_config,_oggedinUser:bsm_od.

omi_config,LoggedinUser:bsm_od...
omi_config,LoggedinUser:bsm_od...

False
False
[0W]
mambod
mambod
False
False

omi_config,L bsm_od.

omi_config,LoggedinUser:bsm_od...

omi_config,LoggednUserbsm_od.

omi_config,LoggedinUser:bsm_od...
omi_config,LoggedinUser:bsm_od...

omi_config,_oggedinUser:bsm_od.

omi_config,LoggedinUser:bsm_od...

omi_config, Lt “bsm od.

o]

OM and OMi Auditing Functionality Comparison

The following table compares auditing functionality in OM and OM.i.

OM for

Functionality UNIX OM for Windows OMi

Stored format | Text file, Windows Event
delimited Log
Visualization = OM for UNIX @ Windows Event

Admin Ul
displays

Admin Ul
formatted
audit log.

Log

View OM
audit log with
a text editor.

HPE Operations Manageri (10.10)

Text file, delimited

OMi GUI, with the ability to filter by context, user and
time frame
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Authorization = Root user

required to

change audit

settings

Restrict File

access to permissions

audit data

Configurable | Fine-grained

audit levels audit levels
on a per-
operation
type basis

OM for Windows
administrator

A Windows
administrator
must restart OM
processes for
changes to take
effect.

Standard
Windows Event
Log security

Fine-grained audit
levels on a per-
operation type
basis

License Reporting

OMi administrator

An operating system administrator must change log4j
settings.

OMi user permissions

Limited configurability. Admin > Platform > Setup
and Maintenance > Infrastructure Settings,
Operations Management, offers two settings for the
OMi audit: Configuration or All (both configuration and
event changes).

In OMi, you can view the current license details and usage in Admin > Platform > Setup and Maintenance
> License Management. You can also query the installed capacity using the JMX console.

The following figure shows an example of the OMi license usage:

Name | License Type=| Days Left | Expiration Date |

Capacity Details

- Service Health Anatyzer
- RUM
B BPM

- Operations Management

Event Management Foundation

Topology-Based Event Corretation

Time-based

Time-based

Target Cennector

Operaticns Agent

(— Business Process Insight

— Management Pack

Monitoring Automation for Composite Applications

Time-based

Time-based

Time-based

Time-based

Time-based

287

287

287

455

287

287

455

04/05/2015

04/05/2015

04/05/2015

1511072015

04/05/2015

04/05/2015

1910/2015

Neot Applicable

Neot Applicable

— ]

e — |

Used 0 Cennector(s) cut of 10
Used 9 Agent(s) out of 10

Mot Applicable

Used 0 Business Process(es) out o.

Used & OS Instance(s) cut of 25

In OM, administrators can run a license report on demand. OM for Windows provides tools to generate and
display reports in the HTML or ASCII format. OM for UNIX provides command-line access to generate

reports.

OM and OMi License Reporting Comparison

The following table compares license reports in OM and OMi.

HPE Operations Manageri (10.10)
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oM OMi

The "OM Feature License Report" shows the license status of For the supported license types (OMi
each OM license type (OM Server, Agents, Target Connectors, Server, Operations Agent, Target
SPIs). It includes the number of installed licenses, the numberof | Connector, Management Pack), the
required licenses, and a license compliance status. equivalent information is reported.

The "OM License Password Report" lists all installed OM license | Not available.
passwords for each OM license type (OM Server, Agents, Target

Connectors, SPIs). It also includes the number of licenses per

license password.

The "OM Node License Report" shows the license requirements While the managed node reports this

of each managed node. This data is reported by the managed data to the OMi server and is stored in
nodes and also includes node attributes, such as CPU countand @ the OMi database, there are no out-of-
operating system version details. the-box reports.

The OM server performs a license check at start-up time and every 24 hours thereafter. License violations are
reported in the OM Message Browser. OM can be configured to email an ASCII license report if it exceeds a
configured severity threshold that is checked on a daily basis.

OMi does not provide email notification of license compliance and does not generate an event for license
violations.

Calculating License Consumption

OMi reports consumption levels of three types of licenses: Agent, Management Pack, and Target Connector.

The HPE Operations Agent reports its license requirements to the primary manager (OM or OMi) on a daily
basis. This includes both agent license and if it is configured with a management pack. This datais stored in
the OM or OMi database.

OM calculates Target Connector usage on a daily basis. OM for UNIX provides a command-line tool that you
can run at any time to output the usage for the last 30 days, which you can average to determine the overall
usage for license compliance purposes. HPE also provides a Target Connector license check utility that can
be used with OM for UNIX and OM for Windows to list the nodes that may require a Target Connector
license. For further details, see the HP Operations Manager “Licensing Best Practices and Reporting”
available at https://softwaresupport.hp.com/group/softwaresupport/search-result?keyword=.

OMi calculates Target Connector usage in the same way on a daily basis. However, no such commands or
utilities are available in OMi. The Agent, Management Pack, and Target Connector data is stored in the OMi
database.

Note: It is not always possible to programmatically determine if a Target Connector license is required.
For example, if the node is already licensed through another HPE Software product, the Target
Connector license may not be required. If the node is a single-purpose device, such as a switch, router,
UPS, or printer, the Target Connector license is not required. In OM, you can exclude these nodes from
the license check by setting appropriate variables in the tclfilter namespace. Such exclude functionality
does not exist in OMi.
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Integration Technologies

Overview

OM integrates with various applications from HPE and other vendors using a variety of different technologies
and interfaces. Many HPE product integrations are provided for OMi as well (see the detailed list below).
Several BSM Connectors are provided to integrate third-party domain managers in OMi. Additionally, all
integrations using standard operations agent policies (opcmsg, opcmon, SNMP, lodfile, and other) can be
technically reused as HPE OMi supports the same policy types.

HPE and HPE partners may provide additional integrations in the future.

“Southbound” Integrations Using Operations Agent
Policies

OMi supports the following OM policy types:

« ConfigFile - not used for integrations

« Flexible Management - not used for integrations

« Logfile Entry

« Measurement Threshold

« Node Info - not used for integrations

o Open Message Interface

« Scheduled Task

« Service Auto-Discovery - not used for integrations
« Service/Process Monitoring - not used for integrations
« SiteScope - not used for integrations

o SNMP Interceptor

« Windows Event Log

« Windows Management Interface

Technically, all integrations using supported policy types can be reused in OMi. However, depending on the
vendor and the license agreement, you may or may not be able to reuse the OM integration with OMi.

The following policy types can also be imported into a BSM Connector, which offers the additional possibility
to integrate topology and metrics:

« Open Message Interface
o SNMP Interceptor
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The following OM policy types are not supported (typically, they are not used for integrations):

« ECS (Event correlation, event composer)
« RAS (Remote action security)

« subagent (OM for Linux)

« Server-based MSI (OM for Windows)

« Server-based Flexible Management (OMi uses connected servers and forwarding rules)

« Server policies (OM for Linux)

Official HPE Integrations

For a list of integrations available for OM for UNIX , OM for Windows, and OMi, visit
http://support.openview.hp.com/sc/solutions/index.jsp#tab=tab3.

In most cases, OMi offers identical or enhanced integrations. Check the Solution & Integration portal for up-
to-date integration information, as new integrations might be added over time.

Existing Integrations into OM
Integrating with: ArcSight Logger

[464] Event correlation and event pattern analysis
(OMW - ArcSight Logger) V1.0 1.0

[618] Event correlation and event pattern analysis
(OMU - ArcSight Logger) 1.0

Integrating with: Operations Analytics

[725] Operations Analytics — Operations Manager
Data Collection integration 2.0

Integrating with: Asset Manager

[141] ClI Inventory Replication via Connect-It (AM-
OMW) 1.0

Integrating with: Network Node Manager i
software

HPE Operations Manageri (10.10)

Equivalent Integrations into OMi

For event analytics, see [704] Operations Analytics —
Operations Manager i integration 2.0.

Identical.

[704] Operations Analytics — Operations Manager i
integration 2.0

Identical.

Using the UCMDB (RTSM) — Asset Manager
integration.

[616] UCMDB to AM Push Integration 2.0
[307] Asset to Cl Replication (AM -> UCMDB) 1.1

[414] Business Service Reconciliation via Connect-It
(AM<-UCMDB) 1.2

[420] Asset Cl Federation for ITSM (AM -> UCMDB)
1.1

Enhanced.
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[26] Incident Exchange (OMW - NNMi) 2.0
[657] Incident Exchange (OMU - NNMi) 2.0

[305] NNMi Integration with Operations Manager

(NNMi - OMW ) 2.5

[622] NNMi Integration with OMU/L (NNMi ->

OMU) 3.0

[656] NNMi Integration with OMU/L (NNMi -

OMU)2.5

[347] NNMi Integration with OMW (NNMi ->

OMW) 3
Integrating with: OO / OO Content

[35] OO to HP Operations Manager (Incident Web

Service) (OO Content-OMW) 3.0

[615] OO to HP Operations Manager (Incident

Web Service) (OO Content -OMU) 3.0

Integrating with: Performance Insight

[283] PI x-domain Reportpack Integration
with OM (Pl -> OMW ) 1.0

[624] PI x-domain Reportpack Integration
with OMU (Pl -> OMU) 1.0

Integrating with: Operations Bridge
Reporter

[410] OBR integration with HP Operations
Manager for Windows (OM for Windows)
1.00

[620] OBR integration with HP Operations
Manager on UNIX/Linux (OM on
UNIX/Linux) 1.0

Integrating with: Service Manager

[105] Systems and Incident Exchange via
SCAuto (SM - OMW) 1.5

[104] Systems and Incident Exchange via
SCAuto (SM -OMU) 1.5

[363] Node Bank and Outage integration
(SM-0MU)1.10

[142] CI Inventory Replication via Connect-
It (SC/SM-OMW) 1.0

HPE Operations Manageri (10.10)

[344] Network to BSM operations management
integration (OMi - NNMi) 1.0

[812] View NNMi Ul components within OMi

Enhanced.

[811] CI to remediation (OMi-O0) 1.0
[365] Event to remediation (OMi - O0) 1.1

Provided by the OBR integration.

Enhanced.

[299] OBR integration with BSM (Operations Management)
events 1.00

[301] OBR integration with the Run-time Service Model
(RTSM)of BSM 1.0

Enhanced.

[337] Incident Exchange (OMi - SM) 1.0
[810] uCMDB to OMi Downtime Integration (OMi - UCMDB)
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Integrating with: SiteScope Enhanced

[39] View SiteScope Monitor Alerts and [412] Event forwarding from SiteScope to BSM OMi 1.0
Events in OM (OMW - SiS) 2.0

[628] View SiteScope Monitor Alerts and

Events in OM (OMU - SiS) 1.0 System Availability Management: SAM Admin is part of

BSM.

[405] System Availability Management:

SAM Admin integration (OMW - SiS) 1.0

[496] SiteScope Remote Configuration by Monitoring

[621] System Availability Management: Automation 1.0

SAM Admin integration (OMU - SiS) 1.0

Integrating with: Storage Essentials

[170] HP SPI for SE (SE -> OMW) 2.0 [167] UCMDB - Storage Essentials 1.0
[625] HP SPI for SE (SE -> OMU ) 2.0

Integrating with: Systems Insight Manager

[166] Integrate Hardware-Level Monitoring | [784] BSM Connector for HPE Systems Insight Manager 2.0
with System and Application Monitoring
(OMW -SIM) 1.0

[626] Integrate Hardware-Level Monitoring
with System and Application Monitoring
(OMU -SIM) 1.0

Integrating with: Continuous Delivery
Automation

[683] CDA & Operations Manager for UNIX | https://hpln.hpe.com/blog/hp-operations-agent-can-be-
Integration 1.00 deployed-cda-and-csa

Integrating with: Performance Manager Enhanced.

[306] Performance Manager to SiteScope Embedded Performance Dashboard gathering metrics from
1.0 Operations Agents, SiteScope, BPM/RUM Profile database,
and Diagnostics.
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Integrating with: BLUE ELEPHANT
SYSTEMS

Core products:

MIDAS Configurator

MIDAS Administrator

Add-ons:

MIDAS Supervisor

MIDAS Synchronizer

MIDAS Outage Manager
MIDAS Debugger

MIDAS Analyzer: MIDAS Inventory
MIDAS Operational Value Pack
MIDAS Service Builder

MIDAS Automator

HPE Operations Manageri (10.10)

MIDAS Supervisor supports OMi/BSM.
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Configuration Parameters

You can fine-tune OMi under Administration > Setup and Maintenance > Infrastructure settings. Fine-

tuning replaces the OM configuration variables and the OM for Windows server configuration.

Where applicable, similar settings exist in OMi. The following figure shows OMi duplicate suppression

settings:

o

P
Name=

Detect Duplicate Events by ETI

Detect Duplicate Events by Identical Attributes

Detect Duplicate Events by Key
Enable Duplicate Events Suppression

Generate histary lines for Duplicate Event
Suppression

Ignare Existing Events in or affer Selected State

Maximum Age of Duplicate Events
Select Application

Select Category

Select €1
Select Cl Hint
Select ETI Hint

Select ETI Value
Select HPOM Service ID

Select Node

Select Node Hint

Select Object

Select Palicy Condition ID

Select Severity

Select Subcategary

Select SubComponentld

Select Title

Select Type

Updare Description of Original Event
Update Severify of Original Event

Undate Title of Original Event

Events Suppression Settings

Description

Use ETIs to find original event. Duplicate events must have the same Cl. ETL and ETl value. and the ETI must contribute fo health
Use selected attributes fo find the ariginal event. All selected attributes must be identical

Use the key attribute o find the original event. Duplicate events must have identical keys.

If enabled, new events that are duplicates of an existing event are not retained and the ariginal event is updated.
Adds, for each recelved duplicate event or 2 duplicate count change from other servers, = history line entry for the original event.
Events in or affer the selected lifecycle state will not be considers as original events.

Maximum number of seconds difference between the creation fimes of the original and new event (0 = infinite).
Duplicate events must have the same zpplication.

Duplicate events must have the same category.

Duplicate events must have the same CL.

Duplicate events must have the same Cl hint.

Duplicate events must have the same ETI hint

Duplicate events must have the same ETI and ETI value

Duplicate events must have the same HPOM service ID

Duplicate events must have the same node

Duplicate events must have the same node hint.

Duplicate events must have the same object.

Duplicate events must have the same policy condition ID.

Duplicate events must have the same severity.

Duplicate events must have the same subcategory.

Duplicate events must have the same SubCompanent ID

Duplicate events must have the same fitle.

Duplicate events must have the same type.

Update description of original event with description of last duplicate event.

Update severity of original event based on selected mode.

Update title of ariginal event with fitie of last duplicate event.

Value
true
false
true
true
false

Closed

true
true
true
true
true
true
true
true
true
true
true
true
true
true
true
true
false
No

false

BIRIREEREEEREREEREREEREEEREEE

See the Administration Guide > Setup and Maintenance > Infrastructure Settings > Infrastructure

Settings for Operations Management for a complete list of settings.

Configuration Exchange Between Servers

OM for Windows and OM for UNIX offer command-line interfaces to export and import various configurations
from a test system into production or backup systems.

OMIi can export and import configuration using the RTSM package manager (deals with all RTSM-related
artifacts, such as queries, views, CI-Types, and so on) and the Content Pack manager (indicators, correlation
rules, tools, graphs, policies, and so on). However, infrastructure settings can currently not be exported and

imported.

The following figure shows an example of configuration export using Administration > RTSM
Administration > Administration > Package Manager:

HPE Operations Manageri (10.10)
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@ Operations Manager i Workspaces »  Administration w Q 2 admin ~

Administration ~ RTSM Administration - Administration -~ Package Manager

View - Tools ~ Help~

B-+onlag|uwa ven

IL| Alertshodel R Selecti
esource selection
L AerisTals Package Properties
1] Ateon_app = Select the resources you want to add to the package from the various resource groups.
Ml Resource Selection o o - -
1] AMPushada Selection Summary ¢ = | E-LIES Appication -
v Configuration tem Types 5T Business =
LI ApacheTom |- = identifications 501 Busineas Services
Aperture_Vi
L) Aperture_ Relationships 1O cous
1L Apiadapter Calculated Relationships I Cluster
1) APMPushAd Valid Links B+ JE configuration Manager [t ChY
1L ARIS_integra] ! _u- Service Models [ JFS] Database
LI As400 T UEg i e[ JET] Datacenter and Power
- aueries
L] Assets EHEE Dotiet
e | Eoonments T Dottlet Topology
1L Atrumpusha} | = impact Rules 1 (14l DotistiS Topolooy _| Hratiumbased o
i 3 = (1T, DothetioniiS Topology 3
IL| AutoDiscove| L~ Policies Heling.py, configL
F-JET GettingStartedGuide
[ AutoDiscovel B Settings 2| e JET Hardware
1L BAC_perspe] ~ Type Definiions :| @ JES BM webSphere MQ
[ BACKPIsAda] = Job Scheduler B3 ntegrations.
I Basic_Autho b g D' State Categories E-CIER nventory
I Basic_Busin L fc:‘;:;ers e-JET iseries
B-JER J2eE
L Basic_Classg {— = Discovery Documents Lo g . .
Pl - Local impact views
Discovery Modules EH_JES Locations
I [ 7 Discovery Jabs §-IET vantrame 5
LlsLe Discovery Configuration Files — | BB wonitors
LI Bsmaterts Discovery Jythen Script - CIF etwork
Ll BsmAtertssd Discovery External Resource -5 0w Deme
I B5Mconnect zs':“"e“’:v'z‘a'df”t’:m BB Operations Management
C s s e
e T sap -
LI Bsmeum L~ Scanner Package for Scanner Generator v —2 |
IL| BSMIntegratid
e e

The following figure shows an example of configuration export using Administration > Setup and
Maintenance > Content Packs:

Content for ion server - Create New Ccmént‘ Pack Definition
o
@A General Content
b Content
@Bl pendencics Avallable Content
D Sumnery Sl ]
0 co
(& pia Filter
@ R Aspects
' e @ Automatic Run Book Rules
@ eve a Automatic User Group Assignments
D Ha E"§ Business Rules
= CI Type-Related Content
= RE: EE Configuration Folders
& Jav i"g Context Menus
(0 Log = correlation Rules
& Log E5 Dashboard Configurations
(0 Log 5] event Forwarding Rules
=] Log E Event Storm Suppression
D vics 3 Event Suppression Rules
& vic ﬁ Fitters for Event Processing
0 Mic E Fitters for Event Processing Customizations.
& vic ﬁ Fitters for Event Suppression Rules
8 ic E Fiters for Mapping Rules.
=Ll ﬁ Fitters for Stream-Based Event Correlation Rules
& on a Filters for User Group assignment
=l Eﬁ Graph Families
oo S Hi Assignments
& om 1 F= Hi eontext manis

OM functionality Equivalent in OMi
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ovpmutil, opccfgupld/opccfgdwn RTSM package manager and Content Packs

CLl Content Manager CLI

Nodes and Services export/import Cl export/import using the RTSM Synchronization job (push or

pull)
Tools Using Content Packs
Policies Export/import of policy templates, aspects, management

templates using Content Packs

Userroles Using Content Packs

Instruction text With policy export/import using Content Packs
Instrumentation (file copy) Using Content Packs

Server configuration Infrastructure settings: currently, there is no export/import.

(ovowconfigutil -download)

CLI/APIs for configuration exchange = See Appendix - Command line, APl and Web Services Reference
for details.

How to Move Content from an OMi Server to
Another OMi Server (Test/Production Use Case)

RTSM Content

Use the RTSM package manager to create a new package that includes RTSM artifacts you want to export,
such as new Cl types, views and queries, enrichment rules, and so on. Then, use “export package to local
directory”. See the RTSM Guides > Administration > Package Manager > Create a Custom Package
for more information.

Connect to another OMi system and deploy the RTSM package.

OMi Content

Use the content manager to create a new content pack that includes OMi artifacts, such as tools, aspects, or
management templates (included artifacts, such as instrumentation and policy templates, are automatically
exported as well). See the Administration Guide > Setup and Maintenance > Content Packs > Defining
Content Packs for more information.

Upload the exported content pack using the content manager.
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Topology Synchronization Packages

You can edit topology synchronization packages in the file system and upload them to the OMi database
using the opr-sdtool utility.

To exchange custom topology synchronization packages, copy the corresponding files from the file system
and upload them using the opr-sdtool utility.
Note: The following configuration cannot be exported/imported between OMi servers:

» Usergroups and users
« My Workspace pages
« Auto-grant IP ranges and scripts (script code can be copied manually)

« Infrastructure settings
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High Availability

Implementing a high availability configuration means setting up your OMi servers so that the service is
continuous despite power outages, machine downtime, and heavy load.

High availability for OMi is implemented in two layers:
« Hardware infrastructure. This layer includes redundant servers, networks, power supplies, and so forth.

« Application. This layer has two components:

o Load balancing. Load balancing divides the work load among several computers. As a result, system
performance and availability increases. External load balancing is a software and hardware unit
supplied by an outside vendor. This unit must be installed and configured to work with OMi applications.

o Failover. Work performed by the Data Processing Server is taken over by a backup server if the primary
server or component fails or becomes temporarily unavailable.
OMi provides its own failover mechanism and does not require separate cluster software.

Implementation of load balancing and failover is discussed in the OMi Administration Guide.

High-availability of the OMi database server (Oracle/MS SQL server) can be achieved through database
vendor-specific HA solutions.

High availability concepts known from OM, such as HA using clusters, server pooling, or HA Manager (Linux)
cannot be reused directly, but the HA concept outlined above offers almost the same benefits and features.
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Load Balancer Gateway DataProcessing
Servers Servers
B
] Backup
) DPS
Users ViD '
[
IP-based ticky seszions - N P =
1 d ° i
! T
i
Datahase Servers

SiSISISISS

Profle Manage- RTSM RTSM Event BPI
ment History

OM i supports MS SQL log file shipping (known from OM for Windows) as part of its disaster recovery
process. See the section below for more information.

OM HA Feature Equivalent in OMi

Use of virtual Yes, using external Load balancer
IP/hostname for server

Distribute load among Distribute load among several Gateway servers

several OM servers
(server pooling)

HA concept allows Certain patches can be installed on a gateway or backup/non-active
installing patches onone = processing server while other gateway servers and the active processing
server while other server | server are running. However, patches updating the communication bus or
is fully operational (server = other core services may require downtime.

pooling) Patching the active DPS requires to move the services to the backup DPS

(after the backup DPS has been patched), which involves some downtime as
the services need to start on the backup DPS. OMi 10.10 and later uses a hot-
standby backup server that reduces the downtime to less than a minute.

Disaster Recovery

OMi supports MS SQL log shipping, Oracle Data guard, and PostgreSQL hot standby as disaster recovery
techniques for databases. Other configuration files have to be copied separately.
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Data Collectors

OMi Production Instance OMi Failover Instance

OMi Gateway
Server

OMi Data
Processing Server

—_ -9 Management database (schema)
|
- r - '9 RTSM database (schema)
|
— —9 Events database (schema)

For details on disaster recovery, see the OMi Administration Guide.

OMi Database
Server
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Overview

Troubleshooting in OM and OMi depends on understanding:

The product architecture
« How to check the status of the application processes
Which log files to inspect

How to enable tracing to collect more detailed information

Tools to test configuration and connectivity

Self-Monitoring

Operations agents that are automatically installed on all OMi servers are used to detect OMi server problems.
OMi server problems reported in OMi log files are detected and reported as events to OMi. The OMi Server
Health page shows those OMi server events, as well as all the events related to operations agents health

check and communication problems.

For certain problems that affect the event processing itself (and therefore also the display of these problems
on the OMi Server health page), notifications can be send by the operations agents to a dedicated user. See

the OMi Help for more details.

(/) operations Manager i Workspaces v Administration v Q_ Liadminv @~
Workspaces - My Workspace
OMi Server Health x selecPage ~ C il
Manitoring Dashboard - OMi Overview | & « & Event Browser for OMi Processing Server on mambo8 | & =
® ouisener @ opentionsAgents . U R A 2; | 31 OMiDeployment ~ .. | % ouintemal . ERIAIR-A - a2
Sev Prio € N I A U D St. TimeReceived Title v Related CI User
@ eventprocessing 10 @ omisenerprocesses 18 @ Agentheatn 0 Py [, 112514083753 AM  OMi sever component wde diarted OMi Processing Server on mambof
a L 1125/14083753AM  OMiserver component schedulergw launched Ol Processing Server on mamboe
@ Iobtanding 1 @ OMiSenerifastrucire 0 @ AgentComeetty 0 || © [l 112514 08:37:53 AW OMi server component postgres_embedded started  OMi Processing Server on mamboé
) [, 112514083753 AW OMi server component OPR started Ol Processing Server on mamboe
itory overal a [}, 112514083753 AW OMi server component odb faunched Ol Processing Server on mamaoe
. ) [l 112514083753 AM  OMi server component message_broker tarted  OMiProcessing Server on mambot
N B ° [, 112514 08:37:53 AM  OMi server component mercuryAS stated Ol Processing Server on mamboe
= 34 a L 1125114083753 AM  OMissnver component marbls_loader staing Ol Processing Senver on mamboe
. o % L 1125114083844 A OMiserver component busine ssimpact_service starter OMiProcessing Server on mambog
D S 0D T ) oW B G2 S0 ED ) L 1125114083753 AM  OMiserver component <Companeni> siared Ol Processing Senver on mambot
) L 112514083609 AM  Auto Upload of content finished. mambod
TopView vl @ o«
OMiDeployment ey © § 3 DisplayOptions ~ | & @
5
) = ttems: 1101 34 (0) iy OMiProc @ 0 wo o A ©8 @O0 @0 40 0 S|
(] OMi Deployment £ | | i T
@ )
1 M Gater General
: :)
[ o] Addtional Inf &
(] mambos) Source Inf e
Open
Actions
Annotations

o Lost Updat: 11/28/2014 10:15:43 A0

admin
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HPE Support

When problems occur and you log a case with HPE Support, HPE typically requests the output of itochecker
(OM for UNIX) or ovsuptinfo (OM for Windows). For OMi, HPE Support typically requests:

« The zip file output of LogGrabber run on both GW and DPS (located in the <OMi_
HOME > /tools/LogGrabber directory)

« The file output of <OMi_HOME>/opr/support/opr-checker[.bat]|.pl] -xml > tmpfile.xml

Troubleshooting Information in the OMi Help

Your primary resource for troubleshooting is the OMi Help. Troubleshooting information is located within each
section. Search for “troubleshooting” and filter by the area of interest.

Architecture

The OMi server is comprised of a Gateway Server and Data Processing Server which are predominantly
Java-based, with a JMS bus to pass events between the servers. Client web browsers connect to the web
server (I1S or Apache Tomcat) that is running on the Gateway Server. For high availability, OMi supports
multiple Gateway Servers through a Load Balancer, and an additional Data Processing Server to fail over on
the backend.

In contrast, OM server processes run on a single server. The client GUI for OM for Windows is either MMC or
a web browser. The operator client GUI for OM for UNIX is Java-based (Java application, Java Web Start, or
Java Applet), while the administrator GUI is a web browser. The OM server can run in a cluster to provide
high availability.

HPE Operations Agents communicate with OM and OMi in the same way (HTTPS-based). Manager-to-
manager event communication between and among OM and OMi servers is the same as well.

For southbound integrations, OMi can get events, metrics, and topology from BSM Connectors and from
SiteScope.

For northbound integrations, OMi leverages web services and scripting. The details are available in the OMi
Extensibility Guide.
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OM, Agent, BSMC, ,
OMi, APM* Northbound Sync, API Ul, Web Services

\Web Server {|S, Apache)

Application Server (JBoss 7)

“topaz" " MA
RTSMUI (sl hac. il oz Ml opr-confic- (exﬁe)
tme} server}
Groovy:Scripts RTSM_ UliMashup PMi Status
Msg Broker (opr-scripting- (cn:;:ql;" {uim) (OVPM) (myStatus)
host)

OPR
Msg Broker e BBC CB
: Groovy Scripts Certificaite
Damain e ’
y (opr-scripting- Server Bizlmpact
Manager
haost) {oues)

Gateway Server (GWS)

A
(opr-config-
server)

{site, hac,
trme

)
UE
{excita)

PMI
(QVPM)

ﬁ
PostqreSCL

Data Processing Server (DPS)

Bxernal

PostgreSOL,
Oracle or M5
SO Server

Status Check

In OMi, you can check the overall status of the server by selecting one of the following methods to run on the
Gateway Server and Data Processing Server:

o Run <OMi_HOME>/tools/bsmstatus/bsmstatus[.bat.sh].

Note: On Windows, this is the same as Start > Programs > HPE Operations Manager i >
Administration > Operations Manager i Status.

o https://OMiSERVER:8080/myStatus/myStatus.html (JMX login credentials required)
If a non-graphical output is required, you can check the Nanny status of all processes by running:

<OMi_HOME>/opr/support/opr-support-utils[.sh|.bat] -1s

Logging and Tracing

OMi makes extensive use of log4j. The log4j properties files control logging characteristics. Log files are
mostly located in the <OMi_HOME>/1og directory. The most important log files are listed in the following
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tables. For further details (including log file management and debugging), see the Administration Guide >

Troubleshooting > OMi Logs.

Gateway Server

Serv
Location and Name er
<OMi_HOME>\1log\wde\opr- GW
gateway.log
<OMi_HOME>\1log\wde\ GW
opr-gateway-flowtrace.log
<OMi_HOME>\1log\opr-scripting- | GW
host\
opr-scripting-host.log
<OMi_HOME>\1log\jboss\ GW
opr-configserver.log

HPE Operations Manageri (10.10)

Purpose

OMi Gateway
processing.

Start here if
you want to
check
whether a
new or a
changed
event was
received by
OMi.

Flowtrace log
entries for
events and
event
changes
arriving at the
Gateway

Custom
Actions

External
event
processing

External
instruction
text lookup

Monitoring
Automation

Debug

<OM1_
HOME>\conf\core\Tools\log4j\wde
\opr-gateway.properties

<OMi_
HOME>\conf\core\Tools\log4j\wde
\opr-gateway.properties

You can log an individual event by
specifying the custom attribute  TRACE___
in the event.

You can capture flow tracing across both
GW and DPS using the OMi GUI by
navigating to Administration > Setup and
Maintenance > Infrastructure Settings,
selecting the Operations Management
context and setting Event Flow Logging
Mode to "mem". To access in-memory flow
logging, go to the processing server and
launch https://localhost:29922/. Click
opr.backend:name=EventFlowTraceMBea
n and invoke the showAllEvents method.

<OM1_HOME>\conf\core\Tools\log4j
\opr-scripting-host
\opr-scripting-host.properties

<OM1_HOME>\conf\core\Tools\log4j
\jboss\opr-webapp.properties
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<OM1_HOME>\1log\jboss\
opr-event-ws.log

<OMi_HOME>\1log\jboss\
opr-ws-response.log

<OMi_HOME>\1log\jboss\
opr-policyeditors.log

<OM1_HOME>\1log\jboss\
opr-webapp. log

<OMi_
HOME>\1og\jboss\login.log

<OMi_HOME>\1log\jboss\
UserActions.servlets.log

<OMi_HOME>\1log\wde\
opr-svcdiscserver.log

<OvDataDir>
\shared\server\log\
OvSvcDiscServer.log
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GW

Gw

Gw

GW

Gw

Gw

Gw

Gw

Event Web
Services

Event Web
Services

Monitoring
Automation

Log file for
OMi web Uls

Monitoring
Automation

Content Pack
import

Tool
execution

LDAP,
LWSSO

Login
attempts

Mapping/filteri
ng part of OMi
dynamic
topology
synchronizati
on

Receiving
part of OMi
dynamic
topology
synchronizati
on

<OM1_HOME>\conf\core\Tools\log4j
\jboss\opr-event-ws.properties

<OMi_
HOME>\conf\core\Tools\log4j\jboss
\opr-ws-response.properties

<OM1_
HOME>\conf\core\Tools\log4j\jboss
\opr-webapp.properties

<OMi_
HOME>\conf\core\Tools\log4j\jboss
\topaz.properties

<OMi_
HOME>\conf\core\Tools\log4j\jboss
\topaz.properties

<OM1i_
HOME>\conf\core\Tools\log4j\wde
\opr-svcdiscserver.properties

To set maximum logging:

<OvBinDir>\ovconfchg -ovrg server -
ns
om.svcdiscserver -set LOG_LEVEL 10

<OM1i_HOME>\opr\support
\opr-support-utils.sh -restart wde

To return to the default logging:

<OvBinDir>\ovconfchg -ovrg server -
ns
om.svcdiscserver -clear LOG_LEVEL

<OM1i_HOME>\opr\support
\opr-support-utils.sh -restart wde

Page 189 of 196



OMi Evolution Guide
Appendix I: Troubleshooting

<OvDataDir>
\shared\server\log\
ovpmtrace.0.txt

<OM1_HOME>\1log\jboss\
content-manager.log

<OM1i_HOME>\1log\jboss\
kes.contentpack.log

<OM1_HOME>\1log\jboss\
downtime.log

<OM1_HOME>\1log\jboss\
opr-ue.log

<OM1_HOME>\log\opr-clis.log

<OMi_HOME>\1og\wde\

opr-heartbeat. log

Data Processing Server

Location and Name

<OM1_HOME>\1log\opr-backend\
opr-backend.log
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GW

GW

GW

GW

GW

GW

GW

Serv
er

DPS

Performance
Dashboard
trace file

Content
Manager
functionality

Content
Manager
functionality

Downtime

User
Engagement

opr-*
Command-
Line
Interfaces

Health Check

Purpose

OMi backend

process.

Start here if
you want to
check
whether a
new or
changed
event was

Enable tracing in the OMi GUI by
navigating to Administration > Setup
and Maintenance > Infrastructure
Settings, selecting the Performance
Dashboard context and setting Trace Level
to 2.

<OM1_
HOME>\conf\core\Tools\log4j\jboss
\content-manager.log

<OM1_
HOME>\conf\core\Tools\log4j\jboss
\kpi_enrichment.properties

<OM1_
HOME>\conf\core\Tools\log4j\jboss
\downtime.properties

<OM1_
HOME>\conf\core\Tools\log4j\jboss
\downtime-client.properties

<OM1_
HOME>\conf\core\Tools\log4j\jboss
\opr-webapp.properties

<OM1_
HOME>\conf\core\Tools\log4j\opr-
clis

\cli-log4j.properties

<OM1_
HOME>\conf\core\Tools\log4j\wde
\opr-heartbeat.properties

Debug

<OM1i_HOME>\conf\core\Tools
\log4j\opr-backend
\opr-backend.properties
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<OMi_HOME>\1log\opr-backend\
opr-flowtrace-backend.log

<OMi_HOME>\1log\opr-
topologysync\
opr-topologysync.log

<OM1i_HOME>\1log\opr-backend_
boot.log

<OMi_HOME>\1og\
opr-backend_shutdown.log

<OM1_HOME>\1log\opr-backend\
opr-ciresolver.log

<OMi_HOME>\log\opr-scripting-
host\
opr-scripting-host.log
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DPS

DPS

DPS

DPS

DPS

DPS

processed by
OM..

Flowtrace log
entries for the
events
arriving from
the OMi
Gateway
process

Log entries
for the OMi
topology
synchronizati
on application

Startup log
entries for the
OMi backend
process

Shutdown
messages for
the OMi
backend
process

OMi backend
process ClI
resolution

EPI
processing

<OM1i_HOME>\conf\core
\Tools\log4j\opr-backend
\opr-backend.properties

You can log an individual event by
specifying the custom attribute _ TRACE_
_inthe event.

You can capture flow tracing across both
GW and DPS using the OMi GUI by
navigating to Administration > Setup
and Maintenance > Infrastructure
Settings, selecting the Operations
Management context and setting Event
Flow Logging Mode to "mem". To access
in-memory flow logging, go to the
processing server and launch
https://localhost:29922/. Click
opr.backend:name=EventFlowTraceMBe
an and invoke the showAllEvents method.

<OM1i_HOME>\conf\core\Tools\
log4j\opr-topologysync\
opr-topologysync.properties

<OM1i_HOME>\conf\core\Tools
\log4j\opr-backend
\opr-backend.properties

<OM1i_HOME>\conf\core\Tools
\log4j\opr-scripting-host
\opr-scripting-host.properties
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<OM1_HOME>\log\opr-scripting-
host\
scripts.log

<OM1_
HOME>\1og\jboss\downtime.log

<OMi_HOME>\1log\marble_worker_
1\

downtime.log

<OM1_HOME>\1log\jboss\opr-
ue.log

<OM1_HOME>\1log\opr-backend\
opr-heartbeat. log

Gateway Server and Data Processing Server

Location and Name

<OM1_HOME>\log\supervisor\nanny_all.log

<OM1_HOME>\log\supervisor\wrapper.log

<OMi_HOME>\log\configserver directory

<OMi_HOME>\log\<ServiceName>_boot.log

DPS

DPS

DPS

DPS

DPS

EPI script
errors

Downtime

Downtime

User

Engagement

Runtime

Health Check

<OM1_HOME>\log\opr-scripting-host_boot.log

<OM1_HOME>\log\opr-scripting-host_shutdown.log

<OM1_HOME>\1log\bus
<OM1_HOME>\1log\bus_shutdown.log
<OMi_HOME>\log\opr-clis.log

<OM1_HOME>\1log\jboss

<OM1_HOME>\1log\jboss7_boot.log
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<OM1_HOME>\conf\core\Tools
\log4dj\opr-scripting-host
\opr-scripting-host.properties

<OM1_HOME>\conf\core\Tools
\log4j\jboss\downtime.properties

<OM1_HOME>\conf\core\Tools
\log4j\jboss\downtime-
client.properties

<OM1_HOME>\conf\core\Tools
\log4j\marble_worker
\dowtime-client.properties

<OM1_HOME>\conf\core\Tools

\log4j\jboss\opr-webapp.properties

<OM1_HOME>\conf\core\Tools

\log4j\opr-backend
\opr-heartbeat.properties

Server

DPS/GW

DPS/GW

DPS/GW

DPS/GW
DPS/GW
DPS/GW
DPS/GW
DPS/GW
DPS/GW
GwW

GwW

Purpose

Nanny Manager — startup/shutdown
log

Wrapper process —
startup/shutdown log

Configuration log files (for example,
when patching or upgrading,
running config wizard, running opr-
mp-installer.bat/sh)

Boot log files for all OMi services
EPI boot

EPI shutdown

Bus logs

Bus shutdown

opr-* Command-line tools

Jboss (MercuryAS) Application
Serverlog files

Jboss (MercuryAS) startup log file
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<OMi_HOME>\1log\wde GW Tomcat (wde) log files
<OvDataDir>\log\System.txt DPS/GW | LCore and OM Agent log file
oM

Location and Name Server Purpose
<OvDataDir>\log\System.txt OM for LCore and OM Agent log

Windows file
/var/opt/0V/log/System.txt

OM for UNIX
<OvShareDir>\server\log\om\incident-ws.trace.txt | OM for Incident Web Service

Wi loggi
/var/opt/0OV/log/om/incident_ws.0.en indows ©°gging

OM for UNIX
<OvDataDir>\shared\server\log\OvSvcDiscServer.log = OM for Service discovery

. Windows

/var/opt/0OV/shared/server/log/OvSvcDiscServer.log

OM for UNIX
Windows Event Log OM for Server-related events

Windows
/opt/0V/0MU/adminUI/logs OM for UNIX | Admin Ul log files

To debug problems with the flex-based user interface, you can enable logging in the GUI. For details, see the
Administration Guide > Troubleshooting > Tracing and Logging Operations Management User
Interfaces > Logging Settings User Interface.

OMi uses the same communications technology as OM to interact with the agent and other OM/OMi servers.
This means you will find some of the same data logged to <OvDataDir>/log and
<OvDataDir>/shared/server/log directories, as on OM. Tracing is configured in the same way as on OM,
namely the OM-style (ovconfchg) and the newer HPE-style (ovtrccfg, ovtrcmon)in OM.

Tools - HPE Operations Agent Communication

The tools for troubleshooting communication with the HPE Operations Agent are similar between OMi and
OM. Typically, configuration issues are related to connectivity (port, firewall settings) or certificates. The
same bbcutil, ovcert, and ovdeploy commands can be used in OMi as in OM.

In OM, the oprcragt command is used to perform a range of tasks on one or multiple managed nodes. OMi
provides ovrc, which, as oprcragt, can perform start, restart, stop, and status actions on remote managed
nodes, for example:

ovrc -ovrg server -host pluto.hp.com -status

ovrc -ovrg server -host pluto.hp.com -start opcmsgi

Note: Each command operates on a single node. To perform the action on a group of nodes or all nodes,
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use opr-agt[.sh|.bat]. For example, to query the status of all nodes in a view, run:

opr-agt.sh -status -view_name ”Hosts with HPE Operations Agents” -username admin
Troubleshooting access to agent-based performance data in OMi is similar to Performance Manager but not
identical. For example, the following Performance Manager commands:
ovcodautil -ping -n mynode.fqdn
ovcodautil -obj -n mynode.fqdn
ovcodautil -dumpds SCOPE -n mynode.fqdn
are implemented in OMi as:
/opt/HP/BSM/JRE/bin/java -jar /opt/OV/java/jcodautil.jar -ping -n mynode.fqdn
/opt/HP/BSM/JRE/bin/java -jar /opt/OV/java/jcodautil.jar -obj -n mynode.fqdn
/opt/HP/BSM/JRE/bin/java -jar /opt/OV/java/jcodautil.jar -dumpds SCOPE -n mynode.fqdn
Or:
<OMi_HOME>\JRE\bin\java -jar "<OVInstallDir>\java\jcodautil.jar" -ping -n mynode.fqdn
<OMi_HOME>\JRE\bin\java -jar "<OVInstallDir>\java\jcodautil.jar" -obj -n mynode.fqdn

<OM1_HOME>\JRE\bin\java -jar "<OVInstallDir>\java\jcodautil.jar" -dumpds SCOPE -n
mynode.fqdn

Performance Manager provides a System Information web page that connects to the agent and reports a
summary of data sources, classes, and the last time the data was logged. This functionality is not available in
OMi.

Tools - Event Processing

In OMi, event processing is implemented differently than in OM, and so the troubleshooting is different. OM
makes use of queue files that can be analyzed. It is possible that events are discarded if there is no matching
node defined on the OM server. OMi uses a Bus to pass events through the Gateway to Data Processing
server and into the database.

You can also use the JMX Console to query an extensive amount of configuration. Since you can make
changes to configuration and data, it is important to take care when using the JMX Console. See the
Administration Guide > Additional Configuration > JMX Console for an overview.

Note: There is no separate documentation on the available methods.

You can run <OMi_HOME > /opr/support/opr-jmsUtil[.sh|.bat] to monitor the number of messages and
the size of the bus queues and topics.

For troubleshooting purposes, in OMi, you can generate an event on demand. On the Gateway Server, run
<OMi_HOME>/opr/support/sendEvent[.sh|.bat]. If you run the command without parameters, you will get
the help syntax.
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Tools — Connected Server Communication

In OMi, you can configure connected servers, such as OMi, APM, OM, SiteScope, BSM Connector, External
Event Processing, and ArcSight Logger. With every connected server, you can test basic connectivity. In the
case of OM, there are separate wizard pages to test the HTTPS-based datacomm to port 383 (default) and to
test Incident Web Services connectivity (default port 8444 or 443).

Create New Server Connection x|

General Server Properties

Server Type
b Server Properties _ Test Connection _ =
Outgoing Connection ::ni > ::ni
Operations Manager i Success Operations Manager

Target Server

Fully Qualified DNS Name: =

neptune.planet.com |

Integration User: E

omuser |

Note: For Operations Manager Windows servers specify DOMAIN\User here.

Advanced Delivery Options |i|
Topology Forwarding

[7] Forward Dynamic Topology to this Target Server
Operations Manager Type

() Operations Manager for Windows

(®) Operations Manager for UMD

[<oack [ wext> Jf coian J concer SR e

Tools - Topology Synchronization

To troubleshoot topology synchronization from OM to OMi, you can capture detailed data that the OMi server
receives. In OMi, navigate to Administration > Setup and Maintenance > Infrastructure Settings, select
the Operations Management context and set Dump Data to true.
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Send Documentation Feedback

If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:

Feedback on OMi Evolution Guide (Operations Manager i 10.10)
Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a web mail client, and
send your feedback to ovdoc-asm@hpe.com.

We appreciate your feedback!

E . | =
Go OMi!


mailto:ovdoc-asm@hpe.com?subject=Feedback on OMi Evolution Guide (Operations Manager i 10.10)
https://hpln.hpe.com/group/operations-manager-i-omi
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